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'dns hostname RAREN) hostname 1T DNS £ (8# Fiddler 1)
. - ldns www.example.com
Inslookup hostname | DNS £E{fF P #if]). & Log B R Bass i
FT 40 Fiddler M2 9% 000 4 A 7 LA i HEp . prefs show
prefs show [substring] ) S ; .
LR T substring, HERES TETRMER | prefs show composer
MRS THE AR name EESH ., T —WAMHH, & | prefs remove
prefs remove name
R 2= 40 B fiddler.ui.fontsize
o prefs set
prefs sct name value HE GRS A nome FE value f13ETH
fiddler.differ. UltraDiff False
prefs log 8 Fiddler At (R TR S 8 Log TR F, LBL{EEED
fih% “DebugSpew” B, & FEH Ti#iL Fiddler A 5409/ 8. ¢ DebugSpew Hi
l AT Fiddler 2HESHN H A E B O BT B E 0 B ) 203 B F 80 il
R 1. AT R Sysinternals (1) DebugView 1 JLEERUZ 66T B, X FPEELF, Fiddler
2 Log B N9 idx 25 Ry m{E R
about:cache {F Log #3004 op 5 775 Fiddler (% W6 11 L4 K2 ¥ 45 89 FH 48 77 10 DNS SR A%
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F 2% HFE Fiddler

Bk

about:config

587 Fiddler [FIRETIAC T W 01, &0 MR AT (300 00 2 HE6

about:connectoids

# Log W 019 56T WinINET (957 47 2 5 04 1

about:network
toolbar ¥r b, R Fiddler THF 2 R, &EHER
tearoff f# Inspectors M, Fiddler (f] = CcpBiliE, S sh Ooh @R

WFFE QuickExec AHGHHEPHERA MG S AE LR BaA-SRER P, NEnfeR e
H FiddlerScript # Fiddler 47 & 47 Wi 1 i) 4 .

¥ 1A FiddlerScript &%

Fiddler SRikf) FiddlerSeript L& TR LA MM 4, XEdr 4 AT LI{E QuickExec
MiEHEP K ah, WA 2-11.

#F2-11 FiddlerScript %
1 4 8 fE %
I R URL AP T 88 A1 5 8 Session. LA AR 88
bold wrftexr bold uploaddata.asp
(] bold, £ HL i S or
20 R Y R 5E (F 1Y) Session £l 28 W5 T 25 BA A 2300 bsp
bps status bps 404
B, T T
J HTTP J7iEULALES 5E {7 Session G KK 4. @A AHE | bpm POST
bpm method
$0r) bpm B, BT bpm OPTIONS
. .' 3 URL 545 AN Session GIEEFH . BAFIER . ;
rext oaddata.
P % bpu B, K £ Peip s
A URL &6 L AN Session GIERHN S, RAFNEY ,
bpafter urltext bpafter dodownload.cgi
(1] bpafier B, 37 L0 1
nuke % WinINET #2817 # cookie nuke
tail #HH #4H5T Web Session F1J22, FA1E 0511 Session B A THRCEHA | il 200
log “At this point,
log string i Log ¥05 % 2647 i 00 W Acal & requests start failing”
log @Log.Save




2.6 b A
¥k
i &S Bk |
cls ST Web Session #13# cls
dump %47 7 A9 4 00 0900 ik 31\ Captures' P92 4 () dump.saz L fFep dump
g 4 i B 5 AT A AT Session % 5 30T g
help 57 QuickExee (¢ £ ¥ ith help
urlreplace
i G RRN URL TR B REs. ASFEEN | udreplace  jQuery.min
1
o urlreplace I, n]LLEE | i JQuery.dbg
newlext
] overridehost
overridehost Wk EER, HiNREEIARMENL. #ARHEEM _
. o production.example.com
oldhost newhost | overridehost B, 4% 11 5 5 Jia
dev.internal example.com
start BB B, 0 Fiddler ¥ 0 R &R start
stop KRB, Fiddler ASFHE L RE AR stop
keeponly ) I - .
il Web Session FlZEchm A2 T8 E MIMEtype 8747 Session | keeponly video/
MiMEwpe
iR i1 Fiddler. i%fr-%-2il tH LIRS 1 shiidT 1 H ExecAction.exe,
quit quit

iR Fiddler i#f§BR 11 C A9 IR SCPFRR AR OR

#% FiddlerScript 7] LA 5 & FiddlerScript i % MI8A 5%, HiFEMA B4, HFEA
ifi Rules>Customize Rules 1£10, #5441 #| OnExecAction Jrik.

g i vl LAY QuickExec @6 IMHERS INILAth fiy&—— AT LU By Sk 13 RE 1) SCRS SRR

FEEL.

2.6 W HIfhER

QuickExec $24t T S A po8 8f S+, Al Fiddler it 3 #¥ M Ah 304 .

Fiddler £l T S 9688 B3R CTRLAALTHF, i MaliGshm s 24, #al LGS

Fiddler. £i%1 Tools > Fiddler Options > General H 0] LLf% 2iriX 4~ A0t .

B T XA~ R, K1) Fiddler 5, 0T LLN FHR £ I0MhAGe, Hibinde 2-12 .
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® 2% K% Fiddler

F#212 Fii FA 74
ALTHQ b 52 O 4F QuickExec 3 iEHE
CTRL+R $TFF FiddlerScript H )i -2
CTRL+E ITH TextWizard
CTRL+Down HHf Web Session #1251 ] F— Session
CTRL+Up B Web Session 1|54 ) E— Session
CTRL+T #i% TexiView Inspectors
CTRL+H #i% HeaderView Inspectors
CTRL+0 AR BER Y 8.25pt (BRI
CTRL+Flus FAI S 1pt (£ 32p0)
CTRL+Minus TR AWM 1pt (D E Tpt)
CTRL+M Ji b4k Fiddler
CTRLASHIFT+DEL | ¥ WinINET 44

Fi2

F3k, M Fiddler 3 A 2 S04 0B a2 M 3R S AL R0 Ab i Y

2.7 HeihEhk

Fiddler A48 #1560 Frh Br T 98 Session HFEA(T £l fEIE T Ay i b7 Bty oA
8, B PARAUHE, % MIME 268 B onifi it

MikP £ Session I, BREAENE 2-13 Fiks.

*®213 itk
Request Count 1Y Session #
IR0 0 B L. R R R R AR B R R b, &
Unigque Hosts
FeBrETE
5 HTTP iR LAl R AR AR ER Y AE. EFRITHONES RSN T &
tes sent
; 1 body % 11195 2
HTTP i = S i = oo Bl 1 00 BT 47 7 W0 8. FF 4 B0 o U5 Tl A 5 iy 1 T Y
Bytes received
AR E T
Requests started at Fiddler S 3 E R E - F W1 A A
Responses completed at | Fiddler A23% $1)5% P S 0 5 10 B R G — 1 W B 1R

32



2.7 Hit#HA+F
Bk

Sequence {clock)

BT R T U B S T eSS S (Rl i )
duration

BT ) Session M i =k 3R 2 fu] (0 ] f9 7. 1534 Session Ml L HATETT
Aggregate session iy, BEpESWATEELE “niebmim " {<. WIER, [EGiX2eik b i) Session MOFFIGEIES
duration s B i) 2 fe] e T i S PR (), A il T S — P R RS —

el 111 1 1 R T T

B b Session #7167 DNS BrE SR Ml 8, WA IR Md 7 DNS
DNS Lookup time

MAEEMAMEENCSE Y, HAEE DNS 8T, HnfsibniETi

FifT ik P Session H L TCPIP MEZFER M AR, DRHHWRBLELECS
TCP/IP Connect duration e

ot b, AN ERAT TCPAP HE, Wifihs RniE TR

W47k h Session { HTTPS #8-F LAT{ES 0T E R, WAHTHI Session Akt
HTTPS  Handshake
P HTTP, AT EME, 80K ST LS =, W
uration

AAFLE HTTPS BF, N0 A 2 B R 7B
Response Codes it Session P& HTTP i I ES (31 8
Response Bytes by | BEH? Session %R 4% Content-Type (95 178, R0 e T 20t F 1 P
Content-Type FTEMIR
= P R AR (locale) HuBK TR 7 3T By WG ] (40 45 ot iR
stimated

MLk b Session (8NN, SEMEtRLZHBEEEENER, K
Performance

ifd A 4R T AR A ey

MR HE D T —4 Session, £ i77i% Session (F17HM 3. Wik () Session JETEHT—K
FREC A, W B B—— T4 B B G T ARG 309 SAZ CHHRA .

IR E 2 - CONNECT illilf, & R77EiZilliE b A X R Fl v 3 (BRAE 208
MELE ) HTTPS hnsd 4 3%, R, 75 75 Web Session #1132+ LU # i) HTTPS Session

oA I A D

EMERBET AR, RSN TARREDE. i Show Chart § 32 B ik
Session [FLFE. 2 H 1l —9K ¢ Tk o B3R # MY headers LA MIME 2808 0FF: DHEMD A
it &~ MIME 2858 2L K headers (17 1780

siikiZE F A1 “Copy this chart” S8 £ 100 P £ b AL P #5 DL BYRGHR, MR Bl
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¥ 2% 5% Fiddler
siianh, i 2-7 fros.

i 2-7

2.8 FILTERS %% |

Filters 3ET0 R340 7 —Fp “BREEIG" AT, AT LATEJy 3 MoK fay 9 () ot i 450 00 Rz ] 1
IEFESI# M BEIRL L. FiddlerSeript o] LLUBHTGETR F LR hiie GEA EAER s 10O, H
JEX TR MMES . Filters B0 — el 2 W58 2 1L 38w K.

L Filters ¥E10 F /e Iy (¥) Use Filters SLIEHESS , gwT LLOE A HCop Bl 45t 0RO 8 38 X
PR EATILIET . ¥ Use Filters RIEHESS, 3 T3 1) Session, Ho 7 (S M K]«

o RS

& L7 Web Session ¥ p i mbril

o REBEMNSHTATLRKL

o LA PRI AR

o BT HBh T EER %

Fiddler &2 BAREIT) Session $LULUEEENE, BI{EE Web Session
FUFE AT R iX e Session.

IR BT Actions i SCRAHE = A& H B9 B3R 4oL

B, B ATRATRORLIENE, PR 2 AT AT B A BRI =i
AR . Help ZEITS 9 2% FId gk iR BY (5 1 o 2-8 Biars.

BRI AT S -
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2.8 FILTERS % 8i ¥

Hosts F 4
Hosts HEHLOEH4ES 1 HL4 1L ak i 2hfie.

Zone Filter FHHESC R E AR CIASHE " B0EHLE) SREBEM Condl <. w9 EAL
F MEAEH, Wi 29 Fras, SRR KBRS 3 5 R0 A B Web SCRYET, X AMIE
HARATH

Hisbs

Shas ooy Intrarel Hasls
Sk paly Delevel Hedls

] 29
Host Filter F4irHE 2 5 br i el Bael 7 B i ) SCAHE P i il ) Edini. Wk 2-10 fras.

PR JCAHEAR 2 [ A LR UL TR 4 . R
BLOREEE T “ IR AR T Hosts” Jf FLESR P S fiddler2.com,  feteolomenons
Fiag the Follawing Hosts

W4T H www.fiddler2.com My FRERHE. b THEG
fiddler2.com & % & 7 47 ) B8 0, W5 S ol AL 7. B 2-10
* fiddler2.com. (EIMRFT 730 F @07 AL bl test.fiddler2.com Al sub.fiddler2.com SFFf R 5.
1) LR AL AR ] fiddler2.com T (180G L, 0T LLAEIE BUFF Rk * fiddler2.com () B al——IZHF
sl AT AL S T A 4 A fiddler2.com 85 GEAEHL, AT AR EM AL WEAE £ host, WEL
RSB TERD: AL CAHERTY SO M, HWEROL B R AU CARHESR
GREV VIR - Sl €L T E G

= Pim it

Pt i 4 ) S R T ) A I (E A AT B R F LRI Fiddler 7EAH R - HLRT,
Fiddler A~ fif #4007 th 06~ 8 A tH Aol 4 i ok .

I 4irfiE Show only traffic from [MFI &N 40F T RE P il EEIE TR IER . ik

HANEER, SRS H WoniBut R e R .

Show only Internet Explorer i H S oRibf 4 #kLL IE T3k ol R User-Agent kAl
compatible; MSIE [r]$#8 .

Hide traffic from Service Host i% 7 £ [ 8K % (13 72 svchost.exe (F) #(d#{ii, svchostexe JEFE
RAZEHF, 2R RSS Feeds LU IT M4 S &5 MEE 5 E) .
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% 2%F #FE Fiddler

i3 3 Request Headers

XTI, fRo] CLES N ER HTTP a3k, th o] LURR AL & 5 eii s S i ok .

Show only if url contains ¥ IHE % £ A6 T URL B 505 sk, o] LU HI RS EXACT ki
WP EIHER, WF.

EXACT:example.com/g=Case+Sensitive+String

b nT LA T IE ) 0k 5K

REGEX: (7insx) .*\. (gif |png|jpgl 5 #only show image requests

Flag requests with header #0032 £ 41 52 3640 HTTP iff K L 2B, 4L Web Session 91| #
%R e, 2L A% Session.

Delete request header #EJ0 3 54552 54~ HTTP ik 0k, A& iRk, <M

Set request header & J0 32 FF i — R T 2B AUE N HTTP ik 3k, sl HTTP ik
S U A e B

B & Breakpoints

Y 2 20 00 HE S 8] 7 s o e 0 o el 1 18

Break request on POST #5612 4 41 POST 3 5 ¥ Wiy 1 .

Break request on GET with QueryString &1 £: 4 Br 5 /0 GET H URL "85 T8
T R R

Break on XMLHttpRequest Sl 4 BT 47 g b af i il XMLHttpRequest A8 Az )il K i
WAL BT B oA RO il XMLHtpRequest 305K,  PitiZohie it
TR L2 Tl X-Requested-With (1H jQuery HERGHRIN) SCBLH). Bt R L=,
X-Download-Initiator, £ TE10 B T FRffRIA b ol AR F 76185 e 4 X-Download-Initiator .

Break response on Content-Type 3 Xl 23 2 it 47 Wi [ 3k Content-Type " 40 % T 45 5 C A (W4
I 5 L ) 7 M

W BE 4K 7553 Response Status Code

i BUBEES A T -{ﬂiﬂﬁliﬂ;ﬂmﬁﬁ?ﬁﬁ%ﬂﬁ Session .

Hide success il = Ba @I 50945 200 $) 299 2 (6] (L7 200 f1 299) BImgR . X28iRE
i H e 2o R Al D) . Hide non-2xx 35 10123 P R0 & 059 A TE 200 3 299 2 (8] (1) LY .
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2.8 FILTERS # 1

Hide Authentication demands 50 23 B3 AR A1 08 401 1 407 fOmI R, 1 B W s 2 5
iﬂ'*‘%ﬁﬁ 1‘5#

Hide redirects 1% 0 £ B R0 475 5 1 47 3 52 fo) (36 e 15
Hide Not Modified ik 1 23 i 3 fF R & S AR &L 0 304 pmi e, Fa3% P SeELEn
SRR T

i i 630 F0 )
X R T, PR 0] EAESBIYE Web Sessions 513 onmB At S B R, PR S RE
fat Sug oL T

Type dropdown %1 F& 3 £ 5 8 3 [ AV JE 48 52 28 4 1) Session.

¢ Show all Content-Types: A~itif.

* Show only IMAGE/*: [ Content-Type kA% J P {258 1) Session.
® Show only HTML: P2 Content-Type kA4 /2 HTML #5841 Session.
e Show only TEXT/CSS: B2 Content-Type A~/ text/css (f) Session.
e Show only SCRIPTS: F2# Content-Type LA AR F) Session.
e Hide IMAGE/*: 38 Content-Type 3k 1% BI{& R () Session.

Hide smaller than 25 100 5 5l 0 1 44 /1402 (1) 2 V5 8O 9. Hide larger than 525 5 BS 5 )
JAE S o B (el o e 410

Time HeatMap 53 HE 25 55 1 IR 45 3% 35 [0 405 5 opi 557 By 75 22 0 1 i) g B4~ Session i 17 5L
Bifs, Gllid Timers #1 % it 3. ServerDoneResponse - FiddlerBeginRequest). A #it 50 ZEFL(
Wy 2z LLER (R s 50 R0 300 b 2 s AT 300 R E] 500 SR 2 (8] R Y
PLBE (A R, i 500 =EF0fm Y LLET (5 8o .

U 5B [2] ) W 1 345 5E Content-Type A4, Block script files @ sE 2312 [7] HTTP/404
W 1 o A4 25 (0] %) 6 1 S F 52 Content-Type 24 B &, Block image files ik £33 [M] 404 Wi .
by LA 0] (o B 346 5E Content-Type 7 Adobe Flash (application/x-shockwave-flash), Block
SWF & T gk 23R 1] 404 Wi .

111 23 (0] () S 3 47 5 Content-Type 4 CSS, Block CSS files HETH 215 [1] 404.
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# 2% HE Fiddler

Wi B 3% Response Headers
M I, RO LU I B HTTP Wiy sk, Bl o R i i 7 ke (o S 45 I .

Flag responses that set cookies T2 LU 44 5o BT 47w Y 342 35 Set-Cookie (1) 5 .

Flag responses with header i% 5 3¢ $545 i HTTP W[5 3k 2 8%, fn S0 op % HTTP SLAF7E,
i% Session 7 Web Session F1|3h & LUKk 77 .

Delete response header #5032 #5475 HTTP WIR L #BR, WRAFAE Wk £ 88, 2 M
I 3k %5 .

Set response header 150 3 £ G s H HTTP Wi sk, fRnr L B L ¥l .

2.9 TIMELINE Bjalihsemi |

AT SRR <A " BURUE A 1 B 250 ANIE ) Session, 100 T fE 51 BT FER A
WRZ MR RA RN . ESER ERAER AR RS, ey B RE, B
i A A (BRSO F R “AL4mad 4k " ( Transfer Timeline)). diidifs LR BN R, &
T T Th B Bhaf 1S HE

fRiEmFpEEA R A d, TRUERE L RIS, R eER 2-14 Fracf)iim.

* 214 LS
MBEPEEE, SAFEYTEEEE, ERRTHESEERFER, AEERE
AutoScale Chart
#ahk
Copy Chart o A T I PR R L PR 3 DL B MY R, R L o
Mode T~ $ir 485 ) P S f o] S5k o

* Timeline: iflilFFIREEE & & 751 Session, WA FEmnimE
* Client Pipe Map: 554104 (a4l 0% 1 55 P 0 Fiddler 2 () (%2 . £ 4> Session
Z EIEH MRS TR g R ar

Mode (dropdown) " :
e Server Pipe Map: S84~ 0 (i) Fiddler 0 b I8 %28 2 (0] () i44% . # 4 Session
ZMERMERES U ERHEAK T
Client Pipe Map #1 Server Pipe Map #3057 % 3 0 15 95 25 2 o du o S 1B, 0 )
M4 5 LS04 99 I




29 TIMELINE B j& % % 51

et () e 5 T A B AR ] CONNECT A3, PR 0 2 3 0 ¥l o vl e R B ay, oy
fEdt ek 2 MR % 1 HTTPS Web Session M il .

291 #&3: Timeline (BtE)3H)

fEI TS, 14T 88— Session, HEAIAAYEM URL SPHIELH R LML, B
PRICEAEE R IEEN L, TRMREETRSERESMESHE. Wilizmna
ANIAA- Session A B fEAT B MR T SHIFT @ S7EH % 1 8751 Session AIH B

FIEER B E L WA MIME B8 g ). 9 a8 B0, RgE R JavaScript,
L Eyn CSS, B HAKR, Wi 2-11 Fras.

L e ——T
Lo N I
Mokt agr.ang |
rgh |
eaal I
Nt gl |
mpda | e a i . |
e g

i 2-11

{4 & EH: (transfer bar) 7£% 55410 Fiddler & i%#i3K ( Timers.ClientBeginRequest)
B T e . Ak [ %5 Hg W R ( Timers.ClientDoneResponse) WU E /G sticea . 4
R B e s, AP0, R HTTP WERE7E Fiddler Wi#@AF i T, AR
A HEE R . SIS UCE AR, Wk 2-12 B, £i% Session [ 0T SE R BT,
AL res FEE R .

Page loaded in Bullering mode Page loaded in Streaming mode

BH 2-12

ST op T [ 3 P48 e on HE U B AR % BRI ( Timers.ServerBeginResponse) 98—

39



¥ 2% H% Fiddler

FAT I . SRR 54/ 1 B8 26 75 Session AT B FERIE TR . SR
R Y, e P e s R R A R . b i R R s R 0 B Fiddler 2 fa] i
. F 515 B8 22 Fiddler 31 AR 55 28 0O EE

F IR S M AL X EbR R % 88 20 T iRk 3k Connection: close (X1 HTTP/1.0 2544
PRI, A4 225 SR 3k Connection: Keep-Alive 280, PRIl E LR A g, KEH L
Pl b e < IR 4% 25 WAV S JESE ) () (302). £06R) PEBRE RS SRR T HRREY (dxx 51 Sxx).

2.9.2 #&5: Client Pipe Map (& PPim&EME)

{E Client Pipe Map 80 F, Bifadh i & mpgEAGER K. Bt
PREF, Ban THERERR. 3R 1D BLEE PSSO Y. i, iexplore:1364(pl14421) 8%
PR IE, RS R 1364, AHFINE D 14421 38 Fiddler. %) Session 2 [A] T A (% th
R ETRES, WHE 2-13 s,

Client PortMap
wmeplore: 1 3644p14421) I
nplone: E0Op1440%) N |
aplors: 280014345 I |

s 2600(p1 4406 I B
s 2B0N(p1 4407 -

B 2-13

2.9.3 #3: Server Pipe Map (R % i & &)
{E Server Pipe Map B3 F, Bffuldh#on Fiddler o) iR % 3% 5% HH 09, &7 4. fElEE
(¥ 2 DAL bR R SF, 260 Fiddler B0 M 0 S M HER EHLE . BN, p14357->twimgs.com ¥
o< Fiddler {8 Fi & 0 14357 & T 3 twimgs.com [') 80 5§ L1138, £ 4 Session 2 [A] H A
EESRRhEA, WE2-14 FiR.
Server PortMap
pI4157-5 twimge.com I i
ol mbmg:mu.m-
pa403-s madaciedenacom B |
144225 maducdn deaus com Y {

514427 peslauressre o I
pl4365-> Lmchweb.oom |

FE 2-14
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2,10 B&% 5 ( AUTORESPONDER ) #15

29.4 (&R EHBHTIERES R

I AL T L2 B8 1 0 £ ML AR . WAL LT LR S M A ok
CRRER), Rkl FERRARI (R4 6 MER), CUGERAR SIS (4
i X BbR) HEEGR, FROTCLRERI, AR RIET Y, TSR .

2.10 HzhwR; ( AUTORESPONDER ) %50 |

£ 25 e 7 0 T 1 Fiddler BB 09— ohfik. &Ry a0E N, W] LLYE i R R AT A
ahfehfe, W WA AR (B2 R R, g A B i 45 28

TE B shm b T R oA sk, AEREEH] AutoResponder AT H, i iZiEIR
o 1ty A 4 btk 2 DT 0 B A URL i3k 1) Match Conditions 1 Actions.

Enable automatic responses 52 25 HEF5 il 22 7 855 AutoResponder BETI . W BE# ik iz
BT, R bR 3T A T AN el .

Unmatched requests passthrough ¥k J5#5 >4 Session A8 VUG &5 i () MU 25 %2 4T 4
B pEEm, AR RS IER RIERIR S &S, SR AutoResponsder HhiEA{r L.
WEAT D EE I, Fiddler 220 BT A RZM N 2 ARG H HTTP 65K HTTP/404 Not
Found Wil f152% 8 A6 2 Pk, Hrpau &k 3k 1-None-Match 5, If-Modified-Since,
Hli4 AutoResponder 2532 [B]Wd 1 HTTP/304 Not Modified.

Enable Latency i% 5035 il U5 A 554~ B0 0 i R S BPUAT, SR REAEIE Latency 7 Btop Bris
SR S, R R P EEI, Latency FELBEA 2 Bk OF R A X0 WY LA S AE A
AOLBR 5z o (0 - AR, BRI I 0 AT LSRR T .

Import £ HI 3 FAZMTHTRN SAZ LM SA LD IEA Session 28513
A T . MERT LS A FARX XCfF, ‘&% M AutoResponder HEXH= 5 th 3.

EIE R LR R, F-FURICALF P (Match Condition), ETFERIIAEMT
4] B B O i R R R ULAC i M . Match Condition i it (1) & g HERE R A Fakrp . 58
TR 7] U A T R A4 . Action Text W] BLIEE SR PIM AN 4, theTkL
R AT AN,

Ak R, 75 F A Rule Editor 3ETHE A o] L $2 4 W (f) Match Condition Hl
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¥ 2% HE Fiddler

Action LA, Test FEHE L FFHEIE T 4F 4 URL 83 Match Condition: i {538 1 FH 1E
FA, izThpEth R, Wk 2-15 Fors.

regex:(nm). Apg$ Motchstrgsendngwith PS v | Test.. [T
e

B 2-15
fE%f Match Condition 8§ Action Text fiUHATA] 2 )5, s1ili Save FHIHESE T H M0 . fn

RARED T 24N, Rule Editor 228 Match Condition ZEI0HE, F HL o] LA B 98 3 By 7 ik
HHEI ) Action Text B0, W 2-16 Bros. ZDIRESCRR 24~ B0 AE AR 1R i w5

Fude Ecitor
Lipciate Al salactad matohas b0 rascand with: : = |
NSRS v} i)

2.10.1 (EEEEFKH

BLAKS M F . Match Condition /2% URL $047 X /NE AN A UCRCERAE . i, SR
BE S0, FURS URL A~ & iia) fuzzle PR, BB SCAHEP B A NOT:fuzzle.
BB RE URL b A0 5 & fuzzle NS, KR ICAC LT 45500

http://fuzzle.bunnies.com
http://bunnies.fuzzle.net
http://example.com/Fuzzle/
http://example.com/search?g=FuZzle

UL AC 4> nT LAILAC AT A s B K

fRE A4 NOT:, ZMWI2VCH URL AELE S A Ak, VCRRNS A
W, P, A EER A, FoR URL LS 6 fuzzle MR, HaE Sk
HEPHi A NOT:fuzzle. BRAEETTRAT URL 43I fuzele (NG AHUE), 058 A] LA
UG AL,

AT EXACT:, nTRLSER Hobs URL /NS0, Bk, M0 EXACT:http:/example.com/a/
a] EAPLAC:

http://example.com/a/

42



2.10 @ shvEE ( AUTORESPONDER ) # 3

LAHEEAILACELF URL:

https: //example.com/a/

http://example .com/b/

http: //exanple.com/afotherstuff

S REGEX:HT4, o LUAHHERAY URL 04T iEMIDCRL, 26000 ilit NET i )&k

FIEERULELH .

CHTREBRIMMGESWMAMENRER: ABAHRAE. BB E
http://fiddler2.com/r/?RegExHelp A 1. &5 WL 2 1 W) ok AU ARt F .

215
g DL P i
fEMT AL — S A F R URL

REGEX:.+

REGEX: H. jpg.*

{E B £ A TR %5 1F jpe 18 URL

REGEX:.+.jpg$

{14 L jpg &5 90 URL

REGEX:.+\.(jpeigifipng)s

{EfTLL jpg- gif oE.png &5 409 URL

REGEX:"htps.+$

LA https FF k(T £ URL

REGEX:(?insx).*\.(jpgleiflpng)$

{EfTELjpg. .gif sl.png S5 URL. ANS A

LA I 7 g o, ek 3y AU R M3k A 2 i I (b S i) . IR

e (Pinsx) fOThBEER A

‘el NSRS, BRI, SSRPRATIE S, X

FROEFATT SR e . X FENRGE, ERFARATIREG “ —0mS, AAME". MRS
AR SRR, fRrT e R O O Oo%a S I E ek AR BT 4 .

LB R i

MR B A FIR 2 ARG B, Ml el &M AR URL, MW RAkRIEE
ST AT . FEULHS 414 i i 85 D0 i 28 URLWithBody o] LAY 2 Match Condition, fif i
6 5 POST o PUT ifi R (A AT VL AL B . A FIXPp ARy, MU 8 — 192 R 2l
P74 1 R DLACHT R URL ) Match Condition, 1f 7 %2 #3 (1) 3L A8 40 W4 24 i R 441 Match
Condition. [WiZ%JEa]fEH 44k Match Condition ] URL {4y, Min#fssil AutoResponder PLAL
Wk A ORI b . R R AR, WA IEREFT URLWithBody AL .

fEVLRLA&E (Match Condition) 7, B LAk URL i 04 43 54502 AT e EXACT:,
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#® 23 #H % Fiddler

NOT:H! REGEX:. #lim.

URLWithBody:
URLWithBody:
URLWithBody:
URLWithBody:
URLWithBody:

upload.php TextToFindInBody
login.php EXACT:Action=Login
ping.php HOT:POST Data I Do Not Care About

EXACT:https://example.com/upload.php REGEX:”.+TextToFind.*§

REGEX:".+/upload.php.*$ REGEX:".+TailOfPOSTS

icfE, % Web Form (] POST &8 AR SCARETTHRED, DI 1280 T UL A A - 23X
Foids. fltn, ZULACHI T POST:

POST http://www.enhanceie.com/sandbox/FileForm.asp HTTE/1.1
Content-Type: application/x-www-form-urlencoded
Content-Length: 54

2=This+is+some+textifileentry2=L charset =windows-1252

PRATUCAC 5 1 N 2L FE T

URLWithBody: /fsandbox/FileForm.asp This+ist+some+text

2.10.2 357 Action Text

Action Text Ji& i% 0] 25 & FURC & CFRT . AutoResponder il T4, nlfilt BRI (A M 4. il
¢ HE S o) BERAT —SE M AbERAE, 3k 2-16 PR

{Efa] Action #fiJ& Final 5 Non-Final 25%!. Non-Final 2% ) Action (117 o] LAV £ 4~
RO, L )i 2 45 52 (] Final Action, VCACIZFESN£miBH, % Session A~&rilt 4 iT M
WU UC IR o 0B A O MG 3 DT AL £, S 7 2 8 75 R ot O O MG 4 0

% 2-16 Action Text
Action Text 1 Final?
filename 4 filename [P FE4F Bw yes
hitp://targetURL B[ targerURL (N FAE MR, & Action 7] ELFT AR R B E 1 | yes
BRI URL, oA il S - 4 5 1

*redir:http://targer | R[5 # B % URL () HTTP/307 52 ) R . 48 1A 88 *redir 77U | yes
URL PR SR AL B R, M i AT AR IE AR ) cookie

*bpu o T R no
*bpafter A o O £ no
*delay:#### HE AR i) AR 9 28 A2 AR 2 W R A R 8 no
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2.10 B &9 ( AUTORESPONDER ) i 5 £

¥
Action Text HAA Final?

*flag:flagname=va | i Session Flag W 8. #in. {#H*Nagui-bold=1 27 Web | no

fue Session ¥y 3¢ o BTG AT 0 . 36 00T O 4F HT 2 1 B 4R E
Session Flag

*drop AREwp, o EXMAE wiEE. W TCPAP EMESR, SEEE | yes
LW FFi, FI%E ) HE R FIN

*resct FREWPE, T EXMERIEE. W TCPAP ERHKESR, ZERRE | yes
FISEITIT Y, (& SRR [A] RST

*exit 5% 1 1F 7 b B )RR ) yes

AutoResponder #5045 % 8 T MBS VI A M S0 0. 2 g A b S PRI, Fiddler 22
HiiZocfE, MAESCHREL 4 HTTP SkJFk. MYLREL HTTP 3JF3k, 7Em R I £k [B]ix
Y5 HTTP 3k, U8 FRSCfmaEEhmnik. WAL, Fiddler 2 B E BN I 3L,
M N EE Rk, RO E A, Web Session ##ha IR MUK E

7% Session.

2.10.3 #} Action Text 5 Ff IE M ik

Fiddler () AutoResponsder ¥ 3 ¥l ] iE W 26 k50, FICAL S o () SCA T # Action
Text (Action 3LA). ZE4@F, LLTF RN

PLAC A Action Text

REGEX: +/asscts/(.*) hitp:/fexample.com/mockup/§1

2240 K hitp:/example.com/assets/Test.gif VLA EHREY hitp/example.com/mockup/Test 1. gif .
LA R0 -

N e Action Text

REGEX: +example'.com.* | http://proxy.webdbg.com/p.cgifurl=80

SESERE M URL, EMATH % examplecom I URL #4{Eh URL S¥fLe5 M
proxy.webdbg.com.
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% 2% R E Fiddler

R M e B 2% LR “AsesE” ok “H4RmsiR” MA, ML T AM, &
iy A, i, A ESED T URL:
http://example.com/main/js/main_c,.ijs
i1 s R F DA AR A
http: //example.com/main/js/main.js

M2 m] LA WA, EA RN AN ARG, T,

M. Vi S Action Text

REGEX:( 7insx) hitp://example.com(?'path’.+) c\.js& http://example.com$ {path} .js

1 RSx4 12 Y path A9 BE P AR E B SCAFEETR, (0 H 2 BEEHE Action Text (1S {path} .
PR T % URL (9 EHLaRE e, i oy CLET S la S, o7 LS. ds i i & 711 2 5.

DD REIR A HE, 93 URL Bl SO dend, ol CUERHT Sl e #H, PRBELL
LU

Match Text Action Text

REGEX:(Tinsx ). Hassets|{ 7 fname'[ “7]*).* Cusersericlaw\desktop\$ { fname }

2541 hitp/example.com/assets/img/1.png?bunnies Ftal C:\users\ericlaw\desktop\img\1 png.

2.10.4 ¥EREFE

AutoResponsder BEIH = & K0l F il chfig, #2#A 602 AutoResponsder B0, il i ThfE,
ARG Windows Explorer IR CPFaR Hak, Aot fah b domm. gest, iEnfel
M Web Session FF& Pl Session, Mifu T Z AT FiHE A ma R, of LLE S B 344 T Enter
fit e b U] 1 F S0 P ) Edit Response T, 4 2R W00 T CR7 10 0 1%

BN (Rules) #|EARPAM L FICEREME 2-17 oS .

+* 217 By RUERS
Remove MRRIE b R, gESh, P — PRI, T Delete it
Promote Rule T Ferh (AR AT A — O, TR — P, H T Plus i@

Demote Rule ) b L e S R A — A O TR P — R, T Minus 8




2.11 TEXTWIZARD

A HRE R AR R S 0 PR ) BE AR S 8 B, T LR 50 R —A S0 Fiddler

Set Latency. .. E 0 T () S P4 WA i, 4 50 ek,
AL LALE BT 0+ - 5, U 0 o A 4 s St

Clone Rule S R, R I 3 e

ik Heoponso HF LB R S N, TSP CE . A e AR e P i R,
T IFERSE () Inspector B 11, S35 e oo
O T2 ARG A P - R, e R A 3 SRR, TR ) AR .

Generate File L BT AR A D Expression Web X Visual Studio) SaBtRaRy e, @H1E
fir &

Edit File With, Fhah o, ATCUEFR R R, aRdR e, H RS i e ke e e i, g i
4R A A TR R B PR R O B R

Open URL { HIBLIA (Y Web 30l 2347 FFEETLAE &8 (Mateh Condition) S 4EEM URL

Export All.. L AR, TS R R A R FARX SCfF. ST ELE AR SO, LT I A

2.10.5 FARX x4

Fiddler AutoResponder XML (FARX) L4 7541 AutoResponsder #IU. 5] AutoResponder
FRIE LR R Y Fiddler I 4> B ah 97, B K5 Fiddler B & ®H . Bahfffrm a2
AutoResponderxml, WA Export CFil) fv S0P CPF, S8 fax X EH.

FARX CfFfnSocBemt i imige, G55 it B w5y, 2 5 o] LA 1 3 B i .
il 2 base64 ST R ESE A3, T LU SO A/h, {HU2 AutoResponder SEIIFIRHE S
ol oo L ) /RS & BB FARX SCHFRTR K.

A4 2R AutoResponsder BUII4E 2 7% Fiddler 3zhBt Hah EH k), KiEL FARZ

SR T8 Fiddler Fah3R® ., B0 G0 sh A0 ) B, w4 A B S S BEE AP Y FARX 3L
e, 7E XM Fiddler 2 fir A B A 91 3 B BR X Lo B0 .

2.11 TEXTWIZARD

S Web PAA TR, AR — Fhak PR s AR AT ARG . TextWizard 3 FF U
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F2FR  HE Fiddler

ESCA AR AR AR 2, B T RS AU i A

o] A3l i 7 Tools > TextWizard 5% F CTRL+E 847 7T TextWizard, WP 2-17 Fi=.
af kLR 4T FF % 1~ TextWizard $5 01 .

I 2 e

B 2-17

TextWizard |7 B AMWAHME (Input box), TJLAYE %46 AMER A SRS LA . 1 TextWizard
R R, vTLLEFERE R TS, ARt OO, (B4 R RYHTHHHE (Output
box) BLHEAXER.

A R P R R, SR E RN R . AR CHRT LR
i3k, A4 Send output to input $cHH, RS S ERE A NS 0L BE A SCRHE, RGiE
RN T — .

THATIGE, WMBERSWYIEERN AR 32KB S¥ D, &HMEHBMAED. YEH
SAHERYSCACR, 2xSrBIRY AP RS . PREEEEES T SN ISP T L B R S
T

AT e 2 e P 0 (S E T E8), TextWizard 23 Ll Unicode # #0754 40 22 it
(OxFFFD, €).

HILHE View bytes SLRFLLH AR AT AWM, ST Cik bl A U il
A IRA AL



2.11 TEXTWIZARD

Send output to input 44§l 3 FFAUEE A SCACER AU HH AR, R - R S

% ITE -

# 2-18 S AT IR A e

%218 A R
— UG AR R S UTFS, #8056 H] Baseod S, 245 Baaidk 7 47 ASCI
i e
From Base64 LA TR 7 (0 ASCIL BOREHT Al 1 BEEL, SRR AR R UTFB FREh
URLEncode CESRA TR LN A URL 565 2 1)
URLDecode MAAFRF R LAt escape I %147 ¥ 65
HexEncode AT ST T AP R B R LT RO L A R S
— HEEEBR RN, Carriage PRAR, BATHFMSARn, "BHREE", EH ASCI 127 1F
FFEDWAROCY deas,  Hod XXX B Unicode 5%
From JS string To IS string 354 11 S 80 1
HTML Encode FEH] HTML SO i A P 1T DA FT e, < nde e,
HTML Decode HTML Encode 8 {}: (1 5z 44
To UTF-7 FHEL A £ A A VT AR AR T Sk ) UTF-7 45 i
From UTF-7 PN T AR R UTF-7 7877
i AR UTF-8 7%, H{EH] DEFLATE R, LR THRERR
1o DEEIAML ) Bascod, MR AR URL i
From 7 FF i kL URLDecodes fi#47 il Baseod, FEifeml 7 T8, A8 dbiT i s, 16
Deflated-SAML 5 QLB BB UTE-8 T eh
F 1 4t

BT, TextWizard 2l H] UTF8 fE 7RI 2 B b . 4 K EH NS
H UTES {5 ket se At Ao, (R i ORI G S AE T I 0 - Fbgm s 2y a8, wl Ll
Preference, % £ B 1Y ARG 60 .

¥ 1 Preference fiddlertextwizard.InputEncoding, 72 1 i {8 HIWE 17 15 S 2 Yl b (1) 7
FriEAT 8809 . %% Preference fiddler.textwizard. OutputEncoding. i B % {4 FJ O~ FrrSE T
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¥ 2% FE Fiddler

Yolkifh. PEOLAD TR S AR, NET HERAESE BRI ML, A28 4 ELL FaERE T L

$&#:

http://fiddler?.com/r/?EncodingNames .

2.12 COMPOSER i&Hi |

Composer 50 F 3§57 F sh ) @t fIA X HTTP. HTTPS H1 FTP ifsk. tbah, nl LA Web
Session F 2 i Session, B H] Composer ZETH o, 1% Session 53 8 2 H
¥tin. siidi Execute $2H, 0 R A 3 IR % dE 0 .

Composer ¥EIF Ak th =~ FRE T F4LEAY: Parsed. Raw Hl Options #0500 F. Fli#i%
FERERRREET R, A TEFEYN, WA,

(L &7
Options ZEXH 3L AEAE S Ik 2-19 Fix.
® 219 Options 11
Inspect Session WKATIG . Inspectors IE Sk &BERGE, T LIEH ik 1085 B

Fix Content-Length
header*

LIS ] Composer f& % 2 AANHR NS 2 Content-Length iR 3k, Fmiff R4
Kpe
Ei WL P, B M Content-Length k1% K €2 hang ('35 HTTP W
tH &b

Follow Redirects®

% M 1| Composer &5 H a8 ] 1R () Location k. M7 HTTPBxx B3 5.
WHR R R, Composer £ M il £ 240007 10 900 5 iy

Automatically

Authenticate®

AT Composer 15 & MW % &5 HTTF/H01 2 HTTPA407 DE K.
WAL PR, SN Fiddler FTZ 4T IMEF 1 Windows iE 15 [1 8w R 1226 o] 14
B A Pk i, B Preference fiddler.composer. AutoAuthCreds.

o) LM 8 0 (0 S AR iy DR S A ], T R e, i £ R [l HTTP/403

Tear off button

4% 4 M. ¥ Fiddler % 0 BB Composer, F-4E 5 1E 800 it BT & 01T IF.
WL Inspect Session MENH, R AH, FhE LFFFEFEH Composer
il Inspector 1% 5




2.12 COMPOSER i#% 3

CA*br iR T S UE ] T Parsed 3550 FRIENEK: M Raw IR R RA X
F i eI

Raw ik

Raw JEI0 RO fR] At SO AlE, o LYE i 0 AHE PR NS 38R HTTP iR, i Stil kg
AR CHolmE e A SOk IS #T CRLF), 27 Execute H8ll A2 it ifi k.

Raw 3 10 6L A flf H——# 02 80 ok b i R Parsed ZE70 5.

Parsed iF¥k

Parsed %100 - Sl o by B SR 0 4 FH A0 (A HE R B oK

TR b7 =AM ARE . 55— AHE LFFIRE HTTP Jiik (i POST); 5 1%
AME R i R D0t URL (24261 L1 httpe/ . https://i, frpo/ 3k ) 85 =i AKE S FFIESE
HTTP i 4SS CGEFE N HTTP/ ).

{Eak o ek iy KR SO B B s AHE Pt k. & F A MmN
CErmBL R, WA 0 HTTP A irRE (i GET A, ek
AHES A SCARNT, S AHES: Wi .

AEFEFEIEK

PR dn Bich, 0] LUR S B Uk, X hTRER T R ah, HfhszaE. Fin,
MR AR B AT A 0 B RT, R AR R AT 0 E AR . Composer W] LA K
— BV TFR SR — S EL URL D8y H BN 8 LA S s ipal, tnp 2-18
.Fﬁd&.;.

GET v hittp: [fwww, example. com/#.3pa ' HTTR/L.1 -
Request Headers [ Upload file...] Help...
User-Agent: Fiddler i

Haost: www.example . com
Referer: http: //www.example.com/displayimage/# htm|

H2-18

S RIMAT G Fiddler 29 O GEHE, ZREAH 807, Wi 2-19. ATUIBE R A
AT (i 8), MR FTAT BT L AU AR A B e, IR AT 0 e, B
WERAT A I URL $Cr A -s w8, IR0 08:
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2% #H % Fiddler

g 2-19

% 2-20

RO T AR RECF S, Fiddler o Gk e K EM-RIFH], Wi 2-21 fos.

Web Sessions
Protoonl Host  LURL
warn. example.com 08, jpg
W, example. com  f09.9pg
Wi, example com (10,509
wanal_exampie.com 1109
‘W exampie.com (1250

&
o]
O]
"_'
4|

: EEEEEN]

433333
Jeusuy B

of LT R P

B z-21
R4 B8 SR R, BRIEE S0 Referer 3. 763/ KA Referer 3k i i 44 5 #,
21 Fiddler BRI Ml kS H ¥R,

FEH) R R A TEE ] Parsed BT R A VT WSRERELL Raw B0 FERY, #4&
1A Al A b7,

L EfEIEKR

af LA s e T A E i 4SSO (Upload File) BEEEGIECHF L4k, &3 Select
File for Upload JCfFEHEW 0. MRzt PUT, HEsEE 000 WK &2
POST, o] LLEFF £ L.

B AR S, Composer AT LLAEE £ & & X e zUR0 Ui, i RiTnd, ki
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2.12 COMPOSER # % +

(1P i @INCLUDE 45| &8 elidlie i m .

T HTTP &, S0fF LR 4ER PUT 88 POST A#:dhiTi. S H pUT Aikdhiroit
fend, ikEEN O RSN, W 2-22 Bk

PUT = hitp://www.examgle.com/uploads/flename. avi HTTP/1.1
Request Headers
Content-Type: video fmp4

User-Agent: Fiddier
Host: www. example, com

[ Upload file... ] Help..

-

3

< BINCLUDE *C:\Users\eridaw \Desktop Flename. avi 2>

4

L

B 2-22

Hitb2 =, A POST J5ik [ f%ill % 2l Content-Type: multipart/form-data % i 3k ¥ it
franalte, W 2-23 pror.

POST - ittt e excample . com jupload Acoept. aspx H:I'li’.fl,i . -
Regquest Headers S [ Upinad file.. ] Help..
Content-Type: multipart form-data; boundary acebdf 13572968

User-Agent: Fiddier

ReguestBody

SPTE SLSU
Content-Dispositon; form-data; name ="feldMameHere™; filename = Flename.ani™
Content-Type: video fmod

< EINCLUDE *C:\Users'endaw \DeskiopFlename.av @ >
acebdf131572460 -

g 2-23

AT POST A&, Tt Name iE, BfREMESEHEETEARILAE.

B ahifKE A

{E R4 5, Fiddler (1 3R Inspector (¥4 41155 L Composer #6151 F W4 . i il7 Execute
HeaReE, #T Shift B, ATRLYEFTAO R R E . TEWTEAE, Y Session £ BN

5, K Inspector. 1XFE, 0T LLFE BT A G ROAE B RR 425 200, {E A Fiddler Inspector
TR .
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B 2% HE Fiddler

2.13 Log %W |

Log £ -F WU FUE R 75, X i 2 th ¥ . FiddlerSeript 8¢ Fiddler 454
il . Fiddler 2id 3N FI4HE (e fRA7E0INE SAZ 3CPF) LLE RSP (R masiE
e L e ) MmNl .
{E 50T 1Y) Fiddler R 441, WebSocket ¥df ifitth vl LAYE Log 370 |- &8s, W 2-24 Bk,
]

-= Fuldler Event Log =-
it (e Sideller 3. comjredi (i wFiddier. og for detals.

08:03:40:4984 Fddler Running... |
08:03:40:4984 Fiddler. Network.AutoProxy> AutoProxy Detection failed. |

08:03:48:6116 hetworkAddressChanged.

08:03:48:6272 NetworkAddressChanged.

08:03:56: 2463 Archived sessions loaded from:
C:\UserstandawDocementsFiddler 2\ Captures'test saz L3
Fiddler (v4.3.7.2) Session Archive. See hitp:/feeony fiddier2.com

108:04:11: 1578 Fidler Notwork AutoProe> AutProwy Datortion failed.
B 2-24
Aiili Log SCAHE, 28 b FICRA, ROUNH S0 M SRR 4.

Copy | %3 =ty S 5 1) 3] B Wh R
Save... | EYHH SERIRM . arelURal AR, thalbl 2R em e CARL (an
Clear | %% Log ® iR L4

Log iEXi £ £ F M i ddr S, ATBAM QuickExec AHED P HIX @4, FA log
@Log.Clear Al ¥ H& . HiA log @Log.Save i {E Web Session ¥ % *Eple i () Session, %
Session [19Md P 44475 Log IET0 R 93CA. HiiA log "@Log.Erport\"filename\"" i] {1 Log J& 1l
S ARAF B R . 4 Unf &R, oI LR b B AR AL, R hRLE,
2% LA 1 45 BLaxt &5 R OR A7 b Al A

2.14 Find Session i I'1

Fiddler [} Find Session T I 5% Ff 48 22 5 42 3 005 omma Bz, 22 o - 8 000 ) S0 A i)
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2.14 Find Session fif O

Session, W 2-25 Fron. kL Edit RS, sLE 7 Fiddler P4 Fikdis CTRL+F, al4T
JF Find Session B 1.

fndSessons
Fipd: |lexk o sewdh o

Ogrtiora

goarth Requests and responges, | v

B rienders and bodes w

[] Match case || Regular Expression
[7] Seaen binanes

[ 1 Decade tomareds ad conbest
I: ] Select matches :nf;m'h ol results
Hesult righiigkt: | Yllow -
Concel

& 2.25

B 17 1% Find S AHE LR E BI0RI A . BEHEN FRy R Bl g,
{E S A 25 sl #b4

Options ZEIRHEFS AT, Search FHrEIIHE L FFHR M %A, {055 Requests and
responses (3Kil{i). Requests only. Responses only il URLs only. [+ URLs only, 770In]
{4 11] Examine F 4457 M 754 8184 Session 1) Headers. Bodies slE M ##58% (IRIMD.

{6 FHOEmHE B2 —4l8 ke, Match case HETIHE 384 ST . Regular
Expression 4~ Fiddler I i% 0480 38 SCAE 4 1F WIF2ik sUAb Pl . Search binaries ¥E 5 32 ¥ Fiddler
{r Session P iEH %, H P Content-Type JsFesriwr R alimi i 4 i)~ BEBI2ERY, ns s, .
Flash #} %% . Decode compressed content i % ¥ Fiddler M8 2115 2 Fmy 52 op i Bx HTTP
PR Y . I S R R AR R, AT R AR o A N Y e A TR R
44T 7F Find Session % 1, 40 %L 4¢ Web Session 5411 77 £ 4~ Session, i &8GE (il 1A
ihi# 7 ) Search only selected sessions 15 HE. Select matches 170 2 {4 Fiddler H &k P 41
&M A K FT T Session. Unmark old results % 50 £ 4.2 i 4832 &5 S b B 47 & 42() Session
HUi #94E 5 5. Result Highlight G000 HE 3 Ry F6 75 St fn, BT 5429 A1) Session
Tl Rl sEi e . i S E P Unmark old results 370, & X3 4T Find Sessions #{Et,
S HA RS, RaER, T EUERERN, BRERS A RRNERE w5,

B TS, #F Find Sessions {581 7] LLihfT#8% . Find Sessions B L1£:9¢H]. {E
Web Session ¥l Lt B CRl SR e B CimBikep &g M), Fiddler PR &8
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2% HE Fiddler
TN

#% F Cancel B2t Escape i LUK 1B 11, ARATIHE.

2.15 Hosts Remapping T_H

Hosts Remapping (EHLEBSH) T HATLMRF WM —& EREMBH S & Ehl, &Y
HLA B TP Mk e 2 6] #5590 %) DNS S, 25 Hi%2hig, vl Fiddler I Tools 328 £T
ifi HOSTS...J0, £:3fiH Host Rmappmg W, ik 2-26 Fias.

Hmwru R T L )
El.n_u g of fnrmrhﬂttnl”.ﬂiﬂﬂul’,mmm Halp
Mpdirect requests for the Produ €Tion server To the Tnternal Dev SErver .
deyierver production. example, com

Wedirect requests Tor wein. exXample. COW TO0 LOCATHOST
ipvd, Fiddler o, Exhmp e, Com

madirect requests Tor ToSL. ﬁ'Fil co| o 193, 168.1.1
152.168.1.1 cest . exanple.

dExpmp]le

=
un:rm;: nnq ] LR DS T Impart Wisdows Howts File ww i

M 2-26

Al LLillid Enable remapping SEHE R I alEE A AE. {EOCARESR, MIATSSE, &
fT—%. ER—FPHAFR LA IP fhhl, RN EAF, BRERERSHENEL.
TR LSS I L, TR EITRIEE.

af LA O R R, SRS HOSTS L (%SYSTEMROOT%!\System32\
drivers' etcthosts ).

H Windows [f) HOSTS CfFAE, ZIhAEA T E455 8 HAslt) 1P bbb, HiScHL, wTLLfg
BNl TWEAE, EeTLERE BRD 5.

EAT R
127.0.0.1:8088 meddler

2 53% hupy/imeddler/ 3| hitpy//127.0.0.1: 8088/ BT H i K .

ifiit Host Remapping LR — 4 FH L EHHHB B S — 1 EHLLH Session £ Web
Session F #e LUl B %05, R HAY HTTPS Session U7 Session #2&{ X-lgnoreCert
CNMismatch Fl X-OverrideCertCN, LU IHBE “iEH54 AUCme” iR,
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o 3 e

Be sy FIi

i-'

3.1 {41 Fiddler 5 i B it

Fiddler #2417 PP ik HERM Arid. st F&E 5 SR % 250 A& 8L,
Tt S0 ) 0wy A B PR 8 o M b

HiE1- &S

5 Crewrite) JEFRIEN Fiddler #0i0if RL M NAE (HE URL 80855 R L1 HOST ¢
By SEACk AR RS & A DR R IER RS % B.

2 AN s S A il R AR T e, R R ST AT cookie iR T GG
) URL, A28 URL. [EFE, Qo 40 70 0 W 2% ) Ml 42 58 DOM #ep 5 5 & %5 i1 URL.
s % B4 R BUGR URL, i A~2 5 4 i B URL.

PRCA T RIY URL #1 HOST TR C & el T, B BUE'S 5 i ko] L4 A 63 |-
EACIERR 5 28 100 A 2= AL AT AW ) B0, ] o B 95 B A M B0 i R ool LA 5 R 3L 1) HOST
FB.

WL HTTPS #bnsds 7y 2050, 4R ol B HEHR % 5 S vk STRL B 0Y ur
1o, BLBESR B “iE P B A" R, EHBX 0, TR EIEN
X-OverrideCertCN #5ic 1 1 Fiddler 5 2 40585 F P 50 (Y Subject CN ( Certificate Name ).

HiE2- EBEH

G C(reroute) EFEAEAGER, A EERGHASE A MRS RSSE B. A1
“WE" M, Fiddler (£ MRS 82 00, KB KA UM R ERM G, Fik, Wb e
FEFEFZ G KM HOST FEEATREM LU, i) 4 B A~ 221K 1 X-OverrideHost br & 9 By
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FI318 HOh#s
RE HH H b b

P AR R R T A, B il R Y Host header, URL Hl Cookie *h {§ {7 #ilif jit
FEEG EALIOE S, AR b B0 B bR EHUGE B BB Bk KA1 Fiddler A B fiE 454
SE TR B I ) H A IP HuhE e A GRS IE R LAF. W Lirai T MOCICRERR %28, © Xk
LA B Fiddler () BBt K, ¥ (8 H sk o 09 s HOST “FELE T #th . Pk, RS
it EFH Host Remapping 1T J i ¥ #5547 X-OverrideHost 1 bypassGateway (F11i, LA {#
T e R ok T LA SR AR e L oA

4 Web [l 9 a5 B BCEHE R I, 3Rk Host FEUM L R SRR %38 EblE, BN
WK ELAR 7R, (HAFS A EEN. RS TR SRR R, R[F] “No such host is
known.” [ HTTP/400 §f {58, IXHUR T S S0 ARG .

2 HTTPS ik mE 3 G laE b B/ 6ok Fiddler 22875 280 “iF R MA
VLA™ e B 017, S{ER T4 FiddlerScript X [ 55 25 (L B I .

if (oSession.HTTPMethodIs ("CONNECT™) && oSession.Hostnamels ("example.com™))
{

oSession["X-OverrideHost”] ="www.fiddler2.com";
]

HN4E htps://example.com/B 253 HHUE 15 A VG AL A B &, o RS 284 OL 00 & www. fiddler2.com
WIAEH, A example.com FUESS, WHE 3-1 Bras.

lgnore remote certificate ermor? [=]

Session #1: The remote server (example.com presented  certicate that .
e ot vabdate, due o ftematel e Sfcatchiametematch.
SUREECT: O =weerw. ficdler 2.com, CUF=Ooman Control valdeted,
Cmwen . fieldier 2.com
ISSLUER: SERIALNUMBER o 799287, (HeGo Daddy Sease Cerbfication
©="GoDladdy.com, In*, L =Scottsdaie, §=Arirons, C=Ui5
EXFIRES: Dodli: 12 P -

Ignore crrors and proceed amyway? | yes || We |

F 3-1

AT LI i B b A X-IgnoreCertCNMismatch, 8 S5 HH UF 1585081 B.-

if (oSession.HTTPMethodIs ("CONNECT™) &&
oSession.Hostnamela ("example.com™) )
{

oSession["X-OverrideHost"] ="www.fiddler?.com";

// Set flag to suppress Fiddler's HTTPS Name Mismatch errors
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3.1 {if B Fiddler ¥ 5 i 48 3

oSession["X-IgnoreCertCNMismatch™] = "no worries mate™;
b

b B bR 3 s A A R IR B A i BLAEAS, R PRAS B Fiddler S Mg 215
(session) BT HE el iR ®e 5 0, o7 LA 9§75 47 X-1gnoreCertErrors.

Host Remapping ( EL4 SmkA) T2 53 X-1gnoreCertCNMismatch $7.5. ™4
BELUE 152 FRAS VL ACE R R, BLAR o0 T S5 b 4= o () AL hatps://example.com/, il Sk B 31 /9
1 https:/fwww.fiddler2.com/[f) 5T 1fi] .

HiE3- EER

Hi5E ] (redirect) J£HiMid Fiddler §5% ) Wi 2] HTTP/307 HUSE [ W2, {H 1% 0 sl
FI i URL SO Acidif k. BUARITEH AR ERMER IS, FreleaiEiik AR ET
Ak, A E A I i R I 25 B Host LA URL. %4445 Hs URL Sk &
cookie, WIS ALIET HTTPS RiXM, 7 5 5 i H R 5 8 0 3 0 H 4R URL 14 3ER
U5, B A 6 0 B i R B 60 (2 3 (11 H 4 URL B HCUCACHY Host, 3P s fil 88 4 4> i
it L AR R B W RS .

EEMIRKAITIEE

Fiddler SCHFifik LT LA Zhaese Bl i =FhRertiR AR -

1) il Tools H AL IF HOSTS. .. fiv4, A LAHSHCE SN —~ TP Huhb TERE i 305 —4~ 1P
k.

2) iliit FiddlerScript #i4 i€, ¥ Session Af %1 X-OverrideHost 5.8, A LU ¥ ifi
M~ 1P Mkl Tk eh 8] 55— 1P Hhbk.

3) it FiddlerScript SE4 i, ¥ Session 1%/ host ¥ fullUrl J&#E, 4~ URL
iR S F % — 4 URL.

4) it FiddlerSeript 8544 R utilCreateResponseAndBypassServer 77ik, aJ LA —
4~ URL HijE 4 3 53—~ URL.

5) ifiif AutoResponder, 7E Action SCAHE 4 AHTH) URL, #JLME -~ URL filfRE
5E ¥ —1 URL.

6) il AutoResponder, 7F Action L AHE-P 3 A AT S *redir:, o LI — URL Bl KR
iE [a] # % —~ URL.



FI3F HOME

7) ifiid AutoResponder, Tt Action JAHEP S A *flag: X-OverrideHost=targethost, 23"
4~ URL (i K Ei# th 3 % —~ URL.

3.2 Session k&%

R G AE 95 v J 6 L — P T R 000 5 O A A AN R B 5 — A R, e X
FfE%, 7 EMKAE R AT Session LR LhAEAY S T LI L FF.

EHLHIPI 1~ Session,  Fif EAT Web Sessions #1| e PP IX P~ Session, #RIG M LT R
ik F¥ Compare #8l (SFAT T CTRL+W 8). $iTadlbam2mt, AR Session = #ifk
FERNER SCfEh, RGBT R, DM MR SO R et e, P 3-2 B,

e e = R R R T 3 AR o 5
e e S e RN e AT L A

GET hEtp:s v cmhancele . confua.aspl HTTRA1.1

| ot : wew . enhanceie. con i
Wser-fgent : Wazillass. @ { {
i» ¥ conpatible; HSIE 19.0; Windows HT 6_2; Wkeh; T

t-Emcoding: geip,

iz e e e e e e

13

14 HITP/Y.1 200 oK {

15 Comtent-Type: text/html; charset-utf-g !
1 1 Bake: Mi 17 Har FE1Z 15:h :

i (5] Bxb% OHT |

1" %
1 Ll

— -

B 3-2

Fiddler #7 A A H TR, ARL 2 7% %% T WinDiff, Odd. Beyond Compare.,
WinMerge siitfh2Eple TH. mERECELE T WinDif TH, #££'E4# U H\Program
Files\Fiddler2 3 fF 3% F, BL# 0 E ¥ UL B REH A PATH #%#2 F ol C:\Windows\ System32),
IXHE Fiddler SERTLUAREIE . iR ORE A L3 M O EE T R, nTELA hitp://WinMerge.org
T4 WinMerge.

1 S A5 ST Fiddler HP 4 i g T HA L WinDiff, ] QuickExec #£3 about:config
TR E = KM (Preferences) J5, SUATLUARCATIE T. &4, 00 THAEE2:

&0



3.2 Session th ¥

PREFS SET fiddler.config.path.differ "C:\Program Files (x86) \Microsoft Visual
Studio 11.0\Common7\IDE\devenv.exe"

WIS, RENREZER TRMGSITTEH,

PREFS SET fiddler.differ.Params "/diff \"[0p\" A" {1}\""

PRIEFT LA T “alternate (FCARETD ™ @y 4T, SR WAL SCF LB hRERS, ${E SHIFT
B SMATIX 4

PREFS SET fiddler.differ.ParamsAlt "/diff “"{OFN" ANF{1}\F"

B alternate #r-<SfTIhfE, W LU SO HE T RS FEGEL. Wi, WinDiff S£$5-p
S ATPRERT, STER T HB 58— 5 b i3 . 29RTE v i Compare ™ B0 I £ (¥ SHIFT
#, Fiddler 240-p brdifr {4y WinDiff, {Ef-PWidboFE 17, W 3-3 fos. X8
At TEFITRERKMICERRAA (I URL M RFRH),

Enhancelie.
coRua .
aspx HTTRM.
1

Host: www.
enhanceie.

[d ]
User-ngent: Mozilla/%.
LA

UltraDiff

BLAOL . Fiddler 5 WinDiff S0P 3L 9700 Ho g TR, S ham 3 i ke U4k,
LA S . XD E T UltraDiff SEE0RY, &2 0CER N 0 il R Sk e, Bk
B4~ Session 318 52 4= M1 17 () headers 5 W <TE A, #8455 ZHUHA F Y headers, 555 1 5
AR SE4 A7 Session [f) headers. UltraDiff & R URL TEFrA148, M\ i £ GE B4 5 4~
URL BHRMMES (Hin URL & 512 478, 6% URL PRFETFRARRED, &R
7E 7 b o] LA A B 6 Hh k.

I B4R A B Fiddler 75 4 77 il K 00 B SO0 A A B 45 2t headers 1 URL, #J ELE
fiddler.differ.ultradiff %15 % ¥ 4 false.

[E & bk §E % 4~ Sessions
AR N Ee B £ Sessions (ILE LA SAZ ), MiEMERY RE TR Traffic
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FI®E HOIWEE

Differ, X T HIR T3 B, 70 6 T, &4 B X0 Web Sessions 7| & iTH
&, i HLSE R ) P i 851 Session AL EE.

3.3 Wixiiit

TEARSEM PRSP, PR0] LU R R P IAAT I ZE R R 2 AL i, X S . 25
FFAEWT A R, PRn] AR R IR, S AT M A R, DLSCERT AT .

Fiddler 4 Web #sRIEQE T LLA, JT W ARl BE. Session fEMITELR PHFEA
A il e O 11 e )

1) WESIRERERE, fEWlRERIESRE RN,

2) FEMRS PRSI0 MR e, A R [0l % S 2 B -

TP I8 S FR b  SRBT 0 Crequest breakpoints ) FIWIR T 4 Cresponse breakpoints ).

PR IETE TR S BT, T LLFE RE 2% R, A13% URL. headers I body.
ok o] LU FE A R Ol oR IR S 88, Fe W RGE NS & S . KRR T, EO5E
R A5l Fiddler 180 T & 1 K.

R R 4P 700 T 057 1 BT 44T L S 8 2 Y 1Y 28, 435 headers B body .
P i W] LB RO (0 e RN, EAC DA JTBE 5 o i B e L A PN L, R leT L
EdMEEE P AR, HEH T RERCERIBSMSER T, ZEN N Fiddler
P A Rt 5 % ARG FB A B R il e i g

WEE S

Fiddler % FFZFpMhr ¥ iy, HEM b, S0 ETAE® Session MM~ 4r
X-BreakRequest fil X-BreakResponse SEHL(F].

3 3 U 1] 52 5 Rules > Automatic Breakpoints 85 if7 Fiddler R £ 2 W50 3 4o, #
A AR B M T ) R i R v A A I A R M S A B A A T PR T R
S TR A T T TR O A R N Y D T R PR

MGy, AT LA A Filters 8 AutoResponder 5% 34 R s (7 7 £ Filters B2 5 ¥F
R ELF JLFP2ER () Session BEHET S 1) R POST Jiik: 2) ifRP ST FEMAS: 3) M
iT XMLHttpRequest Jj iU 1%; 4) B [H[¥F5E () Content-Type. {#H] AutoResponder #5%, 0Ll
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33 W AHER

A URL fe 65 VG AL A i S0 A ol 1 W0 2 ik 50 A 25 b 17 o 1 0 A ok D o 7 0 e B e
R AL, 0T AR Action SCAC K *bpu; BEGIEEW BT AL, W EAIESCA T X *bpafter.

I RARAR 5 CHE T AW &1, TEAEAT R4 Rules > Customize Rules, 7E
FiddlerScript (1] OnBeforeRequest. OnPeekAtResponseHeaders 2§ OnBeforeResponse Jj ik ik
¥ X-BreakRequest 8§ X-BreakResponse #5{7 .

FERCIA M) FiddlerSeript CF, it QuickExec HENT LATR 758 5 M ik B oA~ Rl
AP T . HL TG SR -

bpu TextFromURL

BE AT LAk URL A3 48 5 S0 A 0 7 172 175 10 0 9 1 I

bpafter TextFromURL

AT ELJg URL 035 F8 i SCA ) i 7 2 65 T80 0 0 12 1

P vl LA R 2 18 HTTP ik, A AE oK o 1 il sk

bpm POST

Hn] LUk By AR O 5 HTTP AR A 60 0 w7 152 96 o 2 B .

bps 307

AT — MRS S E 8 G dr%S (bpu. bpafter. bpm 5 bps), HF2xiif i %W 0.

T B4 1F FiddlerSeript (3% 9 1 &) Fiddler) 233 k% QuickExec T 18 ¥ i) 67 11 .

i#3iT Inspectors &

UFRIETEN S ARG, TTELYE Inspectors P éRii i Rekmiy . (E 7L Inspectors Ji—3E
Fritiik i), % Inspectors 3 FF Read/Write DhfiE, $00] L4 i FF 202 T f7 e g2 7 o 0 o 12 1)
header 5§ body. Inspector 23 [ ah3#iEA8 TEFR 1T b Wi Frdi AT 1 o .

F T Hl Inspectors, $RiE ] LA — k.2 i 4 K 2 0 [ 45 Wy T B9 Session. 34 Web
Sessions #1| & &+ 4~ Session, H 4~ Session 7EWT L4t Wi, 5 —4 Session L4 STk,
i gk T Bl bR S 4 1Y) Clone Response 4 & & W Ry, & &40 O£ 52 KM Session
(2t W P % D1 255 oh T (1) Session. fifBhIXA~ThiiE, oTLLIRE 5 & ] — Gz o fliaki (aiis o)
W 465 i P Y e

Breakpoint Bar ¢l &)

44 Session {4 IFHITHF, 7F Request Inspectors 1 Response Inspectors 2 [A] 23 1R~ 41 65,
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3% HomEE

{1 Breakpoint Bar. & H1P-PMEHEUA-—~ FRHELL R, Wi 3-4 o,

Rrjuest Headers
GET Mdden2 updatecheck asp beBetasTam HTTP/1 1

Mo Responss Dala

B 3-4

HAT PR uT R (W s b 51 E RS . B4 Break on Response fé#fl 22 &b 7] sidi k.
2 il B AE L 20 XA Session B EL WA T L, BRUS EAL R AT, IR S AR AR (]
et if) Wk, SdisR A0 Run to Completion # )5, BFS%EMIiTHERITE R,
An o 7E FE B o R ) B

{F Breakpoint Bar 45 (U9 FHCHE,  n DLk FE 5 1 wa B2 ASERR s 3045 2 ki ma i,
P 3-5 Brork.

MFFHEshig h e S, S EEnEE I Inspectors CRELE 1) B, BAETE
R e A s N LR A (AT E R ). SRR R s A
{EH FRoHEPE P A P B R, R A S RS IR e, P Fiddler 23R [BIWRE,

B4 & % 4~ Session '

SR AW H AR, TR PR B AR, W 3-6 FraciRd IS
ek o e I R AT

00 _FuddlerGf dat
00 _SanpilesTL clat
00 _Transfos] dat
_NoCantent.dat
07 _Radrect. dat
03 _Redrecrdniel.
m_m.datm ; )
307_RedrecriithiMe
01 At dat &4 HTTP wwwe, el 7.com
401_AushDugest. dat m HITP wemwr, fdcller 7.com
ﬂ:_mrr.dlt 71 HTTP wowewr_Rcicler 7.com
404 . TF  HITP s Badcler 7.coem
g; :'m_d‘-'d‘l T4 HTTP wewewr. ficcller 2.com
{2 fle... TS HTTP e, fickcler 2.c0m
B 3-5 36

s Fiddler T HLE 1) Resume #8188 7F QuickExec S AHE P EEA g, FT 7 2405 1) Sessions
e LRI bR Ak EE AT .
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AR s
B _I_I_l_

AC ¥ Fiddler F1%% o

4.1 Fiddler &5

#iili Tools > Fiddler Options, 233l Fiddler i35 8 1, ILch {0 &858 Fiddler 174 77 2
(MR A . BN O rp AR £ W I E LY Fiddler A fEME 4%, /R s
W AR, o8 #E ¢ )4 B Fiddler () Capture Traffic ST S48, M®IFETNG, Al
1T 5 i OK $é 8 ol LR A 8, o5 il Cancel #8100 #4524 A F 709 Help BE#E0)
LA A 0 T £ 4 B £ L

411 EBiEm
5 TR0 1T LA Fiddler 14738 FHY Bl e ¥ B E A7

Check for updates on startup £ # Fiddler 75 53 a0 %5 Web fR %R B HH FRAEL
Fiddler. #A7ik-hiz-kming, s Fiddler #Bh3E 4P ) Check for Updates... i1, »fLLF
TR 54 B AR Fiddler.

Participate in the Fiddler Improvement Program i3 F 7 4R A A9 Fiddler thoTH C H i
1A Beta WA, EPIXAETR, Fiddler 24 M M EIEE £ L5 Web R85 . ¥i8

LS R A S P A6 R Fiddler PR SL, (HAREA NBRALE B o B0 Hr F k2l Fiddler
Fﬁj# %-0

Show a message when HTTP protocol violations are encountered i1 ik 52 Fiddler 71 i 18}
e B RIHRE i B AT e L L CORE . B LR R R P AR S SR e A e, FETERA S
1% 7 i R e, 0] LT HFIXMI&T6 . fE Web Session 51l 2 +h 2> il FH B €577 5t bR c B 5L
i, 1% Session MMPEPEE T —6r B0 T R AHT B AR A,

£5



¥ 4% W Fidder % P i

Enable IPv6 (if available)i 1045 4 Fiddler J&75 nf LA B0 A2 i HE TPve 26t BMERA
PEPIXA I, R DNS & Bl hk AR [Pv4 Hulik, Fiddler i 2 45558 40 Hu kit 294k 1Pve it
TR

Map requests to originating application 1% X0 ] Fiddler £ 75 5 B8 i i ke A i A iz
TR . KRR YE Web Session ¥|EP ] Process ¥ Bix, JH{R{F{E Session )
X-Process-Info br&E 1. 7] Windows JRH R £ 8 551 3 LR 55 2 80 A DG 1 4% A EFE I
SIhREA S M. SR C R M G O] R R, (B IRADRE, PR AR e
P Wi 30U AR Y SRR S P E R (T BB E R

Automatically stream audio & video 1551 ] -1 4+ MIME 26802 audio/* il video/* ff) W
P, e A sh AR BRI N, AT B Fiddler NIERTE. MWW THIRIETS, AR
1] Fiddler [f) Inspectors 3 FiddlerScript e o5 Sial Y 8ma 0 7. 1 ¥ XA A1 i de

THE 25 i 0 B0 A% 7 Fi) e m] AR IR, “ [0 780 AR R . BEYE Fiddler vh et o i1 W i,
nf Bl il Fiddler T HE2ep ) Stream .

Systemwide Hotkey Fl -t '8 tREEEE, 4 Fiddler i/hMbali# b e EiGahik &N, i

af LA 52 #4055 Fiddler.

41.2 HTTPS i&IR

HTTPS 70 -F 4 Fiddler 5 030 4 4= 44 56 ) SO 0 2 o .

Capture HTTPS CONNECTs #E5i ¢h i Fiddler /& & &Mt b vl LB HTTPS #R M & 4%
RFE, LA e, AR Y HTTPS AT AL

Decrypt HTTPS traffic #£70 g 5 Fiddler J& 75 847 Hl CONNECT il il 23X (1) HTTPS i oK
Fomapi, sidiSAEHEMHER “Learn more...” &, 2l BB, MRHE SIS HIAR SN
RG] TAER . MRS — kP WS, Fiddler &4 — A B AUES, #fk R
T A Windows BEITHC ' LLGE AR UE .

e ML, & B TR, LSRRI . 40 A A K
o All processes: XA Sl i MR .

o Browsers only: SU77 %iHEF % & Web HIMZNT, A-HHEHT.

e Non-Browsers: R itEE& L Web SUKLENT, A HAYHT.



4.1 Fiddler # 1
® Remote clients: HA7 SRR AN GEiyk QER i Slaa &), A fier.
Decryption Process Filter i 1~ o6 @4 A A5 B2 ) B 0= 1 547 B i —— e in R ml fig A4

FaFAl Dropbox IR SCAF BB G SR, 54T L R ik s b kot
T B L T

Ignore server certificate errors 5 BEHESS I 55 258t T BT %40k F50d, Fiddler 5275 1
i E Y IR PRI, Fiddler YR HTTPS R 45 280, 2 msal ) i Br ik BHNR .
I AR ZIE T, Fiddler R 548 HTTPS Mk, WSGERUE BEHE, SWH %, &R
B T AL R Y, 400 Fiddler SR BEE A WM LS. —BinE, A
P b A I, B AR RS ) R AR o] £ A SR T b, 2 P % e A A R R A
iE CEetndE 1% 4 T AR 95 28 1)

{t Skip decryption for the following hosts 26 JIUHE tp o] L 2 0 15 o (1) B 2625 (1) s 0 A~ i
FREBIT o i Th il o L A LU HT 0% 3 9L . 89, P30T B AS G0 % B8 Exchange RPC-over-HTTPS
Fim(t) HTTPs ik, il iEdS ol LUbf ot ph 8l onl . W EA#k, R4 SdiTaM, *
FE ALY 27, BRI example.com B30 H 3t FRIAT B H Ll fiddler2.com
WA R, ol AL g 8R4 8 O fiddler2.com;*example.com.

Export Root Certificate to Desktop 44 2= Fiddler ¥ Windows 1iF +5H¢ b (r) i iE 1545 U1 2
Wil FiddlerRoot.cer CPFrP . MLUE S 3CF AT LASE DLHN ) A s B B 3 Firefox B4
Opera 52 G {TuE FFES .

Remove Interception Certificates %1 7 {L Decrypt HTTPS traffic %2 Bt HE ¥ A7 gk h i A
A% siliizdedl, 2 M Windows iE-15FE 4 I FE Fiddler HUE5 LA S JECHEI IR 9% 25k 1 .
US4 PR 2 5, W R R PR AT HTTPS 884, Fiddler £ RHT 0 16E -5 358 Hh A 1% HE i ]
AT BT E 1.

413 ¥ RiEm
T PO T #56 FiddlerScript (PR, [0 T ol indL B4 i ¥ k.

Automatically reload script when changed 310 7] £  Fiddler A3 34k i, it Ba) &
Hr 4% FiddlerScript CustomRules.js {4

Editor i Y HE o] £ i 4 IO~ 2 A G4 2% K G i FiddlerSeript. ik “ . HeH £ h ol
PR dR A S 2
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4% BE Fiddler fo P &

References L IHHE N[ §i7 5 FiddlerScript BTHCBLUIN.NET FL/F . 76/ 41 FiddlerScript ff1—7
FRonr L T e 38 S 3 i Y

Extensions i% X0 HE & »< 1" % Inspectors 1 Transcoders LLAM AT & 4" & . 4Rl UL & il i% 04
HETh s B 1R R bug iRl 3 F A if.

Find more extensions $E4E2 4T H Fiddler 414F /0 H 3 .

414 EREER

PEFEE TR AL T R T #E W Fiddler £RBE AL BE T,

Fiddler listens on port ZETHE i ¥ Fiddler il Web Bt ififfom 05 . HEFEAEF B A O
S (8888), BRdEi%En O e H.

Copy Browser Proxy Configuration URL FIZhfg R4 NACEEFAC A  (Configuration
Script) fY URL, BIF %/ WAOICERE:, o] LU URL ¥l L. EuhieiR 0.

Capture FTP requests 5 A HESE ] Fiddler J& 5 Mol LB FTP R0 R4 A0RE . BOAHS
. EIREEA AT

Allow remote computers to connect 37l Fiddler /& 75 4b Ff ok B 1At i+ ST HLEE 3 %09 HTTP
ik, b iZiE, Windows 8 Metro S )% F A A8 £ Fiddler. #5000 HG, HEER
ki Fiddler A fig - R 76 8 b B b, By K HESPF AT il £ 30 th 3 S HE, il YREEE R & 1T Fiddler
FEot A AT R .

EATEOESHREY, 28R ELAR, wFEA L Ll RiEfT
& # Fiddler, #% ¥ vdill i1 4569 Fiddler % i# {69 8484, Mg ddg A atib
LB AT RAR R AR ehit FAL,

Reuse client connections P50 nf LL¥ ] Fiddler At % 5 A B /o 2 (6 88 (% P o {R4F
iR ). [FHE, Reuse connections to servers & HE o] LLES ] Fiddler 2% 2 H A1 5 55 %%
2R (RS S RFEESIRE) . HTYEREEE, RS iE R AR, 6 s M
I BT HR A

Chain Lo upstream gateway proxy & I¥ 2 1 8) Fiddler f£ 24 1-iFM XA RN, BRESE
IE A AIACREAC T .t SRAS P T HE , A > 10 UF Fiddler “ 208 RETENA RICRE R,



4.1 Fiddler # 1

O S B ALY Web .
£iili Show Gateway Info 0] S B 47 U801 Ll SCHC R a4 1.

Act as system proxy on startup iXZ#7 | Fiddler 7 i ah i R HF 240 0 iR R4 {00,
IE #IR £ A BRI S REEICEE, iR, SMBRAR.

Monitor all connections B % HER: i Fiddler & 7% 73 i 4 Ak B2 BT 47 WinINET S840 RE . fn
FRRiMEE VPN, RAS sl 5k s, Wiz EiEm, Mh WinINET 20 B #as X
R UEL.

Use PAC Script 5 HEF? ] Fiddler 73 11 42800 R Er UL — @M 5, i i, Fiddler
£ i R NS A I CER AL W A (a] LU 837 Copy Browser Proxy Configuration URL #4214
FiZMAO, AR IR E 127.0.0.1:8888. ZINERAMA], B Y2553k 1E8 LK
WA A 1 [P SRR CLEtn httpz/localhost B8 http://127.0.0.1) BAFIME: MACE 7200
B e, XE A S RES] Fiddler, {HES{EH PAC WA, £ RIiNIXSHHiH.

WinINET Connections 1 ¢ S i L35 (M RO AL W . 0 S 0000 ik 4 45 a8 VPN EHEH
HHER, % Fiddler H &% B KA Rsie s s, o] LU ZTh ik .

#1F 1E should bypass Fiddler #13, 4 Fiddler ¥ M 0 BREEICHERS, 3304~ 90 38 ] 44 ) gk 2%
WE~ i Kol it Fiddler A% . HE, EVFHEE RAT IE XK WinINET %7 A g 88415,
Wik (1 <-loopback>FF ic & Vs TE9 K 5 i R A< I 12 A2 3% [ 1R i3 K &% Fiddler: fn S 8EAT s it O
+ IES PR S {ERAR T NEE ), TRl EH# R, WinINET £ 8ahidaf. et - n] Ll
Mg F R, Wi ke, ORI IERCTE. A5 T, mAPRA H example.com R 55T
T P S it (RIS PN EEE R, B T Rt ) LU fiddler2.com [ B4 B it #i
if Fiddler, wJLLSA I FFFFi.

<-loopback>;https: //example.com;*.fiddler2.com

4.1.5 SPMIEIR
AR AR TR AL A Eeil] Fiddler Bon kT .

Font Size & 5HE R 1 % Fiddler P p3cAI b ERAREGRTERAD, dEERHG
&)1 Fiddler-

Set Readonly Color fi % 5 24 H U () U A HEZE #E7F R E6A . ool 2 T A0 Jst 4 A2
Windows BRIAMIEIA ARG, (HAE A EHNR AR KRN, AHSIER. ERRIXEE
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¥ 4% EE Fiddler fo & /i
IiAE4k, Al % S5 8 Fiddler.
Hide Fiddler when minimized Si%HE SCFF ik /ME Fiddler B, 7E REFEL P Lo Fiddler 14
b, A RLEAE SR B,
3% Always show tray icon ®EHERT, Fiddler B8P EE S — H B RTERSTLED.
Use SmartScroll in Session List £ H] T- 24 Web Session 71| #& 118 b #) Session B, LI
Fr il Fiddler (AT . A AA MR iZikT6, Fiddler 22 F15)iE 03 #1¥ Session &b (im ik o

View = AutoScroll Session List ).

i ¥ A7 % Use SmartScroll in Session List, Fiddler M £:71 Web Session 1|3 (L4578 4)
B F AN, Ao Bk Web Session. &P 2w of LU 6 E A RIS IR B R,
742 2 A T B T At b i 48 A B B ) Session F13K.

fn 3% 9 Reset Session ID counter on CTRLAX 1ET0, 29§ FH4EE CTRL+X 2 i3 g
in % Remove > All Sessions i % Web Session %I, Session ID S&EF M 1 . W%
Hik P %L, Session ID #EEATH 1, M AR, HPITEH N3 Fiddler.

4.2 HEADER Zaf%i% ¥

A0 3 P A i S AR, 7R i A R S A 0 S P R () R A 3, e (R 0
A A F R IR A MU AT L. HTTP SRS {EM] header Content-Type '[f)
charset J5& ' b UL KR Bz AT 44 7 00 A4

AR AL, HTTP A& SHE HTTP iR krh 8 St — Lk Fm4F ASCI 5. M.
HTTP M fi ) SUREGEF] ASCH §. F78% /2 i i %5 2R T i WX (R HE ASCIH S3EAT
Hah ), (B A7 LR P SRR % 38 2 SR MR ASCII B . fEREFI T, SR Wi
M. $afE Cin Fiddler SXFERACHED FIIRS 28 (I Apache 88 11S) 2 [A] =77 F WHI 2
V) 4 A — S0 ] L

BT S B A S SRR % 2%, Fiddler #—3 HTTP 3L ¥ UTF-8 4aft, K44k
o3 LRSI locale CILILAEZET M), 8 FI (2 ASE) 4w (B EUC-CND. 0] EL T TACHE Fiddler,
7F HKCU\Software\Microsoft\Fiddler2 * fil|# (1) HeaderEncoding i M FF 85, nlLLGiE Rk
WEAFARN G, R LN Encoding, XFEA AT LLHENET HERRR; &
http:/fiddler2.com/r/?EncodingNames ' n] L& 34 B 75 45
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4.3 PREFERENCES ( &%)

A} HeaderEncoding )T {o] 42 S #0385 B2 1537 15 2 Fiddler A fE & 4%

4.3 PREFERENCES ( fki#f )

{E Preferences ', Fiddler % FFR £ R/ ", "TLER T Fiddler PRI 24 ELL
B AL fh 41 . 10 % Preferences P LLifiit Fiddler F /™ Yhifi b i3 ol 0 AR HEDH AT U %, (H 5%
Preferences A~ ¥ fFikfpdeel 70, HfiEifiid Preferences F 4 kA uk ek,

{E Web Sessions 5134 T /51 QuickExec IESiHEF, LA ] PREFS fir % # Preferences il {1
AL S prefs log 21U Preferences #lic 3 ¥ Fiddler () Log X Fp . #1707 LU A prefs set
[prefname] [prefvalue] 46 E# 5L 5 5 Preference {i1. WIRH P2, LG SRERnR
H. %A prefs remove [prefname] £ ER Preference. X Fiddler #r#ii% Preference (MHERT, 23
/% Preference U AT(E, U Preference 2RI, $8 A prefs show [partialname] s i 7
BEPRE T B AT 8 1Y Preferences ¥ (Preference [f1# MR AL K/ NVE AN HURA) .

£ QuickExec FEIIHEF 4 A\ about:config, o] LLPEH BT AL E ) Preferences: % {E 2 61
H B Fiddler Ul S0 1) about:config i+, H 76 ob 4 M B Wi e 3 1 B 45
Preferences, W4 4-1 fyan.

H 4-1

ik 5L~ Preference FIT{EMUAT I8 F Delete 8, i n] LIMES % Preference. {EHLIGHE ¥4
T CTRLAC o LB fhZ ook (e, sk 3971 F CTRL+C, 2 [Fs 50 4% Ff A 1
{i. AILAS 7 Value ¥ 48 20K: 1~ Preference (I{HIFRIA B . ol Lladils 1T (XA
A*S5k5iH), 4 Preference M INE AT, H8A B2 FRAY,

i)



®a#F FHHE Fiddler fn & i

bk D P& T Fiddler S FFIIFTH Preferences Bl & Fiddler § K.

4.4 RCER

TR ACELIR %5 88 Fiddler HAEF B A8 S MEURGL. MR T, KEHNHBFN
P g i E s RESS Fiddler, B4 R FYEIZ T, Fiddler £x3E At ML AR Windows FREE{LHE.
FERSEASOL F, R Fiddler BATIEMSER A RSO, v LAR %/ Wi A5 Fiddler #4T
MO R D A . FEMACERAR S A%, Fiddler & n] LARMUE R T STHUR S S50 R0 1 55 2%
(P B BRI (i sCEF WiFi 0 PRI TR,

AW 4180 Fiddler He3 2 B 38 0 1 8- Fp A oK.

4.41 TN IS8 ROBEER

{f Windows |-izqT(f) IE. Chrome #l Safari #i %% < P a3 8HE f AR S B |
B, KRR Fiddler a] B ah4 R e 28 ) B i .

#t Firefox il Opera jl W28 27 IR N0, SEOTLLLLE (140 808 3 2 1% 5 Fiddler.

Firefox

TR A Fiddler o] LL%%¢ Firefox () —4fiff——FiddlerHook, {77 Fiddler thn] L4 4
3% Firefox M%45. % fH Firefox’s Tools>Add-ons > Extensions ¥ 223830 fifE. 295 d
Schk)5 . FiddlerHook 277 Firefox il %5 #8 1) Tools 328 h 18— Monitor with Fiddler fix 4.

3 UG % L H5P Fiddler ¥ W 5 Firefox BRAMO{CHEE, LA & $E K13 Fiddler.

i ik P Fiddler F L Monitor F (] Show StatusBar item #iy-%, WP 4-2 it i HiE
1T Firefox HI% 8 View=Toolbar>Add-on Bar X, Firefox MEEMESG FASBrn
FiddlerHook [¥] 2474k & .

oA RAEL R, Sl R, AP AT S FiddlerHook MY R . ShAh, idE
T — 85 ER Firefox 2847 1 Cookie MIFE I, W 4-3 Fras.

kst o gistomaticathy | ®  Ube Fidilinr puvmaically
Eorce iraffs #n Fuddier e trallec te Ericline
& Dopot use Pakde | Do ot use Fidies
;'\" Show SRatusBar dem b (Firelen Carhe
| Lnch Fiddier now | o Frshe Eafion
¥ 4-2 B 43
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4 k1M FiddlerHook Bf, % AT LLYE Firefox (9 T HA M h 8 n— 48, of Ll HE L5
&) Fiddler. Al Firefox T HE:, & Customize, WE 4-4 s, 0 Fiddler 348046 8] {54 2
B TR AT .

i P AT K G AL A FiddlerHook #8£F, o7 LLEE 3 A ¥ Firefox 30 %0 2% LL{E A Fiddler.

{F Firefox 4 LS HritiAch, fidi Tools > Options 24T ik 0. il E A
Advanced bz, #8578 Network 350 . ¢ Network ¥E50 1, it Connections HEt
ff) Settings %4, & 4 P Y Use system proxy settings 250, WM 4-5 Fris. SemiiXedpif
J&» Firefox £x{# FH#l Fiddler Bk, REEARILEL,

@ Use manual promy configuration
Protocol Prowy senver Fort
Hﬂﬂ_

&} HTTP 127,081
7 Use this prosy for all protocols
W HTTPS 127000 |wasn

i Fre : ___H

msoas | B

7] |Use prowy for locsl servers

A 4-5

M e BT Opera $81, 5107 Settings, #8J5 7 Preferences. 5% Advanced,
BRI o5 et A s 2 b 19 Network @74 #4il7 Proxy Servers #H1, 3 HTTP R HTTPS {CF i 5%
PBEBLEE R 127.0.0.1, 3 Port My i pE 8888.

H b i) Y 2R

A FiZATTE Windows LRICAR il W%, K2 L Aa R MBI RICH B . 2 T8
HRH U RS CEREN, —MUS, 5 Opera MH P BAEI— A B F2 0
B UL S+, 3° HTTP # HTTPS (0P ¥ 6L Fiddler 92535, B 127.0.0.1:8888.

HeAh, fREATCIRBIR 2o, RS EA. EMIEdRRiN, Fiddler 20
Eh R A B A JE R T . (T Tools > Fiddler Options = Connections 7 (1) 8 £
Copy Browser Proxy Configuration URL, 1 {CE (IR # A URL # DI BB WS b, T LT (i
e ) 0 £
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# 4% WY Fiddler fo% F 3%

442 MNEAMNHSDHEREER

Windows 5% F1# HTTP / HTTPS / FTP [£% Eh ik & WinINET, 1E DL K E¥ILih%
7 i A A bSOk . X R T NG W LURT Fidder &R, A% Fiddler K105, B
i3 F £ A sh B WinINET {CHL.

{HJ2, Windows ik A JLAP AR AT WININET ) 9% bl kg . — 22 5% FI#L, 0 Firefox,
HAWFIMSAME. ERSRS T, XSRS BEERE AW Winlnet {RRE, iy
fESm A — st R, DA TFEhAE .

WinHTTP

WinHTTP 5 WININET 266l X BI7E TR %20 Windows B 55 3EF LR — S I il 2 4
J & T B0 3 B0 8 B E 1Y Windows 41 £F 6068 BITSOS & 8 k145 %5 ) . Windows
Update. CryptoAPI if $5361FR%%F. WH 7R T WinHTTP M HFIF R ELZ AT, Fiddler CL£8
¥EN T, WinHTTP 7] fig2 (1 3hi%EHE D] Fiddler, 4 57 F 2T WinHTTP (948 H F3L.
S R £ ] WinHTTP, WTEA{#A] WinHitpOpen 5 WinHttpSetOption i
API Hpifi R TS A4y Fiddler. R BSOS IR0, RGOS T LSRN
WinHTTP {3 th e P18 U &5 3 .

7E Windows XP fl Windows 2003 S5 HLIG A, fir % W F:
Proxycfg -p http= 127.0.0.1:8888;https = 127.0.0.1:8888
# Windows Vista FIE E/RAS, o AFAR, WF:

Hetsh winhttp set proxy 127.0.0.1:8388

R ER IR T WinHop PIERIABUE, R fiddler 2 )5, NizTa) E RN
B, AN, FET WinHTTP iR F R P o) e ik e 4 B &%

NET #E22

Microsoft ) NET HES{E /] System.Net #3503 HTTP/HTTPS H1 FTP B il {EXCEEA 5L T,
1% FEhi, SEF NET B9 F2 B3 % WinINET (G388, Ptk ee i B i 8h-2 /% 53 3h Fiddler
af LA Fiddler e 546 52 2 5 I ) B0 .-

B0, Al CliEmm T AR AR, R A AR U R $E 1) Fiddler:

GlobalProxySelection.Select = new WebProxy("127.0.0.1", 8888);
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BEAR, Rt ATLAZE % A WebRequest 3-8t Tl U,

objRequast = (HttpWebRequest)WebReguest.Create (url);
objRequest.Proxy= new WebProxy("127.0.0.1", BB8EB);

U PR LU Il R R EACES, eTELEE RN A B b (0 EE . Sallt (el flER)
392 () yourappname.exe.config S fF, #5 00 ek 8 5 LLF 4 4

<configuration>
<system.net>
<defaultProxy>
<PIOXY
usasystemdefaul t="true"
bypaszonlocal="false"
proxyaddress="http://127.0.0.1:8888"
>
</defaultProxy>
</
syatem.net>
</econfiguration>

BT e R A LA, T LU et 2 fF machine.config P F) configuration {43 8 #
PLEACH . W 0 machine.config BE A7 iR SERAKS FRAMNAEFFANET £
Wbk, fIEEITE IS LAY ASPNET Frd il f9 MR % Mk 5 FiEiTi M .

A tp ] ¥ EACRE, NET 5207 LLEsit Fiddler, FiEEabFE4E A APLA URL (B “[E8% ™).
R PR MR T SRS AL, RS S R4

Java
M Java IE{TETERRE ORE) 2x AalRH] WinINET 408 . 500, fofe] ok BRI 4 CBE IR
% BN P T PR AL I 2 JRE BCA . 1 —MRRARRY JRE P55 T Windows Control Panel ()7
J¥ Capplet), W LLEEHRACEE. {£M FEX@-~dr< ol LUE JRE 18 H .

jre =-DproxySet=true -DproxyHost=127.0.0.1 -DproxyPort=8888 MyApp
jre -DproxySet=true -Dhttp.proxyHost=127.0.0.1 -Chttp.proxyPort=8888

SRk AR 7 AR E W AR, ATLA#ES JRE MR M S0 .

PHP / CURL
{E PHP il i CURL A% M &% ke, BEARR i k¥ R85 Fiddler {08, AI{EAE Web
R AT F i AT, HoebSch B3 curl init)ATIE[E]H) handle:

:url_setcpt{$ch, CURLOPT PROXY, '127.0.0.1:B8B8');
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# 4% BYE Fiddler fuZ f 3%

4.4.3 B3R SFBIREER A

Fiddler M2 A 460 F P i REAEL . RS2 LA H f W /24719, 138 ASPNET
1 11S Worker Processes, Iy iX46[R % EBAR L F A £ 19 Fiddler 5% ¥k

% Fiddler fic ¥ 4 A~ F) R W S ARER M A —, AR S AR A s . 254001
THifE ASPNET M Gify) Web MR% MM, oI LL%%# ASPNET %% L ff web.config =
machineconfig, BLEESL(CHY, Ml NET HESSASE — Wep Frfiid bR, Fahiin Web {UEL.

of T4 LA 45 BB () Windows HESS (1 Java 8E WinHTTP), 58 fr4EiX st web %
A O TACEEACRE.

444 iR ‘B #8iER

4 0% % LR Fiddler IETTEER — G HLIS LR, — B RN BRAO AL A e 4
$R) 2 1 i P A B AR 46 S A i . SRS P 5 1 8% (loopback) BB, PR ik sy
0 VAT S F R ACHL . (v B A R A 04 % B (BB M Bk 127.0.0.1, [1)RIBE %
localhost BB, 77 A A0 45 A0 B BT EH ST LAY TCP/P Mkt %o .

ST EIERART, A5 = a5 S B

1) 5 2 P N PR 0 HE 050 o 0 8 0 7 o R R O 58 Ak R ) 8 308

2) 7 Windows Vista L& S Ji0fAh, 4% il % 586 TR — &L L, HTTP
GSREAT R B

3) 7F Windows 8 7, Metro JUKS it N FF 5 482 30025 4720 1 L0 P40 LA b [ i 1 o 28
( 0 Fiddler).

LT SR AT 145 4 Sk e

553 [a] 8%

B2 5w B shieid Pl SRR AR, U Oh i 1 ACBR IR 95 35 (0 Mk F 75 P 3 R
bk AS ), AR 55 88 CTE AR B ) € 127.0.0.1" @IEURAL. MR, XEEE S RN
FHE A % PO G WA Fiddler) BT R — LA L3R, TRy
o, ACERIR S AR A S i ) ML hE R A R 0 .

1E 1E 9 A Z B, il WinINET M&44% (i 1IE. Office 5548 %) X i) ir & S i
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W R RGER] 127.0.0.0, [:1]2EHLA localhost, £ HahSeidACPRARS 3% . 970 1) Opera A
2, Firefox ] No Proxy For SRIAS I T 112 i ¥ 4 localhost 1 127.0.0.1. Sk NET
HEAE A S — P B B DU RR 0 [l 8 ok th S e AL B

oy A LR RRh P i e BE AT AL IR S 2 b, e ek T
HEAEIR R R IE S RS

{C Fiddler "1, EHHLIXFREAEM, AR SESCE RPN Ehs, bR wmEER
S 1 A 75 R A 1o ] B M ok R i . b 5 A 9 R 10 O SO A R < v S BLE DNS EBLE
C te i1 httpz//mymachinename ), {H A RXTE 2 T S0 ol SCHLA BB, X FRIEBGESEE G
W% L T AE A ) S AR S Ay

T SRAMEAEREG, Fiddler SCERFUCE AU LA, AT kRl bk 8 4 -

AEF R R i T i gy 2
127.0.0.1 ipvd.fiddler
[1] ipv6. fiddler
localhost localhost.fiddler

BB L RN, BB A 158, Fiddler, Fiddler 7£iff3K URL F Host ¥+
LA ERN EHLA.

fE IE9 #, WinINET H4in T B hfie, %/ %Al WinNET, i id fURE i [ml i &
Wii. MTEREMREXFITH, WEX Proxy Bypass List ¥R, {# H A58 %NEC
<-loopback>; Fiddler BUik £z B b BX - hnic, Moo Al LLIE 28 5 fr A B A4 ib ot STALE
. M Windows 8 JF45, WinHTTP 1 B8 Y15 <-loopback>F7 11F . Wi%! Opera AINET
HE BEAE LIS B R A o A 8 S 400 o] i i i AL TR 55 { T BE.

[E] 5% 5 45 % i

Windows Vista A 8 @ A ) SR 40 2 (40 F P 952 0] % 5 4 3e Uil (loopback authentication)
Yedi. fERXFEED, &0 meOh RS BT B AL, SR B R R AT B
BB E . XPh Ml A R TG S ) B E A LE AT MR SE 2. ™ Windows il 33X Hp
B A LT S BT A R R RO, S SR R S B .

T BUE RIS, AT 4% hitp://support. microsoft.com/kb/926642 H1 kAT B,
BN F: DisableLoopbackCheck=1.
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# 4% FHE Fiddler fu &k P iy

# Metro B #& 89 Windows 8 Fi Fi BE 2 A4 5] #%

Windows 8 HEHH T R BTN I RE S HE AR, 2 49 AppContainer. () “Metro FUESFEH] "
AR EEAR, 105 Metro RUREEEA Y TE, LLE M Windows f RGP T . 4 Bh i3k
(¥) AppContainer St F R OGRS ER) @47, 2l kEEPH 1L Metro FUES
¥ 15 i AT PE A HLIO R %5 28 AR M A RE . ARG 4 bl SRS H P o — ik
http://localhost. http://127.0.0.1 fI http://machinename #<> W, #8855 FH /™ o] LL7E 8 28 7F 4
I 4 11 T CheckNetlsolation.exe & f -1 P B~ BRI . 03RS Visual Studio K
PO FEVIRE b S o e 0 ] R - %

ELOAREOLF . R {RTE Windows 8 LizZ4T Fiddler, JFRIsN T Metro FURE 30 Y085 A1 H
Ve RN IR R B T R0l 68 LK RS SRl F Fiddler i2{77EAHL L,
B K S LR R S SRR S e . RO EACE MBI %5 982 Fiddler, RIFI& Ak MR
AT, IR

A TR, B T EJEL TR, 04 EnableLoopback, &S FFA %
4 AppContainers 0¥ [l ¥ B . Fiddler fi#& 4 MM P S RIMM IR FOE LR T
EnableLoopback.exe T I, it Fiddler T H=/- filf] Win8 Config % S
el sz~ T.H, Wk 4-6 Bror. & wink Conbig. ) 43 Re

Fiddler R4 2 () ;7 a] LU hitp:/fiddler2.com/r/?Win8EL T 4% s

EnableLoopback.exe X4~ T .. % Loopback Exemptions [0]##%uBs) %14 5 B47 778 i AL
B, MEFFEEhR, SR IEHE, FaREh U\ o LLLLE B 0 BHETT .

*113)) EnableLoopback.exe TR, B &{EFZ D ¥ HAHFT ) AppContainers. 1] 114}
KB4~ AppContainer, 7T LM% T B I J7 (1466 B 47 () AppContainers fil %o i ¥ .
fEREG, fidi Save Changes #28l, 0T LTI 4% 2000 H ) Windows B 11, T 4-7 Frag.

'S Apetontainer Loapback Exemptiarn Lty =l

o ey 30 rokstly prrsors, Vrekrers ) apobetions Canved ol sered nafiwo e 15 e bl ol T Wy st pou 2 relas

AL Mara  ACS0 Bnass I
5] b Fia e e o e ool $11E DWW S T et |
B Moo Vil Cos Murnme Miomaok Vel Cos Muntess soppot ssossolt 115 o
) Cabruairat =Y e ES COMIRDOWE apen 1 wwahos s
] Samsoha VA | N 5115 NS e W et sme |
o Do o wngtorw_ . 515 () |
| 7 Pt ey Fusmnis [edop {armechan wddrey. M3 (oral

.mmmu-mucthcm_;umm _:;l

8 4.7
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{E5 k% app I AppContainer 9 [1Eg R G, #U0T LU A Fiddler X2l APP (1 $icds i
T, 5 R R

445 £f Max OSX izfT Fiddler

£ Windows [iH]. Fiddler 4 &4 Likizfr{k Maec OSX L. #ifi, VMWare Fusion o
Parallels Desktop BXFE ) R #0467 5 A #4 Fiddler X FEfT Windows [ HI 407 EATE Mac (¥ 82 $0LH1
Lizir, Wi 4-8 i,

Ml Al Laidares - QAT MF AT il'nl{dw'l'-ﬁ LI ] 'rr-ﬂ-'lr.'l- 1
R - [T Y ——— - R T o
fof LT B Sy Al T oiliati Wy M (L% S
T T s W i ek e, -,h--hl-wl-rhqlmm-msg s Prbgme® iy
Tapr i agesi Hring

Mozilla) 5.0 (Macintosh; Intel Mac 05 X 10_7_3) AppleWabKit/ 534, 55.3 (KHTML, like Gecho)
Wersion/5.1.5 Salari/534.55.3

B AT ey R e, | kil

[ Fie Bt Rul Took view Help WDanaie

,':: L) by gty W= b Ramerre # Suse B Cuinde m.:um g Prciris FLRoed il S BB B Brer
e - [ 1 & = '™

AL Parallels FizAT Fiddler, S ZafAcC Mg 0. %8 Parallels, TOHALE, 4
Windows HE{ELHLY) Hardware > Network 1Type % {417 Bridged Network Hii, 101/ 4-9 iz,

enn : WInTHPAZ - Mardware

* oot Order
Conmected
W video o
=y Print =
o Shared Netwark i
e Flopey Disk " !!
W oojove | MAL addres
3 Hard Oisk | N—
[ ™ Newerk1 ] | s
& sounid | = Erhernet
= USE Comtrofer [ —
I = wnic ] |
| Most-Only Metwark |




§ 4% BLE Fiddler fo % P 3%

e By AR 2 JS . Mac sE0T LR B RIHL S MR BRI T . IR, 3
{EREAUUHL (1) Windows #4F R 4 | 4% Fiddler. {E AL Fiddler I, £iili Tools > Fiddler Options
> Connections #£15, i%H Allow remote computers to connect. % B 5ei)5, % 553 Fiddler A
REAE R AT RE G 5 S AL B kB, {E'E foiF ) Fiddler R

RAERNSK. TS0 DR, Fiddier LN Mac 1 (s @ X
PERIHIRIT . B4, FE TN Mac, 1 Web MOk s
R L EAT(EEAULHL L 4 Fiddler. L etn vl

Dormain:
E5E, W T AP ESIELE 1P Hhhb. HERURREESYE Fiddler  |fe80:8dbf-2babuct51:5b7 %11
feBl:57:107 357 #0fa%13
T RFEALME Online #7125 1. THESES BRORRESE 1192168155
fLHLAY 1P Muht, WP 4-10 Pras. B 4-10
#ia. siide Apple Menu Fl System Preferences. n1ili Network PR, 5 piili Advanced 4%
. riidi Proxies 1. P Web Proxy (HTTP) i1 H! Secure Web Proxy (HTTPS) 7,

AR Ipvd kb, 1B fCEZTT 70 8888 30, i 4-11 Fraxs.

———eeed TCP/IP | ON5 | WINS | 802.1% [EERRSEN Hardware

Select a protocol to configure: Web Proxy Server
U1 Auto Proxy Discovery 1192.168.15.5 |+ 888
| Automatic Proxy Configuration ( . ;
# Secure Web Proxy (HTTPS) UsermaTe:
i) FTP Proxy
[ SOCKS Proxy Pas swoird:
L Streaming Froxy (RTSF
I 1 Gopher Proxy
[ Exclude simple hostnames
Bypass proxy settings for these Hosts & Domains:
R TR B U g T (T s S
™ Use Passive FTP Mode (PASVY
¥ 4-n

AU 5E Mac {UHE S, Fiddler =44t Safari FISLALR S . A Fiddler
B, Fii%iR[A]%)] OSX System Preferences iE7i, HUM{CH i H .
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446 MEMITHEUIEIRERER

BN ] SCRFAUPEAR %5 2%, aR o] LS it Fiddler HEHLiz 17 46 HAh b 8041 1 Ata 4~ 1 F 0 iy
AR, b b, XRRARRS S TR, T RIS, ok AR
Fiddler, #& 50 HAb 5L,

HACH Fiddler, xidiitIi Tools > Fiddler Options > Connections. £ Allow remote
computers to connect. ECSERG . T &) Fiddler, At R0 220, 75 5 15 AC ¥ B kbl
fei'F 5 Fiddler HEREEE 37 W £ HEHE JF AR B

TR S O LR ESE B Th U5 ] Fiddler, APl HGES#E: [HTIFRIME. Uiml
http://Fiddler Machinel P:8888 I A2 HIBL ] Ml ] . I SORFE BUEE A FEN “Fiddler Echo
Service” (] Web 01, iM% )" ¥igHl Fiddler 2 8] n] LAl .

EMst W 2, FBRED G AL EACE{CEE, R« M ARy il e S
P W R )RR . b RO e, AN EFER] 127.0.0.1:8888 {4 {CREM)
Huht, NEiZAEHR] IPOfTheFiddlerPC:8888. #5161, 1+ 5 HLIY) Internet Explorer > Tools
> Internet Options > Connections > LAN Settings ('] &% &k < 0] GE Q0B 4-12 Fra.

Automatic configuration
Automatic configuration may overnide manus settings. To ensure the
ume of manual setings, deable sutomatc configuration.

[] utomatically detect setiings
[T Juse sutomatc configuration saript

Proxy server

Euunwwhrmmm:mvlmmﬂ?h

Addess: |FdderPCslP | Pork (3883 || Advanged
[ Bypacs proxy server for local addresses

H 4-12
i . T s
o LARALMB—SIELZEGHE, Fiddler th4Rig 42 2 FutiTitiE (w “R
T Web R BMEA") HFIXMNAETEFT T4, BHEEHERDEEIIE Aot
2 £ 45,

a1



4% BE Fiddler 3

o o RARITEMATH Fiddler EATE R B FAL L& IR, ToadAF “HTTPS AL~
F—%, Kb B TREVR,

s L4k X H Fiddler, 1L, TEHFHRH—EH AN LHKERET. T, €64
dyif K ARe ke, B % Fiddler L2 R BiESTT.

447 MNEEHIREBURR

% 55 Wi-Fi 5 Ethernet (751 38 - #0 vT DLURC T A0 308 i A% 45 Fiddler fUBE, X4
i #5045 108 1% % il iPhone.iPad #1 iPod Touch ). i % Android ¥ % L1 & #7147 Windows Phone
H1 Windows RT .

TEATHIMAFE Y P2 T WTACTE Fiddler, W& SCRFORTHITHLAOEARTRL. 5, Rirres
ikt % F0 Fiddler .2 (] M &8 ——ilid ¥ & L A30 S 2815 ] hitp://FiddlerMachinelP: 8888,
P % 2 () B 2 75 7F Fiddler () Web Session 33270 . 4 n] fE 5 220 1 i 4619 3G g,
M B £ % Bl o LR AR N WiFT RS isid ke, WRTEMRM R L3 B B MR, iR B
FEREENR, BT ERE WiFi. WA T P .

13 WiFi Isolation

2) IPSEC

1R % 3CHE B th 38 3CFF Wi-Fi Isolation DhiiE. KiahZThikSGE, WEH Wi-Fi & LikdHEn

HE 05 B i 2500 Ethernet i M98 46 . 72U ER i B SCRFBILAEREA WicFi 26/ 0 i 4 31 )
A~ Wi-Fi 0, RO E th A L Rrifhoh B, WA ERERIXLeThAE, LLOE & o] LUE
5| Fiddler .

MR HE, Sl ME SR IPSEC. IPSEC 2&H 1E M —A4F IPSEC %/ Hi#1 5
—A~ IPSEC % F' i 2 IR . #ak % 8t & A SCRF IPSEC, Bt i RART B MR d &
BRI, LAHEIEAT Fiddler fUHLISAE AL “IPSEC Boundary Exception”, Ml 54 A
Wi ANE IPSEC. {EMRE RS, iXRpyrak B 5 A7 RS 5 1 5 e ad 5o k.

o AN EEFE B Fiddler J5, TSR ERCE A HTTP M HTTPS Sl fuad {3 .

Apple iOS {{1ig &

H{E iPhone. iPad 8% iPod Fihm {0, fdh LA “HE” Bir. ERER &P, Ed
General, #RJ5 MF| 2Pk Network. siili WiFi 378 F Wi-Fi &8 4G Wl AT 3k, 33
HTACE . Aidi HTTP Proxy (¥ Manual 3£ . 7F Server HE'P, A Fiddler ] IP Huhlsk |
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44 BREZPF W

HL#i. 7F Port S AKED, $2t Fiddler iy AW (F15 115 . M3 Authentication {R¥F7E Off 4R 4,
mpE 4-13 Bras.

Server 192.168.123.12 |
Port 8888 |

4 4-13

Windows Phone {122 8

% Windows Phone |8YBMUH, RPATH “Seting” Wi, fiifi Wi-Fi #00, i F WiFi
Mk 4 0k pidli “Edit”. 0 “Proxy” AT H, 1€ Server/ORL HE 146 A Fiddler () IP Muhls§ ¥
HL4A7E Port HE'p . 4241 Fiddler BTHIWT #1511 . “Proxy authentication” £¥§ Off $hik.

Windows RT {1218 &

IZATPE ARM $fE R4 A B AR Windows 8 R, i iidr4 & Windows RT, & H
fiEizdT Metro MARINIH] . 31X 1L S 2 Fiddler k(X it & AT, Rim, Horel
Al Windows RT #, ¥R E R M 40 Windows 8 S UHLEEE i 4 L. 7E Windows 8
I sh b s, WA Proxy. siili Settings #E%, £ 45 Configure Proxy Server 1. i ilii%ik
T, 2x{ESLIA L34 Internet Properties 2 iGHE. fiidi LAN Settings #4, WA %W
P 4-14 o5, {E Address EEIHE 14 A Fiddler PC ffY) IPv4 kil

Sustomate configurabon

L B 1 l' tion may o & d sethi T e the
use of manual settings, daabie automatic configuration.

[ | automancaly detect settnga

[ ] e sutomatic configuration gorpt

Frowy serer
Em.“wh your LAN [These settngs wil not apply fo
- ar CornECions).

addrgms: |FaderrCsp | porg 8808 || agvanged |
[ pypass proxy server for local addresses

4 4-14
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# 4% MW Fiddler % P 3%

Hithig &

4 K R Wi-Fi (BB % HEAESE A A Settings /s R AC BACRE. #Rifn, LT H b 8L
(085 4 HRA) Amazon () Kindle Fire, A KRB ACH. BE(EIX 242 46 1o Fiddler,
S B AT HRRAR", AT 95U o S BB, 0 DL ) ORI M) Fiddler, 15
AR A Sy 3

BB

o e REAWMEIAAGIRA, HAAARLETMN TG I6 Ak, BRHAAOHR
P RATEA Wi-Fi M,

o K EHINEEEAREE AL M Fiddler #F HTTPS #0847 E. £ “HTTPS
ME — P BEidmy.

4.48 {EM Fiddler {E4 R LR

FERCHLg L T, 45 ] B A 58 08 ] Fiddler 5 42 8036 5, (1 3OERERC ¥ & ) S ik JLAE H Fiddler
R %25 . oA T2 — WK, Fiddler nf LLIER “ Bum 4CEE™. ¢85 mfCERRC ¥ P, Fiddler
IEATTEM S 28 b, Sl i R 2 3 A [ i 3 0 L & A [Ty o ML L

A T, IR 35247704 0 WEBSERVER (191 %5 25019 80 %511 {£H] Kindle Fire
M, F Kindle Fire | {R7GIERCH Web {CRE. 58 AR M55 |2 i B i, LA
T 55 A% (rywa e, Wf Lt R

1) 7E WEBSERVER L k1) Fiddler, iZf77E3kiAMY 8888 &ill.

2) i35 Tools > Fiddler Options, fififs & £ HE Allow remote computers to connect 1%
ch, TEMS, HEH RS,

3) %+ Rules > Customize Rules.

4) 7 OnBeforeRequest AEFRFEFF, Hhn—47 87 A0S

if (oSession.Hostnamels (("webserver") oSession.host = "webserver:80%;

5) {E Kindle, 77T hitp://webserver:8888.

LLEACESERR)G . {F Fiddler th4: Wl B R MUK, B0z M BR8R S [1H4 4245 Web [t
FrASFTEATH 80 3. WARVE I Fiddler KX P&, e AL 80 35 O Ui Ede 4.

PR n] LA Fiddler Ao W H0EE ] fCRR, TR AN S ORI A 0 S O T SR
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44 BEEFH

bR, % ETEHAE Web HR% 2R Fiddler. 1%, EHACH Web REE, Mg —
L. i, WA Web MRS AT 80 0, DS BAL B REATIE 81 M.
#J5 . {H Tools > Fiddler Options > Connections "7 iET0,  Fiddler it 5 HE7E 80 & 1 By,

{E0 HTTPS IR E{LER

1 2k B ) AR FEIE AT 0 — A o) R 8 7 i K 450 S ok S A a0 A A B R 45 28 et ok
(¥l LXECREAT I P % W ) Fiddler A23% HTTPS iR, EA &% r CONNECT ##, mi
FLH TIPS HTTPS #2FHhill. Fiddler HIMIH% M EERIE HTTP iR, Ema il —iHm
HTTPS & TRt o Sdie i, 8o e sk

i [ K] LA 2 Fiddler G0l &0 A 1 RO £ i T 28 e Bl HTTPS dEHem) ek, 76
Session ¥ 4¢ T /1 [¥) WuickExec X GFHED, #A

!1isten 444 WebServer

i 270 444 S CHEVE 37 ) 1 2 R W 8, e 380 I AT sl B ) R A2 M HTTPS 48T
. Fiddler ZxfE 0 M &, X T RWrdr < 08 S8 E T EHLR, BEEBGE
5. fELL LIOP o, A B TURLAE T ALIESS hitps://WebServer [1H§2K .

{EERNE T & HEE )G . A FEFE OnBeforeRequest 2 R ICH] i) 22 45 i R e 2 25 BLIE )
e 55 2% o

449 $HEF iR A TEAR SRS
BRIAE IS T, Fiddler 220700 FRECICER W W, (0 B o o0 4 0 B &t R 1Y
Y LiefCRE, P 4-15 Bk,

Intamet

Explorer [ WinIMET

:
it
i

B 4-15
Fiddler ¥ FEAT AR HEE, OFET Ciper. SHEMA=SRAs0NE (WPAD)
LHL, AR R R .

REBAMAME ST (LI IE ) Tools > Internet Options > Connections > LAN
Settings} ERIAOL T 240 BRI BDAEPRASE B UGB F 0 5 XA B, sl
P VPN XA AR R R A A, e LR SR B A M R R AR,

a5



4% B Fiddler s pP i

MR YRR L Fiddler [ &) H: & 3 R AR, ATTER Y Tools > Fiddler Options >
Connections " H{i 1% 1 Chain to upstream gateway proxy #£7i .

i B8, Rk T BLE H FiddlerSeript TE4% FT {7 Session (3810 9 0108, 30X — 2,
i 1 AR AT X-OverrideGateway . W1 HU b 47 (148 5t ¥k DIRECT, # 4 Fiddler %%t
MG, AWk ES HRSEAS. BRI EEE N addressspore 11X,
myproxyserver:80, Fiddler 2% 1% Session {# ] i & 4 CEL.

4410 ##%| SOCKS/TOR

LA 8 F . Fiddler % 3 b5 47 % X-OverrideGateway 448 0] LU Fl CERN {20 £
UL, JLFERAMAREAMA S . B, EFE R AR ARTOMRMEERE, BHh
SOCKS. L SOCKS Hriflth, %/ s mCH A% i H 3k, E5 M T TCPIP BN % E
F i HERHEE . 2 SOCKS B s i =k (e 5l i O 48 b pll e, & 7 2 A ok il 3 A 18
Web i85 i .

Al L e fHCOVPND A I8 T SOCKS Birill, SOCKS h 0] BLF 3 % B TOR Project.
TOR Project 2@ ERACH SR, 5760 JR00RE & M4 ) thiiE. TOR M R {E 452 i)
He 3%, MOVEE BEL o o e 15 U 8 5 1 SR B R SOCKSS Bl MUAR 4a 63 £54C B i 45 88 404T DNS
frif], Miom r P ERR. 2lid SOCKS vda 4% TOR I, DNS ##Hr&dEz=ii A2 A8
HL AT .

B T HARAT S BaRL, TOR MM 5 — 47 B2 b e 1] LISk B A [ i b 7 B 44
W. ZSAPF, 7C TOR M, Riji T4 & 00, )~ &R 2E, EXRHRTE TOR
R £8 1 L) 100 8 R B g 30 4

N E X-OverrideGateway brali (i, TaZAEAI A4 socks=2¢7 Fiddler 7614 ) Ll 5%
AR %A H SOCKS vda Hhll. #fm, TOR ZRFFMiL SOCKS fRE) 8118 %11 Polipo
W TOR WA gL, W] BB F i i #] FiddlerScript ) OnBeforeRequest 7 ik, 0
it TOR M 25k 3 test.example.com:

if (oSession.Hostnamels ("test.example.com™)) |
oSession["x-OverrideGateway"] = "127.0.0,1:8111";
I
MRSl TOR RIEFFAE Web HH, vILLh &4 Session 5 Hl it B
X-OverrideGateway $8: 407 .



4.5 WA fo Fiddler 89 “{o 8"

4411 VPN, Modem FAp&g 5

"ARTE Windows H i 7 VPN. 3G St St iE i 154 SR EERY, WinINET < il Br 4T il
RAERERACE . @R Fiddler o] LG4 BIXFEHEH, 1 Tools > Fiddler Options >
Connections 1t & &2 ¥ HE Monitor all connections.

— AN T B OO g £ 7 R 2 fE WAnINET J2RLAET . Ml it 8nt, Fiddler
fE G BRI Web SIS, P b Gl AR B bl A O R AT 4E LRl T
WinINET {45 ) 5anf

4.4.12 DirectAccess

0 ) Windows WA % §f DirectAccess £ A ( hitpz/technet. microsoft.com/ en-us/network/
dd420463 ), DirectAccess S FFtFEih nl ks, AT 28 VPN, DirectAccess #84E WinINET
i, Bk DirectAccess [ R &SRR RIIR AR REEACRE |,

BRI AL, AT b WA 7648 DirectAccess I, Fiddler ki fk L SR . 76k W%
Hha] LLEE 37 &1~ DirectAccess BC¥ 1, 552 WIS H FrfCBR AR &5 25, (HAL i o X FpbL sl i ik
AR, MIEZ F, SECREREET A Fiddler Y, TFR % 2 {8/ Remote Desktop
ifiE AT e M b ALl PC, nfBAYEIX G PC _LIZTT Fiddler MI% S SR HL

45 WAHERIAI Fiddler iy “fr&”

Fiddler <540 1 R R W2 1R 56 8¢ 3 B ORAT L A7, X3 Fiddler TEIZATH 0l GRS i1 FE K
A (RAM). BERSMAGETAEBRER FEBENRMATE, B Fidder #H T
KRR, R R 0S4 e ORI T RESE 0 o kb

B, EMEERENFERBSM, Fidder i B4 0l GE B8 5466 R,

Exception of type 'System.OutOfMemoryException' was thrown.
at System.IO.MemoryStream.set Capacity{Int3i2 walue)
at System.I0.MemoryStream.EnsureCapacity(Int32 wvalue)
at System.IO.MemoryStream.Write (Byte[] buffer, Int32 offset, Int32 count)
at Fiddler.Session.Execute (Object objThreadstate)

LA 2R, PRGN M Ar—— MR, XRA A B SR
e 3 AL 08 A ik 1 b =5 () 4 DERAR AP U R BRI Y . 2 FARCfFRY (Honidid 100MB )
LA S S BLX A RS A 24 RAM, 32 (AR SR T 2GB ikl %% (] .
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# 4% BHE Fiddler ¥ F i

e il ok 5% o] B 0 B2 BB RE R, T BOR L R AT I A 4 B SOk 4
M a-16 Frox, BAEERKDT, TIEEESEN 087 R w0,

SER TR TFR %, NP aEsE R R
1 M2 W e 5 M =8 R T L A

i 1 I Tl

4 4-16

{6 32 frfgeH 8L b, S Fiddler (1 Web Session #|# P& 8 T4 Session, W&
SEOEEAA D EL MB 9wz, af el B IAYERT S Web Session #1) 32 46 X 4~ o) 8.
Sb, i T EE LY Keep Only SHEHEA] LL 5 2h#k#7 Web Session #1l 3¢, A= plil i {103 o] F
fit = (8] K/ Session.

24 Fiddler i=4T{E 64 /() Windows R A i, &8 B M AFRE R B 64 {1
Mohb=F ] e W A, A vl BT s AR S ECCEFE KM Session. A, HMEYE 64
el B, th FAENET HEAL e 2 B, B~ SR e ot B R iB 8 2GB.

e 32 frmitsipl B, Y FEUOCHER, nfBLBE{E FiddlerSeript /9 OnPeckAtResponse
Headers Bfi 8 hifs oLl fCR%38E G py P SR O, LU FAURS Y B & S 80 L SMB i Scfh Ll
i X B % 4R, Fiddler AL {R7rE] 4.

/f This block enables streaming for files larger than 5mb
if (pSession.oResponse.headers.Exists("Content-Length™))
{
var slen = oSession.oResponse ["Content-Length™]:
if (!'isMaM({sLen)) f{
var iLen = parselnt(sLen);
if (iLen > 5000000) {
oSession.bBufferResponse = false;
oSesslion["ul-color™] = "yellow";
oSession["log-drop-response-body”] = "save memory™;
}
}
}

L 3T FiddlerCore HJE SR Fiddler 9, o] LL{E 2L E 4R -

FiddlerApplication.ResponseHeadersAvailable += delegate (Fiddler.Session oS)
{
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4.6 A7 foii A MR R

// This block enables streaming for files larger than 5Smb
if (oS.oResponse.headers. Exists ("Content-Length”))
1

int ilen = 0;

if (int.TryParse(oS.oResponse["Content-Length"™], out ilLen))
i
// Pile larger than Smb? Don't save its centent
if (iLen > 5000000)
{
o5.bBufferResponse = false;
oS ["log-drop-response-body™] = "save memory™;
b
}
}
bi

HAHE S~ Fiddler 75 64 f7 AN Windows |- 5 f& Ll 64 frbiazqT. fEilbAm F,
PRa] B E A E A 32 F B FaETT. B . WURARAE D B0 RE AR A A th — BE LY
432 Qe gEesza bl 32 fBEL (o Silverlight 4) JE1T, S #R1F) FiddlerSeript
M AR R BB 64 (U IIRCAS . BSAMBIF, Microsoft.Jet. OLEDB.4.0 il Fe (it R i =1 i 1
fi3 Microsoft Access MDB 86, B OCPFEAT 64 friea. Eoiil Fiddler 71 64 4 (1)
Windows FEL 32 fEBEA021T, ol {# M Fiddler %38 30 #F % F i) ForceCPU.exe I JL.

4.6  GeAr R A B i

BT R R Y, o] LAY Fiddler BEATRCTE A4 e $0 0 SR R R 3 R A0 F] H AR L
MWW, wrelsEesEAr e,

46.1 HREF

SRR Fiddler, Fiddler £2 % WU HTTP iR, WA ® 7 #ei, id
R, ZFFRE Inspector T-Fil. WiRGREEIT S, S TS SHIEHE, Fiddler SR
P e i TR B

Fiddler A~ S FFTATHLHILL “3at™ £ HTTP iR LR H 48, B R ME P Sy
iR AR B e F k. HTMLS WebSockets 2 32 1~ W i) — 4~ $ ) ——
WebSocket 17 5L A1) I LA X 1F) o
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Ea4F EWE Fiddler E P iy

46.2 WRNLZETF

R AR PIMR S &5, Fiddler ZEIUITWIN ., A 268 WLAY Web 5t ORILR SR M
SRS ) RS2 3w R R A7 T i e ml, PRt Fiddler S2RFRLCMIRE . 3 o 5 G 44
Fiddler i) Inspcetor #EfTEEE. BRUAKRSL T, ST 5 S8 AL 00380 440 12 R 0 ik e LA B k]
LARC ¥ B A (e 4 H Fiddler “C L= [ fish 252 FF 3G B ¥ B4 (0w 12, ol 4% nT BLifi et FiddlerSeript
T Session (1] bBufferResponse Ji{F 24 false, A0 W7ok £ 04 Mt 17 06 =LAk BE .

0] Wl W S R AR B e, TR 0 i A DA B T AR R e N
BLUR LR, WS P R O B Fiddler 1 HE, Fiddler it 2 130 BB 45 S (MW I, 52§
WrAE A ma B . R R A S Fiddler {7 9 S PR 0k F &, B E R R I
fiddler.network. streaming. AbortIfClientAborts % true.

RN, WAREREZEF, FiddlerScript ) OnBeforeResponse i i £ {6 W il [P &5
B IRIET . EMT A (ATRES ABRVE) SCiRF A asfEciompi i edE Clodew ik Ll H &
LS B HAEED ), MR TP Session MIAERE ER . WRARIMACHD S B0 5 A4
fry o i 2 5 R Y, e T LI Session [F) BitFlags:

bool bWasStreamed = oSession.iaFlagSet (SeszionFlags.ResponseStreamed))

an AR A N A RGE B R P i s e, M B AE AL PEFE)Y OnBeforeRequest
&%, OnPeckAtResponseHeaders 1 1 ¥ oSession.bBufferResponse=true, H{iifiiis{AbBE.

46.3 COMET

Fiddler '] Inspector /£ MR % ddm B e it is, Haslbasmipvi k. (B2, RS
Wy — HAAE R, SREMARRIE? R R URBEEE R RGP R, e
H#h COMET () Web Sa i HR s it sk,

1 T COMET, M%F&BEWH “BHEHE4" (hanging frame) s HABFLE], Wi HTTP &
HEHE, R PSR EERHEE R . HTMLS 5 T —®h3seln i, #5248 “Server Sent
Events”, ‘& TAEHLEIA COMET Mifd]. (K% 1K % 20 COMET Wi #IASILIE “85H”, &
S R [0 (Y 8d A F Fiddler Inspector i 5 8 A~0) WY, Pl ECH.

B F A R B Fiddler fF Web Session ] I F C# 8 p4{iE T COMETPeek i %«
A iZEG 4, Fiddler & “thIR” IEAEPATRIWER, w] LU 55 38 1 3 U0 ) B840 o R

Fiddler 2R\ 725 M BEREAT LR 77 (097 A/ w7 {8l COMET i, EREEMNE

a0



47 HTMLS5 WEBSOCKETS

COMET BLF, B4 % 0 ma g #E A £ 45 8, I Fiddler 3 COMET ¥ ifi it 4148 43l
W £S5 Web N, MR, COMET WM &4 LMEE A Ubid, BEitnRAsse
F S R a0, T T S AR A7 v AR e 2 e oy

4.7 HTML5 WEBSOCKETS

HTMLS RS |A T WebSockets, 1548 A S F52 7 3 H1 I %5 38 2 )41 520 socket il {55, =
fildlt WebSocket, 5%, &/ iR PRGN HTTPS)ERE. W, B/ AR 24ET,
[ STz 1o J5 SR B A ] WebSocket Fipisl. X T4l S A H %45 1¥) WebSockets, 435
1l H] ws://B1 wss:// URI schemes, BUR#IEG R8T Bt 42 HTTP 8 HTTPS L4W4THY.

T ML AR (o Fiddler) %% WebSocket Bl il LI, & 565 WM gt v
L) CONNECT, R 3 HbrR % 250000 . W E WebSocket URIL i FH () /2 I ) wss://
Wpill, EANAT HTTPS 8T A4 A A2 A & (Y wse/bhisl, i amgix— 4,

WG, B il EE KL HTTP GET iR, iRk Upgrade Fnb1HL3|
WebSocket tpill. WAL IR B GE —H obhidl, B4 iX HTTP/101 Switching Protocols WY .
illit Web Session ¥4 H) Inspector, 0] LIRSS MR XA LR, Wi 4-17 Fras.

Weh Sessans

; Weh Festior [== Santstes | Ty Iropectors ml
# Desult  Probedol Hemi UL J &h

m.wmm

M HTT Turmsl (B wel. wblrpockitaln. Com 51

GET fwenace HTTRS1.1

Trarabor s |||.-n-u-: Teethen  Sysianiies | lmagei
(HTTR 1 101 Swiching Prolocsh
Fmorilanenus

Lo iatie: ‘WishGaket
Secuirity

St WebSomet-Arrept Sqap U yE2TIIT HHD WIE =
Transpart

Corrwciion: Lggrads

M 4-17

BTG, &R % 28 0] LLEUE o] W 5o #2232 WebSocket 8. 1 HTTP iR
BiAUAS ], R 45 3% 45 0% WebSocket i1 ELE % 7 8, W% 5 4238 WebSocket 1 B &5 iR
08 (K4 THEE B WebSocket PRl S, {EEE FABAENR HTTP i &, ¥F Web Session #1321

a1



®4FE K H Fiddler o & P 35

Lo ifi R Ek WA RS Inspectors & A~2x 75 # WebSocket i K. .

{HJZ, Fiddler TLiEMHT WebSocket .8, 7ELLS ) Fiddler MUA P 24| A B Inspector
R, Fy B RE L WebSocket BB HL. TLAE, &/ NS IR 4582 WebSocket i B2 TE Log
fRAeh Bosny . X B BLE A T R A B Y.

Upgrading Session #47 to websocket
[WebSocket #47] Server->Client (12 bytes)
TYFE: TEXT.

MESSAGE: connected,

FLAGS: 10000001 DATA: 10 bytes.

[WebSocket #47] Client->Server (14 bytes)
TYPE: TEXT.

MESSAGE: timer,
FLAGS: 10000001 DATA: & bytes, masked using KEY: BD-36-84-D5.

i i i i i i, i e g b i i

[WebSccket #47)] Server->Client (23 bytes)
TYPE: TEXT.
MESSAGE: time,2012/4/30 14:50:38
FLAGS: 10000001 DATA: 23 bytes.

[WebSocket #47] Client->Server (B bytes)
TYPE: CLOSE.
CLOSE REARSON: 1001
FLAGS: 10001000 DAT;: 2 bytes, masked using KEY: 25-R2-56-AE.

77 1k W 4 R B A 5 S BT bug MR EfHH R MM, B BT WebSocket i
M AR AT S AR AESS (masking key) HEIT S sliZ S H AR LA, FEHETH
JavaScript WAE A %N, HLLHERCRE MW WebSockets i 8, Fiddler il %
SRHERS SCAHEITAR S, LLAE T (Y.

B THRAER) finalize ik MBS H NG, $HFEEHMISSIET WebSockets
mﬂu ﬁuﬁﬂ-! Flddlﬂ%i&ﬁiﬁl &mﬁ”ﬂﬂiﬁﬁtﬁ'}ﬂ,

4.8 Fiddler fil HTTPS
M7E Fiddler Lifjin] HTTPS M, BN FEBIMANESE. BAOVE A DI

g2



4.8 Fiddler #n HTTPS

KM FI, "R R] 4R E > CONNECT i, W 4-18 B,

# Result Protoool Host  URL Body

8 0 HITP Tunret to  vwww, fiddler 2.com: 443 0

é 2 200 HTTR Tunnel to  ssl.google-analytics, com:443 ]
¥ 4-18

HTTPS HrilU7E HTTP i R FUs 2 () TCP/P M 25 3% 35 2 Al n— E & I (SSL 3 TLS)
MR, R EmMENERE L. TR T mEER L, o7 BUES ik 45 b ) 4 W 52
A a0l HTTP odis i .

PR T il 2 b b A BGE L A FEAC W Fiddler, WTLIEFFH RIS HTTPS ¥dWii. Fiddler il
i “rpmA” SR HTTPS (e, XERAT 9% Pt ifnd, Fiddler £ “fi3%”
HORE 3%, MRS e iEet, Fiddler 2 “f3E” HOLE M 4.

HTTPS Fpis i i5 v Iz 30 ek {6 0l 15 ke A UE HTTPS MR 3% (AR T LLEEFR% 1 5D,
Ml BB . 9% Ui AR 55 3% B0 B 45, B Sl ol B0 7 iR $RAF R e R (A 1R Y
Root Certification Authority, 32iFiF A S REHEEIEMN . FYIER RE LM LiEfT
Fiddler, W] LA S0HAC ¥ ) WO 28 sl £ R85, {F 5T Fiddler MRIESS. FrEL, &/ mp e
8 B H A th Fiddler £ BHEE B, BASMNER.

TL{E Fiddler b 3l HTTPS #(3 i@, ¥ siili Tools > Fiddler Options. 7E HTTPS i1
fe L, 1% Decrypt HTTPS traffic 1 15HE, Wik 4-19 Frg.

| Feddleriz able to decrypt HTTPS sessians by re-signing tralfic sysg 8 seif-ganersted cerlicate.

| Capture HTTPS COMNECTS
&7 iﬁﬁwﬁ?slhﬁa Lizarn mare aboet deoyption and certificate evars ...
’E-_s—ﬁa-_-_ T

[[] lgneee server carticate ervors

| Feip decryption for the following hosts:

| ExpartRnot Certificateto Desktop Remove InMerception Certficates

Help Hate: Changees may &3t take off ect eotil Fiddler s restarted. ,ﬂ':“-| !w )

B 4-19
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¥ 4% ®E Fiddler &P 5

YfRiA ] HTTPS 889, Fiddler £ *E B8 A MRIET LU VCALRIRFT #9. Fiddler 2 A#54
B ] () 22 Ao AT ] UIE B B HTTPS MRS 284F 15[ Bl “£45i5C4K" (End Entity) E+5].

{E1F Fiddler #RiE$H

LML PG, Fiddler 3 M AGHE, kPR # 2L &R L nE] Windows 12 E{EMHE
P EEFE D . VR UE 585 0 30 52 45 47 i Fe o ] LU 43 50 W28 A0 3L Ad s BT 3A 2 Fiddler JG1H0E
R HTTPS MR 28E H2 4 B . &l CABH b W28 Boan® & AL, @ T “{fE1Ess
BB R

Fiddler 1 Windows &3 B &5 B, A T2 GRS U HE P EE TR, i 420
i

ﬁ Fidcier generates a unigue root CA certificate to intercept HTTPS traffic,

You may chacse 1o have Windows st this root certificate to avesd
secunity warnings about the unirusted root certificate, You should
OHLY chick "fes’ on & computer used exdusively for TEST purposes.

You should dick Ne” unless you're very very sre.

Trust the Fddier Root cervente? | Yes | [ B ]
B 4-20

i 57 Yes, Windows 29 HH A6 HE, BR®ELLF 240, Wk 4-21 Fros.

You e il 1o eritall § certdaste fresm § CRtihoEnn Sulhasy (LA]
chisrirg bo sepeesent

DD WOT_TRUST Felberiost

‘Windows carnscd validale Bt the cetds sfe i actually from

D NOT_TRUST FialdbiBant”, Vi thinsd conlm its srgen by
contacting “DO_MOT_TELET Fiddierfno®. The tellowing numiser sifl
st yom i e, prosen:

Thasnbiprnt: fsha1): ATEEIDED F585907 ASEESECA 4327 208E
DRSS

Wirneg
¥ you kil this root certfcats, Winddnw will ally trus any
cerirticabe sawed by this Cb. inslalbeg o cortificate with sn unconlimmed

thyrrlsprind i a secerity mk. Il you click V™ pou scinoshedge thn
vt

%3 iy Vit B i) EhA £ et

| L]




48 Fiddler ## HTTPS

TR T BRI AR TP, (R e i R AR R DD . B Fiddler HUEF#EE
G i SOUME— A g, R R ORI Fiddler B B M R (RO HRAE 15, A 8 o 22 4a 4k
PRk, RAEP A2 B FE AR STl 2T i E Bt i . R IRa e Sl S
B, RS B WO .

£ Windows 8 Lt HALTEEMEE

ff Windows 8 |-, Metro Rk (¥ F A 2 (5 4F Fiddler FARAE 15, Bk igMiE 5 E4E i 81
HUEHEMMRIE RS . Eik, fERAT SR LA BRIEE B mB A R RE B )G,
Fiddler 45 k3 504 FEARIF, JCHUEBEEmEHSUES, WA 4-22 Frr.

o 4 I ; T
_q

SEEn Progiam name  Fiddler Centheste T
Tl Verfied pubdshen Dric Laswrence
File anigw: Hard drewe om thig Compater

! Show gt STYEN] Wr—

Lhirgs wén thaye nedils At Spga

M 422

) R iy Yes 180% T H, #ua#efE, W 4-23 fras.

% TrustCert Confrmation - | bt

Please confarm that you wish to ADD the following cevificabe bo your computer’'s
Truded Raot ceridicabes dore

CH=D0_NOT_TRUST FiddisrBoot, =00 BOT_TEUST, OU=Crested
by hibwpeveweve fiddierl com

=1 % ]

8 4-23

S — B AHEHE S, 2r4e% Fiddler FOMIF15. 4 Fiddler §7% S e,
Windows U485 FE 90 A2 s 2 4 iR .

SR T Fiddler “ERLAHEYS, RHUHIED Decrypt HTTPS traffic HikHE, MISHT

Remove Interception Certificates .
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4% K Fiddler fo % /3%

Fa{E1E Fiddler #RiEH

i A T2 54T Fiddler HiF15, 7l K15l certmgrmse, AP FEUEFS M, Personal 3
$t4% #| Trusted Root Certification Authorities SC{f-3. W7 EL ¥ ¥ THL S8, i
LLF 5.

1) 7E Personal 3¢ DO NOT TRUST FIDDLERROOT ilF-15, £+ All Tasks > Export.
2) 4P HAE 5Ll DER Encoded X509 Binary 1E50 5 H B 5L i1 FiddlerRoot.cer .

3) KiZh mme.exe.

4) rlii File > Add/Remove Snap-In.

5) i Certificates J4%  Add 8.

6) 243t 4] 5HE This snap-in will always manage certificates for, %P Computer Account.
7) giiti Local Computer, #J5 fith Finish, % siti OK.

8) 477119 £ Cenrtificates (Local Computer).

9) A7 L EIE Trusted Root Certificate Authorities, #E+£f All Tasks > Import.

100 EERTES 2 B M, FRAE.

Hih HTTPS i£Im

{3 Fiddler Options & 1.2 dif, X EAEA] 4 S B A8 FH o~ DE R AR b B i,
4-24 R,

oS08 L Sl ol B A MO A, B A P s, 6
R HT EC A A R DR 1 FH s i . B T IRAE CPU R
WAF, i P iz o ay G 1A B LR HE T S04 F HTTPS 1)
BT R 8 Cn Outlook 4 ] RPC-over-HTTPS i i
#EFE Exchange %85 ) LLEA AL Fiddler 7E Windows {ii{E
FE (lm Dropbox ) 4 FAARAEF5 o | A i o] L

A T CAQE FE SCACHE B 11 A 75 22 0 0 1Y) HTTPS Bl iip e %38 26407, RamidLl +
B W B 1A Outlook Web Access 1 Dropbox ¥l Wit 1T/ %, Wil 4-25 Fror,

ik S T AR TR R, R R

[] Dgcrypt HTTPS traffic




49 K HTTPS MEEE % %

Skip d ecryplion For the following hosts:

= euchange, mrossft. com: “draphax. com

¥ 4-25

4.9 4 HTTPS fR#AcE % ) o

iR A B EIWH (IE. Microsoft Office. Chrome. Safari %) {#H Windows ik 5 F 3k
B b uE 5, (0 —Seny S 0 CRUEREE. toln, Java BT EREEEE A B CRUETE.
ifii Firefox #1 Opera 1l 518§ 3 43 5 447 B QL HOIES ) 3% .

B GORE () % P 5 4T Fiddler “EREMAE, 856 Z04KI Fiddler AOMRUEH5{F 4 .CER
SOt AT CAAT PR SR - F R

1) #aid Fiddler Options % C11) HTTPS 76 <[] Export Root Certificate to Desktop $z#l .

2) 50 W% oy ] httpe//127.0.0.1:8888/, s diEEE: FiddlerRoot Certificate, UE4: F#
b .CER 1C{t.

£ THRAUEB M, @ n] LU I0mA BN H i E EE AR .

491 FETEE

Firefox

1t Firefox ', fiifi Tools > Options. pitli Advanced 4, #/5 V)4 Encryption ZE5 .
57 View Certificates 1] LL§] I Certificate Manager. riifii&Ji+ Authorities, JF it Import
$ie6ll. ¥ ¥ FiddlerRoot.cer, #iili Open. i HAEHE Trust this CA to identify websites, 1%
F Ok. Firefox 215 {F Fiddler Rk f HTTPS [l % 4§k 15.

Opera

i Opera f %28, 17 Opera > Settings > Preferences. riili Advanced iE7F, i)
P Security. fiddi Manage Certificates. £%ili Authorities #EMIF, sitdi Import.. f&H. %
b FiddlerRoot.cer 4F, sidi Open. Aiddi Install #5241, 2idy Ok fil, Wi (R {5 5 %IE15.
Opera 23 {5 4F Fiddler 42k HTTPS fE % #51E15.
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B 4% BE Fiddler fuE P i

it EAMAR

ARG Fiddler 1524 HAh it STHLE HTTPS ¥l fCn, A% F shmd B ICah it 500l 4
'EAH T Fiddler B4 2 10MEETS. 0T LU http://FiddlerMachineName: 8888/ 0 (I F &8 15, 4%
JEFEhALHE certmgrmse W, HEFEHRIES.

BRI

#4- Fiddler #RE B2 H &3 AR —4). wREF % PC LW LA KT Fiddler 4RiE
#, HAE RS A H — & it JM Ll i Fiddler FARAMMIA, B A TR AL & KGR
EHREE (L EMAEAF, AN EHARR ), EHREAREALRL HTTPS #4204
TR GHR — PR P R O AT A SRR, B R AP, LM A Y
Fiddler #RiE 45 .

492 HTTPS flig&

Windows F#1

4 T ¥ Windows Phone i %15 T FiddlerRoot iE 15, 7L Windows T-HL [ 44 50 %36 1% iF 5.
EEIHL X -, NSE M B9 4T T http/FiddlerMachineName:8888/ . T & Wi 5. 4177
FiddlerRoot.cer SCfF, #5 )G (E 9 11 Install certificate? Bf #& |2, 251l Install #4 .

Android and iOS

Fiddler BRILMYAE 2% (Certificate Maker) RIEF 447 TH makecertexe. JLTHr
11 1) Windows % /" S #4552 1% T R A2 M AIE 1, CHE 4 JUABF 6 52X Bl 5. {02, Apple
i0S i ({94F iPad. iPhone 1 iPod) B ALK % 45 UE 151055 makecert.exe-"E 1K
UE b A A A oAb o ¥l . 2% Android A A B BT K.

LAY Fiddler EMMUEHRIX LR EWE, MMLL FHig F Fiddler 46 Certificate
Maker:

http://fiddlerZ.com/r/?FiddlerCertMaker

ZAEE T E ST RS N Windows Vista sELL ERRA. & &40 Fiddler TPIRIAWE
JRACHS B 4 S 3E 1 T BRI Bouncy Castle BUEILFERIRRA . BRUANSL T, flifF22 Bk 08 #0%
MIAE$, JF HL %Rt Preferences, UL HFIIZH9T & W% .

A, F—F Android V& TR BEHE EKU _EARNIZA Critical £Y%. #]
LA B E 152 A A, il QuickExec BEELWIF, A 29 5

prefs set fiddler.certmaker.bc.ee.criticaleku false
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49 HHTTPS BERE & P i

A R R 5 SR AE BRI AE Windows IEFEFED, R EEFTEAGS . B
Fiddler 8 i, LR BIET. i1 makecert.exe T FLATE A UF 15 W) 43 508 In
B MAEBEED, H 994 T Remove Interception Certificates 41 J5 A 2= M % .

AL 1 Fiddler "ERHI B FEMUENS S, BENERC W B & (54T Fiddler AMRUETS. B4
BIX — i, e IR AT i ol B PR O A A, S R SR Fiddler 1R 4 {UHE.
5, 7ok # AT T hup://ipv4.fiddler:8888/, JF F B HMIE 1. 773+ FiddlerRoot.cer, I
b 4-26 B,

4 F Install $i4ll. RSEBE SR, WTLEEF Install SHBETHA, WFE 4-27 B,

A g i | Ther suthenticity of “DO_NOT_TRUST _FdeRool™ cannat
] TRUST Fiddierfioot
O s | be verifisd. instaling this profile will change sefings on your
[ iPad.
b e e ] '
Pcesverd Winy 18, 511 | Rout Cerificate
| Installing the cerificate "D0_NOT_TAUST FiddierRoot™ will
Mare Dhetais » | add it o the st of nsted cotificates on your Pad.

B 4-26 B 4-27

ST Fiddler MIBUEYS I, 9 Fiddler WEHTEUR G, B0 SA8 RN A2 prafth i
BRI

AR E M & VAR 15, W JF Settings M, A General, #8538 50 Bl ER3
Ige F A ) Profiles. &7 DO _NOT _TRUST FiddlerRoot, Ji§% F Remove Fifll.

4.9.3 HTTPS %2548 Bug

1/ ¥ HTTPS it % 25 80 IE 8 SE I TLS 48 T, 9 Fiddler FIZSE R % 3848 T0F &%
W, Y Web T8 045 2k emt, St LR RE AOERE R, (E 0 WT 28 0T A 3 sh ] iE $)4
R A R4 T Bl SRRk Ak P 2 Wi o) 11

Fiddler 7] LARC ¥ Al Ok Hit 55 854 (45 52 (6 BR 0 RRU A M 35 92 A7 bug (4 5B 75 FiddlerScript
H, {E Main()f 2P A B F 4SS, B Fiddler 7E & 7 HTTPS FEHemt HE2{E SSLv3.

CONFIG.ohcceptedServerHTTPSProtocols =
System.Security.Authentication.SslProtocols.5s513;
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# 4% BHE Fiddler fu% P i

st ATCARE M LAE T4 — K. (£ OnBeforeRequest e ¥ P, I F L.

if (oSession.HTTPMethodls ("CONNECT") &&
oSession.Hostnamels ("buggy.example.com™) )
{
oSezgion["x=OverrideSzlProtocols™] = "ss13.0";
}

i H L0t SSLv3,  fn] LU S AR A (WA SCREY R TLS B fib oh B A A 45 25 .

494 FE4EH

™ Fiddler ZE#: 8 HTTPS M358, EoRUFRS 808, fftur B Ra 8, it
HEHRSEMENS . BANRT, 2R FA O e g R o i Ak s, i 4-28
iR

Session £11: The remote server [mal_exchange moosoft. com) presented &
ertificate that dd not vabdate, due 1o BemoteCerthestsamabiamaten,

SUBJECT: Chi=193, 168, 158. 158, OU=HTTPS Management Certificate for

{seif -signed), L=Surnyvale,
ENPIRES: 1f18/2038 T:14:07 P

{This warning can be dissbled by dicking Took | Fidder Options. )

Tgnore errors and proceed anyway? T | e l

P 4-28

RS No, EEERSH EF . WIRER Yes, iF SR 20, EESEWRMM.
Fiddler 248 {Aipfiti o, ABEH s, BEA Fiddler 250 5 CMUE, WfHkas
FURINERAE S S, RPN AL EIRBR S SR .

4.9.5 Certificate Pinning

£ % HTTPS % %i % F % 4F “ Certificate Pinning” ShfE, &IhE LGN % /i i H it
TR ES, Mofy REEEERUE Y. BIERRfF AR 50 A (i 18 FE 4 48 A0k 15 B £ 43 3 1 H AR
%85, XF R SRR A IR,

Holil, —2 Twitter A1 Dropbox MiFEL4 % IE. Windows § Metro i FIJ il L HEH: Hu %5
SAFRE S A AR SE 1 A FEME 5%
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4.10 Fiddler 2 FTP

9 Certificate-Pinned ¥ Hifiid CONNECT i 1 Fiddler #17 HTTPS £ F i, EoH#
W P2 ETUE 1, IF LPE 223 Fiddler 4 g AE I, Sdadnki% il k.

BRI A, A A SERR A ) B, PR AE R (Y e Ll T fF CONNECT il
F# T x-no-decrypt Session braifir, Gt b M BIR HURITIE S . bR A £ UL Fiddler
fi 9 LA P P B T, BRI L) Fiddler B 3306 06 S s i

4.10 Fiddler Fl FTP

EOHTTP 256l SCPEsmbhil (FTP) 23+ TCPAP MYthill, H L8, BEEE
HTTP hisUtHERA 5L, JEHA HTTP BRCAER. H, BB A4, Fiddler Mg
FAE T HTTP M bl G0 TR A 29 1 i Dol U 2% s i PR 2 A ¥ Rl ok CERN JE AU EE
Fiddler ) e AURE FTP HAGHR, 25 P e AR £ AR 2 6 &40 FTP F 80w R ¥ 4L HTTP GET

e S R AR S S, B4 FTP B HTTP ik 4b ik FTP ik, &k
L~ FTP Wpistdl e i 3 B i IR 45 8% . 247 HTTP 4§k ¥ URL 1 Authorization 3L JtH T FTP
i, At S kL s

Fiddler 0] LLil ik —Fp A7 L Ab B FTP $icdbs i -

1) f£4 HTTP 2 FTP ¥/ 3% .

2) il S bl CERN B M{CHEES 2% (I Microsoft ISA), EMR%#%41F 4 HTTP
| FTP 19193,

3) ifiit Fiddler AutoResponder (BGILALTHAE) emd fv k.

LA Fiddler yEME 0 /YR FTP AUBE, rid Tools > Fiddler Options. £ Connections i
T4, ¥ Capture FTP requests 0, # i k7 Fiddler,

b1 5 Fiddler #EWFI MY FTP i R %A X3 LHFMOCICEE, M H AutoResponder A0 #:17
LEFE K, Fiddler 225 (FH FTP BHSUEHE BIMR % 25 . Fiddler 2 F ik UL FTP il % 2511
WA R HTTP s, i mles% F si. 9 fF ok HTTP 3| FTP (IR XHt, &fE RN .
il , A2 Session [ Timers A1 % . Fiddler A3 F FTP H#is\Wifi——5c (1) FTP W N 7E
e 2 A2 ERAE, JFIRMIERE S .
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$ 4% MY Fiddler % P 5

4.11 Fiddler Hl Web iAiiE

#i 3  MU2 TFRY) Web 3 g A A HTML F S0 EAT U IE——2S 30 Y RHEHE, BRE P A
PrAARER. REOL LB R, %S B S Cookie, % Cookie 23R8 B i G4k
(K . Fiddler 0] LR 5 & F AL AZ X PP Cookie.

{2, HTTP fl HTTPS 32 0EPYFl BUEHLBIETT %7 W6 AL

* HTTP B{Hlik

e HTTPS % )7 fiik 45

Fiddler ] LA{# A] LL EARfT—FpihiE 20 5 R 952830 111

4.11.1 HTTP BiAiE

{EH] HTTP S4HAE, &/ 3 e 0% HTTP K, % 3ma R & % 2k 156 HTTP/401
2 HTTP/407. HTTP/401s & i i 42 £ 4 DA UIE () BB 5528 AR 1), 10 HTTP/407s A o £ e 55 9%
y, 8318

HTTP & % 47 VU F SHHAE LS

* Basic

*  Digest

* NTLM

* Negotiate

{E Basic tAiE (RFC 2617) #L&*P, %/ %&7E Authorization W3R L P HEGER] 2 FIEM.
% PUEAEAS AR 2T 64 (i, FFH Auth Inspector B LA ARYES . Basic tATEHLEIA G451,
SR AME ) HTTP b R A 241

{E Digest tMEHLE CEIE REC 2617 hifiif ), [R5 28 &l WWW-Authenticate ¥
1 3k e 3 0 R HH R . P U S R M RO P R R BN, BR AR AL B
NI &1, A EHLHI L Basic S8, {HAE i1 0 55 38 S A iZ W0 S R PR L e 5 Rk 1 o
bug, ZHLEE D W,

NTLM Wb UFHL 5 4R 2L fE 25 3 Internet 08, (B2 2T Windows % Intranet =P I i {d
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4.11 Fiddler #2 Web il

o 85545 6] 55 5 S A0 HTTP/M01 WP, 95/ e BT AS TR, s E30Fr NTLM ik
HE, #RJE RS AR T . 0 il e % T R 1 e I R PR, SRR I
B, BB S BRA0AE (ML R R . B R AT 27 NTLM WAERY, & B a7 Bl e Ll
HTTP/200 #2122 #7, W4~ HTTP/401 M.

5 Basic fl Digest iAUEAH, NTLM HLEGIHE AR ik, MM, NTLM HL
B —MEEN, oW HESAEEES A EREE LGERTf RNk, X
ERE RN SE BT — NN R S — R 5 HTTP/401s, 655 30 ) o1 o indk
I A BT A J U\ R T B A

Negotiate AUEHLE] (B BFRY “HRH Windows AIE™) A “ B30 i, HEEd
J NTLM il K Kerberos Hpid. #£ HTTP )2, Negotiate 5 NTLM fR#f, i RFH%E 1
) 3 AEEF.

S E AR 55 48 I {6 H NTLM 5 Negotiate B, 25 7 b 1 A 223K 1242245 I Proxy-Support:
Session-Based-Authentication Wi ¥ 3. 120 B 3k Fe A CRLERAR A 8] 10 % 1 2 (]2 2 A
(F1i%EHE. Fiddler £ H ol mizmi i 3k .

411.2 Fiddler 818 sh B {3AILE

Fiddler ©] LLH&h#f i ] Digest. NTLM #1 Negotiate il iR 5% #E4T & 4 ihik. 4
Fiddler [ shiE 1T 84 A UERT , 36 1 R i % 7 3 0 8 7 2 op 8] 42 ) HTTP/401 8L HTTP/407
W%, BRE R Fiddler A5 &b tem iy, &R SR, SE N AMERREA
IR AL SR

S {§ Fiddler [ zh i P AR 45 2% ol o A PR IG DA R ], R8T Session i) X-AutoAuth JHHE
B AU A . WER (B0 {4, Fiddler 24 HiZ4T Fiddler () Windows & 3tH]
PO RS

static function OnBeforeRequest (oSession: Session)
{
J/{ To use the current Fiddler user's credentials:
if (cSession.Hostnamels("ServerThatDemandsCreds")) |
oSession["x-Autoluth"] = "(default)™:

I

f/ or, to use explicit credentials...
if (oSession.Hostnamels ("ServerUsingChannelBinding™}) |
oSession["x-Rutofuth”] = "redmond\‘ericlaw:MyPEiswlrd";
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# 4% ME Fiddler % P iy

1
/

4o % Fiddler £ & & S AL & 2R P B P P abdiih £, 008 Bk
& {li a8 e 4P E | B ik sl K £ 1T iE 4T Fiddler &) B 0945 4 it
T % WrikiE,

i 45 Options TEM ik h T Automatically Authenticate ( [ 5 fiHAUE) W iFHE,
Composer i% 1l F 2 H &I x-AutoAuth #5 & 67 ) {5 ¥ ¥ i Preference fiddler.composer.
AutoAuthCreds [11{E . /£ 75 % HTTP Basic tAiEMH R T, L E~ LT E# username:password
T, (A TextWizard #4T base64 Hif. {(FF] base6d HSISATUEFFFFEH, EEEmE]
Authorization 5% Proxy-Authorization 3¢ 3. 3L e LLEEF Filters &5 F . FiddlerScript i
Til f 2% Composer #E T ) Request Headers 3% HEFR Imad #h Al ok .

411.3 BiAiEie R

M4 Fiddler £ 4 {CEE JE4R M0 M HTTPS W% Lhfie, BTLL Fiddler 7Eis 1707 I 2 W
AE. PAERT 3 WL =4~ [ 8 & Channel-Binding Tokens. WinHTTP il 45 i fil Loopback A
IEfRT. EUFHRE k.

Channel-Binding

NTLM £ it A E L Ak 2 —fE T2l %2 “ Bl (passthrough)” By, fEEFHEd,
G TR R, 1 AN A = IR AR A UE R . % i sk
SR LA BT ) o N, R O A D 7 i ) DO o o N A W B Y 5 T R 95 A8
AT B pAE. B EGET, Bl o] LU AT 1 A B B 0 R 55 4% B Ul .

R PhiX AR 8, $EH T Channel-Binding (1% . Channel-Binding % i\ U /i iy me 1 4§ 5
B, WIAREGE S N LA O, @0, 00F 588 30251 HTTPS %%
#1757 AT BLIE R TF. Channel-Binding /2l il 11S # Extended Protection 17 5 HLIY

Channel-Binding %% Fiddler 773k T [, [E7% P U uE il Fiddler 965 3% ) &,
P Fiddler 18X 800 HfE R TUL MR A A0, MASSind. BT HE, JLifd
¥ Fiddler 4 S HI% 88 B4H0E, AREFF WSS, BN Fiddler H AT RN,
Al Channel-Binding {5 SRR % 8% B C0ERILA, REHSEUEGZIEY. BEACE Fiddler 24
%P e AT . A F 4.11.2 RTHGA R X-AutoAuth £ & {7 58 .
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4.11 Fiddler = Web i\ iE

WinHTTP iE4 % 1 %R

WinHTTP FEERA LR XM, E30R 4 & Fiddler ZHMCHN, Efnfe
frsfm i A IERT . 94 Microsoft Office % /' &ii . ] M. SharePoint &5 &5 F £ #4106, wl g
SR XA . OTEARGE Fiddler 7E7%)  iiill it X-AutoAuth $7 2 0 DA UE et X A4~ ol 1
M4, Pr 4 http://support.microsoft.com/kb/956943 W] LA T % 5 & U ] ¢F 33 M 2 b £ 2L
AuthForwardServerList [F1{55 &..

[E &% (Loopback Protection)

Windows b2 {40 G “ PG AIE" B, fERFR B, &7 E R
M %5 88T UAAE, (ESERR R R STHLUGIE . R il 5 L o8 T FHIC 4 St R iz
FTRLBR, A H AR R I A MR . Y Windows 8 3 A 30188 AR A M ST RLAE, o PH 2

W Al BR R4, T LLE % http:/support. microsoft.com/kb/926642 ik (), & H bR
DisablelLoopbackCheck=1.

4114 HTTPS & AikiEH

BT HE T HTML R0 HTTP IGEHMN, 757G e AH0 o s o] LU 3 = A ET,
HTTPS 72 1 il 15 2 A 5 M A E e 4L, Pt e R R 356 (4T focey
B E A GE AR, ok R o AR AR OL A S SRS, I3 R i A i
1 547t

P EAE R UGAE R SR H 2 — R SR Mg a4 (N Fiddler) % k1. BY
il P g N FHAEAE 15 35 &Y Fiddler, Fiddler 70k R Dh i 5T 12 0E 45, o 1z 6 55 48 1) i 2K
BE Ok o i A e F A 2 4 Fiddler #2408 808

BT R, SRS SR T, o BLE RO 5 S e 1 AL BT Fiddler. 2K
LT, SRR S5 AR R A U HE, ERE S SHRNIE TS, Fiddler 25 fi%USERPROFILE%)
Documents\Fiddler2\ F 3% F {#] ClientCertificate.cer SCfF, {8 FH 1 UE 15 K ol AR 45 48 (A IF 2K .

FEMCES SR, PRa] LA RS & 0 S T e e e . BESCEIX — o, fEIEEEE
e B A PAIE I IR 5524019 CONNECT il EAEH hitps-Client-Certificate J& 4 5 2 ik H B¢
e, Blhn, YRIRCS W F AR

static function OnBeforeRequest (oSession: Session)
{
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4% AE Fiddler fn & P iy

if (oSession.HTTPMethodIs ("COHMNECT") |

if {(oSession.Hostnamels("exampleA")) {
oSession["https-Client-Certificate™] = "Ci\\certs\\CertA.cer™;

i

else

if (oSessicn.Hostnamels ("exampleB")) |
oSession["https-Client-Certificate”] = "C:\\teat\\CertB.cer";

}

}

Fils

CER A AR FES M A9 8], M5, .CER XXfFH 2N Windows 4~ Ak
1ol (certmgrmse) (9751 H]. Windows UE-F5PE ERAF 1 FIE+5H 56 iF) FABT LKL 0 BEAY AL AT RCAS .
2436 A\ Smartcard I, fF Smartcard b {4710 % /" BRAE5 22 B 80 BLLED AAEHFE, i 4-29
.

Eile Eﬁm_ﬁm Help
e A FGIXE= B

-:_";J-Etﬂi'lgat:s-. Current Liser - - i |,,. ed Ta Sssued By

a |2 Personal
] Cenificates
+ [ Trusted Root Centafucation

i.]m:luuﬂmlu... Commsncations Sener
ernclaw

Pl 4-29

2946 M Smartcard I, A[LLM certmgr.mse 5 H.CER M, {8 H A2/ w5 HERE{E
W'E. H5, Smartcard £41{R &, LAY Fiddler of LA ERIAAHA.

f S AR P R B A 23 Windows S NIEBFE (Haln 245 pfx 304, R 4Ueite S
ABREH S, 5 THARCER . ¥ TiEHE, RiwEGiitt, & All Tasks >
Export...., f1.CER {47 #|58ik ) ClientCertificate.cer 2 8L {# 17 # hups-Client-Certificate
bR BT P .
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+5 4

Inspectors

5.1 %

Fiddler [f] Inspectors ] T~ & 75 Web Session ¥4+ 1L & session ()i K AW . Inspectors
Al L BRAE MMy . — ) Fiddler 1% 1) Inspectors tab ¥E36|<, ¥ —~ &ML Inspect
Session B [1. Inspect Session & I E¢E Web Session i I F 30 i A dy 4 A4 BE4T 7.

{: Inspectors ZE i =11, Request Inspectors 7 [ #i i, Response Inspectors 7 [l # Ji 46 .
st Inspector %8 (11 HexView) 0] LLAf Inspector ib T804, Wik 5-1 Fras.

] 5-1

Wi — I AF Web Session 1|32 0 5~ Session 844 F Enter 8, i 285 Inspectors i
Fo REES AR W R AW inspector BEFTHEW, WhAZE AW RMm R 5 &iE. B4

-7, ImageView Inspector £ 31 image/* 28GR P] “#&4", M CARLRLEF “4E407. #HR
M, TextView Inspector A 3C A R [A] 43, il — 2 il 6 B R [BIE 47

-1 54~ Session, iR 4] fi 5 43+ (1] inspectors £ ##0 - 855 i Fiddler & & 80 X1~ Request
Inspector, #] ELilk ¥ fiddler.ui.inspectors.request.alwaysuse 411% Inspector ZEI0FfHbn . oM
il Fiddler £t & #7541~ Response Inspector, W37 %2 7 fiddler.ui.inspectors.response.alwaysuse
(F1 50 M % Inspector BEI60 = (¥ bR .

L RVF 2 el e R o B R AT 4R 0T LA AR BhiX R 2R OF
9 o R A . el B (5 4 )28 2= ik K {k Response Inspectors [[H, B AR K EZHH &
WA, WP 5-2 .
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# 5% Inspectors

| T o | £ aonesponder | 5] Compose |

Headers | Textview | Syntaniew | WebForma | Hesview | A

g 5-2

ATH KBRS, PTLLiE Inspector T M B O cp3ar ik, wTladh THE LAY
Tearoff ##l, 1877 ELE QuickExec & iHHE A tearoff fiy S 5CHLIE — H K. %] Inspector i
1, FEeriR 3 W OB A R .

A i LA 3 SR B ) Inspector 3£ 70 F £ s L B BT AY R . Inspector Properties
F1 Hide Inspector. /3 Y11 Inspector #24LMH H B {5 B, 105 42 M Inspectors
ET P MER X Inspector. 4 T 76 )5 Witk 5 F28LIT) Inspector, A]LL%w#H fiddler.inspectors.
hidelist preference, HH# =, LFTE ) Fiddler B T SHIFT .

TRIAN AL F . Inspectors JitELH i (ReadOnly) HE04rHr 34 session, [4dli% Session 2§
A FE R i ik BRELISh, 92 Session b FAH{E (Unlocked) this, ZEoTLLYE Edit
e Wueh gy A 4 0% Session #HTHRE. K E 3 Inspector 7F ReadOnly Bizl F 2 LUK 1Y B
sk s, MAvEmis, SURNMEGA GERREA6). BN ReadOnly Sifs 2% 5
{8, @I LLif T Tools > Fiddler Options > Appearance #5501 0 Ho i T4k,

A= TE e o 5 /44 Fiddler 4 #9745 Inspector.

52 FBUHNAME (AUTH)

*R i K e e
Fipin i 5

Fiddler ff] Auth Inspector £ kA0 R 3k #240 (Authorization) FHALE ( Authentication )
e g, —Bi S, RS2 HTTP/401 1 HTTP/A07 W LR, 50 &4 17 Bl ik ik
1o, S ERm TR R X

B4, EEARIED Rule FR P “Require Proxy Authentication” FEII, Fiddler £xiR[0]
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52 #MflE (AUTH)
HTTP/A407 Wi, BERA] SO TR AR . e 4 A it i 3 3 Proxy-Authenticate $2¢
{ILff), Auth Response Inspector (19 511 5-3 i,
[aoth |

Proxy-Authenticate Header is present: EBasic realm="FiddlerProxy"

Ko Wew-Authenticate Header 15 present.

P 5-3

FLF £E D SR 19 Authentication AHEHE DA R % UserName FI#1Y SecretKey Jo. i
LA I R AR P SR LS T UAIEE 15 Proxy-Authorization i3k k. K i 4~ it
BT I A UESLIEE HTTP Basic, AEIUEF5 ALl base64 %ifih(¥). Auth Request Inspector £ [
S E RPN, JFLL R, Wk 5-4 P,
[auth |

Frouy-nuthoﬂzuiun Header is present: Basic VXN]ckShbwUsUZVJomyOS2VS

ecoded Username:Password= UserName: Secretkey

Ho Authorization Header s present.
i 5-4
R, K E B Web B a2 E R R A UE A AL, i fEH] HTTP Digest. Windows NTLM
o, Negotatiate HL#l. #F Windows &5+, Negotatiate (A iE L1 b 11 .

Fiddler (] Auth inspector P45 T #HT NTLM St abLbl, S HF i i 7 2ok ok i
Heh 45 1045 B -

=[NTLM Type3: Authentication]-==========—c=mrecce—em——————=—
Provider: MTLMSSP
Type: 3

0S5 Version: 6.2:B329
Flags: OxaZ888205
Unicode supported in security buffer.
Regquest server's authentication realm included in Typed reply.
WTLM authentication. Negotiate Always S5ign. Megotiate NTLMZ Eey.
Target Information block provided for use incalculation of the NTLMvZ response.,
Supports 56-bit encryption. Supports 128-bit encrypticn.
lmresp Offset: 134; lmresp Length: 24; lmresp Length2: 24
ntresp Offset: 158; ntresp Length: 396; ntresp Length2: 396
bDomain Offset: BA; Domain Length: 14; Domain_LengthZ: 14
User Offset: 102; User_Length: 14; User_ LengthZ: 14
Host Offset: 116; Host_Length: 18; Host_Length2: 1B
msg_len: 554
Domain: REDMOND

109



% 5% Inspectors

User: ericlaw

Host: ERICLAWTS

Im resp: 00 00 0O OO 00 OO OO OO OO OO OO OO OO OO OO OO OO OO OO 0O QOO OO OO0 OO

nt_resp: 42 40 AE AB 3E D7 TF 02 BS F% 7¢ D7 C9 5E &B 82 01 01 00 00 00 00 00 00
05 96 B2 D4 01 23 CD C1 D3 D9 8A 33 47 87 40 3D 00 00 OO0 OO0 02 00 52 ...

Auth Inspector = §if JCiL ¥ #T Kerberos YAUET A, {HURE vl LA SR 3= 88 555 I ) o vhi) A1 o 2 (A9 7

53 &4 (CACHING)

*m S
fLifiii &

Caching Response Inspector 2 T4 HTTP Wi 3k, L& b (w45 HTTP MU0 F &S
o] LLEEAF, MReTLAZEAF, WL TN HARTr ], & Sillid i I ff) Cache-Control. Expires.
Pragma. Vary. ETag. Age fl Last-Modified {5 B 485 771 W 2 5 47 2.

HEep s (038 IE) TR HTML U4 ] META HTTP-EQUIV #xid £ f7{5 .
Caching Inspector 21§ fu % HTML Content-Type 10, Sorbsid F 4L HTTP-EQUIV
5, PRAGMA #i%.

A AT A AL TR A L ATk P IMIWAR, Caching Inspector £rifist i sk 3k
ff] Last-Modified ¥7%35LA K RFC2616 "R MSEE, HEAGHHEFR A, mE 5-5 Fras.

muth |[Cacing | Cookies | Raw | 3ON | o4 |

response does not speafy s explot expraton bme and does rot speofy & Last-Modified date, Meunstic
is typically based on Last-Modifed date. Lacking Last-Modified, this resporse may be revaldaied on every
o once per browsng sesson, depending on the browser configuration.

response contains nesther an ETAG nor & Last-Moddfied tme. This will prevent a Condibonal Revaldation of ths

i 5-5

ML EL TR URAE TR S B WA T R R A N5 http:/fiddler2.com/r/?httpperf.

5.4 COOKIES

b o T & )
Fo Vit &
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5.4 COOKIES

Cookies Inspector 22 S (B ACik 1B 22101 3k Cookie I Cookie2 PN TE, J W
oz 3] () 1 3k o 1) Set-Cookie. Set-Cookie2 HI PIP. #E#L, i3k Cookie2 1 Set-Cookie2 #-
S, EAE TE BLE — S 30 fth ) W1 38 b Bl S FF.

Cookie IR pREAREAN{EZE (5 Headers inspector o A] LLF B4 R 45 6 ). XA
inspector WM AIEAGE., w7 B8 P3P WA, SR WL AATE,  ESE 2 Cookie 275
$24E{f. P3P (Platform for Privacy Preferences) E#nifEII R & EME Mm@ E i, &
J S AT RAR S dofe] 4 FH 4 P3P 0 3R 3k Cookie.

Set-Cockie: ASPSESSIONIDCCBTDCRD=CIFKIKJDFMJFFOCDAJPFMFEGH: paths=/
P3F: CP="ALL IND DSP COR ADM CONo CUR CUSec IVAc IVDo PSA PSD TAI TELo
OUR SAMc CHNT COM INT NAV ONL PHY PRE PUR UNI"

Inspector 7] LLAE4T P3P 3./ CP (Compact Policy) F4F T AQERINET, & LA s-6
Frar.
T T T T R TR TR TR TR T T

wert 53 bvtes of Cookie data: -~
Set-Cookie; ASPEESSEOMIDCCETDCRD =CIFKICDFM IFFODAIPFMFKGN; path=/ i

I Heder i present:

Pe="ALL IND D5P COR ADS COMo CLR CUS0 [VEs T¥0o PSA PSD TAL TELp DUR Sado CONT COM INT INAY ObL PiHY PRE PUR UL
Policy token i presenl. & bralieg 'o” means opt-oul, & raling T mears. opt-a

| o tderfiect Data: Access i green o ol deriified dats,

| = retaned for an rdetermnats period of e, The steence of & reteniion policy would be reflecied under s opbion, Wiere e
| is @ public Tora, s is Tthe appropriate reterion polcy.

prreacy policy containes DISPUTES semants,

o verongiid acbors ansng n connechon with the prvacy polcy wall be remedisd by e serace,
B 5-6
Inspector £z #F— b4 FAF T 7, #00E IE (] B B Ba FA 0 8 2 75 1A b i% Cookie
ORI, AR, T MES (0 Facebook. Google %) &% 4FiLM P3P &
By, CLRE#NSMEAThEE. F P3P N TF, AikiRBIMERC (bl R AR )
L W .
Cookies Request Inspector &7 K tH 1) Cookie Skt k D, #iBhMPE K Cookie Sk i
1 Cookie </ LI TH M &4 ik .

Cookies Response Inspector b i —25% Wi 8. Fltn, 1E &B4bprH Eiatd
TR # 1 95 28 1% T Cookie, Inspector A BLX B i i 2285 HELR.
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% 5% Inspectors

5.5 HEADERS
x e A
St 2

B~ HTTP K382 DAASC AR T U 0 R Ok T 8, k2 o s BT 4 SEil k.
KM —4T (“Request Line™) @& =A{f: HTTP Jiik (I “GET” & “POST™). ikl
URL ##f& (0 “/findex.htm”) LK HTTP A4S (i “HTTP/1.17). Request Line FJjjt—4T
s 24T, Hop R R A EE DN, fm User-Agent Fl Accept-Language.

Fefeibh, BT HTTP o BT Ll Al Sc A m i Sk R oG, B HaR 7 iR as S, w58
—4T (“Status Line”) fl& HTTP A S (W “HTTP/1.17). WRARARS (I “200™) LL AW
AR A LA (i “OK™). Status Line F AR 7o £47, o6 H -1 w B R % 28 1)
JCECE AR, Lh o RS RO RE . ST LA R W B T £ A 45 -

Headers Inspector 3 #5# & il KA ) HTTP 3k, 7F Request Line 5% Status Line T Jy Ll
HENENER R A BRMEN . HTTP kAR R EA SR T IO RERETT 2 410, 285 HE 28R
Fe P BHFHERE A0 A RO T R 0, A2 R B MR L Tl a3k, 44140 55 [Cache, Client,
Entity, Transport, Cookies/Login, Miscellaneous]. &1 Wi 3k, 4411245 (Entity, Transport,
Cookies/Login, Security, Miscellaneous].

LRI L F . Headers Inspector (IS 2 HiEm), Kt romd. €N EHEAT, B
JEVLEE 1 Raw Headers XfEHEMITY BL AR R (R, “EPERET B b wm i m
Web Session, B %) Edit $£#.9(1) Unlock for Editing #1111}, Headers Inspector €2 L Edit
BB, £Edit BT, WEMARMWMEOSE (A6, Mer, ATELHY headers 1N
FEHEIT i -

#iili Inspector 7 177 () Raw EBEHE, £ Borsli LA M header, header #iJELASE WA
Tt Rt ek L. s5id78E8E Header Definitions, #[LA#F# )¢ T W. HTTP header B IL4¥
Fr s D .

1T Windows #1590 P8 5 B0 7 76 S B, Rtk LR R header ()42 BRAME M RT 260 4~F
. BAA AR 260 FFA) header, 7T LLEET % header, 1% F Enter 2 F2 8, slA7ili
header JFi% View Header. Header Viewer B -2 bl BT, ATl R R R, &
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5.5 HEADERS

O b B 2 B (BLP R,

L4 Inspector 4k 15118 (ReadOnly) Bz, {24 T FRE, Frfi M Cookie il K LHES
AR . fESRE (Edit) BEUF, 4T Cookie LA —ITh Sk, KBRS
AR th BT — 1 Cookie 3.

551 LT3
41 il Header ¥ F& R ELL FEMMAER, Wk 5-1 Fros.
51 Header 38
View Header 1T header (1 Header Viewer 8 1.
Edit Header (H LSRR R 7)Y 4T AR h header (F) Header Editor # 1.
Copy Header JEEEA T ) header $5 UL F BTG
Copy Value only FURE B 1) header (U4HE 13 95
Send to TextWizard | 2P header [FI{E4E 11 3] TextWizard, LA {E 0 S i SO A EE TR 0D .
Add Header {F Edit #8855 F. @881 header.

Remove Header

7t Edit U, MMERIE ) header.

Paste Headers 7€ Edit BiaUT, =l FoyRs 05 B #n# header.
Lookup Header TP & % P HTTP header (47 BLI Web 91 ffij .
552 1RiEH

P Web Session ¥ 39(¥) Session 5, % F CTRL+H 88 AT LURGES 17 R i 1 1) Header
Inspectors. {F Inspector 4, ®JLL{# 3% 5-2 Brosithyies

52 thiERE
CTRL+C PR header $4 012007 W5 .
CTRLASHIFT+C L header [E{ELEE U0 S0 0E RN .

F2 o Enter 1 FFi%H header ) Header Viewer 58 Header Editor % 11 .

CTRL+V {F Editing #{:F, TR o9&, B4 E 48 header.
Insert ¥F Editing #1:F, @819 3 header.

Delete F Editing BI:0F, @ER & (¥) header.
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% 5% Inspectors

55.3 Ywig

™, Inspector 4:7E Edit (4% ) 8T,  headers A X FHR %8 25 /W 2 a0 o LAt
AArtEck. WA i headers, LSk Inspector 47 77 B Raw #E4%. R4
i Raw Headers i (1, 0] LL{YAF 5 (1Y) header 4.

ek, ik nf LU i g4 Inspector BT AN, HIEMEM Request 5 Status Line 14
. EHHA A AR 1) header, WL, $i F2 @l A7 Enter, Header Editor i 1
B, BEEINE T Header, 1% Insert B < HHBLE ) header, Jf H&h#T T Header Editor.

PRnT ELTEXS iR HESh SUHOHT header ¥ BR-(E0, o0& £ di 8 11 F /7 (1) Header Templates %
., AHE ) header TIEFE R FR-(HX, Wl 5-7 Fras.

Request Hoaders
IGET /he/ 72961245/ Pvistor=4 86035520530 Mrmseasorkey =45 7571 501263307469 Aate= 72361 2458cmd T ag

Bl -Modfes snce
v | IF- Mone-Match
' | Expires (distant)
Cache-Conirol [no-cache]
Cache-Control [one day)
Last-Modified
P 5-7
5.6 HEXVIEW
£ 2] 1 o e e
fo Vi 8 it
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5.6 HEXVIEW

HexView Inspector 3 £ {E |73 HE 4R HE ] 15 35 15 K HIWI R (1] header I body. 34 82
CabbER, EThAERA .

# Inspector {5 HexEdit FEHIE:, =145 BAMEFIHERE A, 2045
BIF LA AN A, P PR S AR B B e ALl Ascn oA
Tl v . W HexView A0 ¥ A 7R header, W5 RUEAN, wipid i
. R AH AR,

Inspector [ P RARER:, AF A, 3Dl i 20 b bsde 7P
HIREE, A RERR- SRR MR R U, 28 Inspector 5 % o< header 745, 9 ubrit
A body #i4HHE W, S AHEMEEERS 0.

R fEE R s T A AN E, o (i) R R AR MR P G R

A MBS AT M ATBEEC: Read only. Overwrite 5§ Insert. & F Session A9 45757
Ahel iy oS Ab F A EUE AR, ) Inspector #i4 4T Read only #is. 7r &= T,
$4 F Insert 8, 0] LLYEE S F4E A H (R F 15 2 ) b .

HexView Inspector 11 I 3 3¢ i 2 ¥y 3 5-3 P AL

F5-3 Hex\iew

Insert File Here... £ Edit Ba0F . #8200 b WA P PR A .

PR TEHE, ERORER A SRR R RS G A T G e o R
IR . R AR AR A T L RS TR AS T .

P RS HTTP W45 () Chunked Sfddk, i#shiesiR 1A, 8% 615k
A R 7 R B R AR .

Save Selected Bytes... | & — Pl F WM, ERHER S 0T W RSB .

HFHE B B E .

Goto Offset... i M+ Bl AT LU S A T s e T R A A P R T A
Mts. mA R bR BN TN, ERWRRAS TR,

af LA SRR H AR A . SRR S SRR AT T . R F3 8,
{F S UL G 5 ] ELSRSE ) F % .

I EREN TR (PSS UTF-S FRIAEED. WS04 b5
FEMO W TFIG . & F F3 8, fERERRRIUAD i5 o] LAk s ) F .

Select Bytes...

Find Bytes...

Find String. ..
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% 53 Inspectors

%
SR HE N Tl 7 SR header 79 . MR AR EEAHE, M4 RR body
T
Show Headers
e 78 MATRARNY Fiddler . % HexView Inspector &b Edit BUUH, %k W&
FEhBUED, B2 A % header.
_ IR T R AT 0 Zik HexView HEIET AT/ AL FE 7 8
Set Bytes per Line...

(T A A

5.7 IMAGEVIEW

XK M4
feiFimii i

ImageView Inspector 3§ LA H 2 S s ma B 9 4 %8 i Inspector BESCHFH WY Web
Frigat, 6058 JPEG. PNG. GIF, tH30F 2040 Wik, teiniies. R . 48 . EMF/WMF
F1TIFF B2l i% Inspector A 3FF SVG M: WAtecde 7 1E9 ol H MR A, wliflid WebView
Inspector 146 SVG K& ma .

v A 0 65, T R s R M AE P B A R, BRI (LI EGERR) RER
SPEABCC R . ER AR — A T AR, o Rl dl S A 48 i -

e Noscaling: P LLEGS OB,

® Autoshrink: a4/ F E 2o B A B AR

e Scaleto fit: & 8B HIERN FEE, BOCE@GE D, HhERBOC

fE3X A Inspector [ b P 3CsE s, A Ll LAy P O oS PRy BTG, S0l A 2wt il
J A Ry, P B R A B Windows L. EMEHME T kT, ESES
DataURI i:f78 l. DataURI At —Fh3rAcks s, wTLLA #| HTML siFeaCrp, fEF—Amm
WigE (IE8+) w3, MEESH URI (M CHEEIH 32kb, Fiddler &3 HE SR, 15 IE8 A~
FHEFICT 32kb (9 URI, 7575 TE9 5R 5 H7 A6 A () ol YE 8%l te e B o SREAL P i 0 Je — I T 3
P B, GEN R, JEEAEREEEHME T, R AR A At HBE .

i i B R S E N BB R E b B R ST e E. ek
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2.8

JSON

HWHEP, fEF%k s-4 hig.

F 54 ERNEIHEE
g o WLk N Ihitg
Enter % Z 7 4= B F sz By kb 2 R
H AT RS B 1R
v T e e
R 1 e 4 M T RS 90 HiE
Blbs | +RETR
MiETFi# e KRR
Escape B ER
Jo T WA b R RS R, o] LR R4 Gallery View.
5.8 JSON
i) (G210
iR #

JSON Inspector 241 7 {335 = sl m 1 (4 i B¢ 1 JSON  (JavaScript Object Notation ) #%3€
MIFfTe, DU EME SR JSON X&YW, R Rkalim a2 ISON i, RIEES
R4, FKE L Inspector ANEl, JSON Inspector 0J LLE B 8HE,  C0 40 a7ty s sl 1 /22 1 45 s
A BER] T HTTP Chunked %fth: 454 7 B0 i o 0 o o dildis % .

% Content-Type #i5E /2 ISON RY®I R SEER FJFASJE ISON #20. Mk, E11/2E JSONP,
£ HL~ R BOR AL 1Y JavaScript SCRF, B30 — S8 ISON K575 H . JSON Inspector
fESS AL FRIR £ 2 KUAY ISONP, B4 ZMMMmEEM, MgEmMESGS. HE, f
e JISONP Hr A IEHf. HmSFE AT 515 JSON Inspector JG i b BRI Bk 3L,

AT A .

| F S S R ANE ST Copy I RSP 4 SR8k (EidE F CTRLAC);
Send to TextWizard H T4 o ()Y o 78 22420328 B TextWizard & 11, 3 FCREAT SR 65 FO 265 b 20
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# 5% Inspectors

UL Expand ANl fiz ¥l 2 e FF B0 BT 4545 83, 1l Collapse 2 # £ [P AF# W . L4
FARER Y b T 2000, JSON #& AR, WFREGET IS, o F ook,
I i% F-2h g T

59 RAW
xy | ik
s Vit ji

Raw Inspector =& £ 71 & 5C ¥ R Hma iy, (048 S0 Ak ) header #1 body . “raw( JR#5 )"
KA S ARG, 0 Fiddler 3 6 35 R0 W W 09 = W AT T REHT: WG B A A SRR
AFERY “raw” FLPEE, 0 LU S0 LR R T H, 4 Microsoft Network Monitor  (NetMon)
a¥, Wireshark .

1% Inspector ()48 A3 POSEAE — A~ A0SR, BRI A S header Hl body 15 B,
M A header. T EFRICEIRA M META SBERIC. 78 AKX T CTRLAG
et AR B BRI S - A di SRR, FN I LR S rp ROt T RRRER T,
CRUEIT R RGNS BETR. E bR SRR RN M MR, wf LAFE S ik b i SR R E
TextWizard T H. FPEd i EiE, —A 0 FEmUR S R H AT (Word Wrap),
A HFEERE S Bshalil (AutoTruncate) IhiE.

Inspector A REAFRIBE, ExXFr e HMIhEE. &%k, BEEIREP A ELAR
A, BEUCEES IS, AEFFEMFREL. B FEFEEDR @R EEmE sk er BLiks
AP KA LB A F IR RN 10, SR S s SR LA, o S R 8 DO o,
e S Bon iR, B HRIBILRD, EES B M. T Enter 58E F3 AT ELBE
B F—AVCElTE. $% F CTRL+Enter 8% &40 o B4 UG P %

View in Notepad %1240 SCAC N B0 AT Bl o 300, IRTHF CARB B TA UF. Ok
i 5 3% R TP ) fiddler.config path.texteditor Tl 8K DA 1 A & 4 B 47 10 S AR Y
(notepad.exe ).

Inspector = Unicode % (@) FHEFTHH null 757, Hik, X Inspector th o] LA
—HEwRm s N A, BIE HexView EiG M TIEAMES. BT CAHED o km) — it filks s
(1) body 5 2 & I CPU R WIAI AL, BTLLIXA Inspector #EACH HOMN KN #ETT B 2
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5.10 SYNTAXVIEW

. R TR (R B Content-Type BLE LL T DY/ 3E 55045 1) «
* fiddler.inspectors.request.raw.truncatebinaryat
e fiddler.inspectors.request.raw.truncatetextat
* fiddler.inspectors.response.raw.truncatebinaryat

s fiddler.inspectors.response.raw.truncatetextat

BRUNEBL T, it HIIE A 0 Content-Types 6 128 4~ 44 kb A7, S A 3411 Content-Types
{ 262144 T AL . LI | F S0 6 AR .

5.10 SYNTAXVIEW

g i 2 e 7
seFh 2

SyntaxView Inspector =L ¥FHLEE 21~ 80000 & 58 B os T PR RUP i R A R iR ic 4. ik
HTML. XML. CSS il JavaScript I, XA~ ShHERIERH AIMY. Inspector illid Content-Type
3he 31 T 197 127 {7 PR ORGSR L)

SyntaxView Inspector /& Fiddler "' #i #7 H[f) Inspectors 2 —, {HEBTFERKT, Hik,
AEEESRNG AP, Fiddler 4ar ) efl A2y 750KB, W47 Syntax Highlighting
i, AT 8 5. b T #0% Fiddler F 5 1 {55, SyntaxView ¥ 5 E i F 4L,
Fasbal % hitp//fiddler2.com/r/?SYNTAXVIEWINSTALL, [ 5-8 fifx.

T =TT T e | r = R ey

3 1 —

7| = DOCTYPE hemd FURLIC =-/ W3/ /BTD MHTME |0 Trsnsicvional/ MW" "hoop /e wld  acg TR =
{7 | =hewll/OTD/ xheel L -traneicionsl  dpd™s E
1| theal dir~"itr"” Lang="sn"™ aml; lanz="sn"™ amins="Http /e . el cog/ 1l fhtml™ amlng (="
(¥ | wcn:schesss mdcrosodicon-mecom=hi e
i | ibaad-ctitlas
L Micrceait Corporetion: Scftwacs, Smartphoces, Omiine, Gamse, Cloud Computing, IT
(" |Susisess Dechosliogy, Dewnlosds
-!-’-hu.:l- =N -k -t bl conlans == IB=18% fr-iamia HbUpegulr="Centemt -
P Type™ contente et /Bl charsereeLl -8 JrTmets BLpe-sge s v E- - TES- Tesn LapoucMenr i oe™
o FARIEnESS gAP-vETTLERl" F
T | sanripe Type=TTaEt) ] sVeseripsT
Bvar QoelnicTims = inew Dacad) . gecTimed);
lver QoalosdTims = "7
i0| var QoaPagellri = ancodelTRIiwindow. locetaani
11 | vmr gonaBsssfsc = wind location. g oml w e mid oo/ trane_pivel  aspefroutes
| S4SERcEzl=SCikica=" + |inew Date!}).getTimmscneOffsst il / @3] + “ecovsbigoe.uri=' #
| EmePagelca; -
S =
S 5



% S Inspectors

{t Inspector 7 RDHIEE, ERETIILAIENEBMINEE. F PB4 CE, B85
TR TR MR TN QuickFind HE, ‘ESCFFNMERE. T REAEHE,
ERO T @A AP ” ThEE. ERIBEMSMNE A, BIR Inspector iR H
T e i e

QuickFind HESFy IEWIFeih A, MBS S gl LArst REGEX: 758, #1408
oo BEARRE R IE W Rk A

B T BRAERS B, ST, RIS LG R IEETT 7 de4r, SyntaxView f) Context
F Rt gt T % 5-5 FranThfe:

#55 SyntaxView B9Th &

Send to TextWizard | 40925 i ob i 00 A< B2 1885 TextWizard B 01 LLHETT 85 B0 AR 6D

Flbl XML UM SOR. D SRR ALY, SO USSR Y XML B T P O 307 L
Format XML fh. BME Inspector JE 7k HABHGUT, SRR LT R, BB ESEBETA
s HAER Rtk T e

22l EL JavaScriptJSON B ZURR BT 0B, SCACS EURHER JavaScripe i i Re L s .
Format ScriptJSON | BHE Inspector JE{E S EHIAUT, SO R T, ERAATESRBET A4 50

FH 8 s AR D fE
Find... {97 “fr PR oEHE, B0 T IR S A k.
Word Wrap G HE W LA AR 5 sl AT

Editor Options... TH A% T 0 2 e SR o T T .

5.11 TEXTVIEW

bl 1 =f & e 7
hivias -t B

TextView Inspector 3 £ LL A TE AL i R R R fE . TextView Inspector & 7EH —
T ARRNT, EAES T s TR N .

Inspector (1B KHCAR L, oo REmp R m e, HAMM7FELE
if header. 7 1iFFbR BT A META #5010 /5 R . 7ECAK ST CTRLAG &, o]
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5.12 TRANSFORMER

LR s B3R e AT 5. A, Sl e, ROtERRER “RE) T, 8T <R,
W™ Thfg. Sesh, ML T N E S BT AR R SR HE. 200 R PO T AT L
M) AR IR B TextWizard T H A (f1Thit.

Inspector (M F AR~ JE42, fR4OET —te b s QRThAE. & Pt st T bbs ni e
TERATAF] (LA Line:Column B0 S5 ). M 8 LU/ % (Offset/Total) 134 i a4 i
FEEA TP A MR . 3 =~ THE S s 2 2 ik b () 5T B

Fm iU ae, SCRTEM SRR rA, R AR N ERURR, A SR T ik
e ¥ FHENEPFIF Falm FAF LT LI AR E S CHAEL T {0 e b il
R, AR S, B HATICR, R R TUCE S, MEHES Bkt i
R H VLA, WEERRNOM, £ F Enter 8% F3 o] DUBEHE] F— UL/, & F
CTRL+Enter B <552 W Br g g VE AL .

View in Notepad $&H £ 1% 300 A4 B0 A7 UG I SO Pk b, 710 S0 A2 485 38 v 4T iAo 4.
A G AE AL fiddler.config.path.texteditor $F 6, MILSE L A (notepad.exe).

R AMR. L, SR AT B SO, R Windows [F) Open With
AEHE, Mopik RN A X A

5.12 TRANSFORMER

ey W
oV et 8

5.12.1 MR B 4wA3 AT — L5 | AR

HTTP R0 Ay 52 ST 16 2wl AR e P fiE o ed g 3

® Jk#%i (Compression) ¥k (41 DEFLATE) aJCLNH - HTTP #htr, fESE RS 7E M4
I B i 7 3. SCAE Y Content-Types, Il HTML. Script £l CSS, H:ifi #
A LLk #| 80%.

o SrHu{tHigiiY ( Chunked Transfer-Encoding ) 3235754450 body [ A5 LL 4G 1 F body
B . — T 7. body 11468 JE4E ) Content-Length Sk 22161, (B2 UL 5T body
P/ BB TR I R A7, I EEY body M PR 7L 10 P o ifg sl B A e 4
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® 5% Inspectors

ROt L T A B TR it

AE AT S B it IR 5 AR [ e A A AN R A E s, 26751%3% Connection:
close 3k, “qWRCES R OCHIERL . IXFPHLIE S HTTP ) Keep-Alive HLELR #9EM, 2xiEmitE
[ R 3= 0] i3 1 TR

S B LB IR 3l e A A R A B R D S R L A BN e
AR BRI AR E P ICRE R U, o I, IRB BRI e, PR P iue
2y el 1 g 48]«

HTTP/1.1 200 OK
Content-Type: text/plain
Transfer-Encoding: chunked

2b

This is a response which has been delivered
21

using HTTP Chunked encoding. To r

ig

educe overhead, the chunks should be larger than those in
Oe

this exampl

18

e; 2kb is a common size.

0

5.12.2 {#H Transformer & s Mifs 4mE3 5 =

Hi L1 T body N A1 5 2 . Transformer Inspector 32 ¥ [l w15 cb 3% Jm =l M R o
BB+ HTTP M%i%. 7F Transformer MR L AFIIM T

[Tramfomer | Headers = Textwew |

body “jHTfIA s FES MBI ERERaSET, w] LR R B, Emty Siee: 11,437 byves.
% 5-9 frae. ] Counked Transfer-Encodeng
HTTP Comprespion
Chunked Transfer-Encoding %2 i HE M ma 1% ob 5 Jon sl ) B @ o Compression
Chunked Transfer-Encoding. 5k 1 SL AL o] LA FH o S ki b
MEEamtY, MG EsNEEM P Transfer-Encoding #! Content-Length (.3 By

WM k. HRAEE, 2KAIESERE T I HTTP 4§k
fE. WO A, HRnammlER s i, MG HTTP
P46 5 3K

HTTP Compression % SUHE 2 () 8 22 ] & RF A body 3E4T He 45 sl i He 4 -

M 5-9
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53.12  TRANSFORMER

* No compression: body J& 4 A1) .

e GZIP: body (F/ GZIP J5 A 4. iZ8m0% A A8 100t & DEFLATE, {HJ& 36k
AR A

® DEFLATE: Body /2iliid DEFLATE (RFC1951) SikMRE4iM.

*  BZIP2:body Jtifi it BZIP2 BLid FE 47 (. BZIP2 735 () 1k 4 %2 i % LY GZIP 8% DEFLATE
B, (U ALHTFEN CPU MWMIE £ . HAT{# Google [¥) Chrome | i #% 3 FfiZhs £,
1] At = A R O A R S AR A S KF . Fiddler SIS R B N T b7 HEL,
LR FH 10, 2 S £ 38 3 A AR U 0 i SR R s U P AR BB AT R .

% T L LR AT LA body B FH SRR R4~ STEL, FRin . BB B2 Content-Encoding
I UL K U ¥ Content-Length k.

B A Inspector, BJLLT @B 5 HTTP Hodi 505 H B body P9 28 n
MFREBEOCARLER, EY KL S8 body KM 80%. RIKEHM Inspector A,
Transformer Inspector % ¥F 452 ReadOnly (SEREH) WRE, A S GTMSIE. BT Y
fig, wf LAy (0 Ha A ER Session M4, LIEHS.

40, Transformer Inspector H &M T-4bBEmg R . {R/-2 iS4 HTTP 869, M B A
L YR e R S 48 A S I Y .

5.12.3 MR EbAR

{524 & % ¥ Fiddler Inspectors JCikIER A Bt ) 7, ik b RIS Session

I, 1F Inspector $1|3ef) B4 & HBL— 0. sl avdX A He il 2 DA R sl 1% b i e e
Igaes, W 5-10 Fros.

L Osmwme | Biepedws [ f whemponter [ Composer |

Renuest s encoded and may need to be decoded before inspedtion, Click here to transform, ||
!m|lm|sm WebForms | HexWiew | Auth | Cookies | Raw | |
| moM | e i
[ |
B Htspnm.u;ls encoded and may need to be dcmdtdbﬂherrd:ncﬂﬂh.ad.hﬂeluh_.ﬁr_u:"]

Transformer | Headers | [Textiiew | Swimwview | ImageView | Hewdiew | Webbew |
|

Auth | Caching | Cockics | Rew | 30N | oo |

K

M 5-10
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% 5% Inspectors

Al L A7 i Web Session #1424 1) Session, M |- F S3E 5 b % ¥ Decode Selected Sessions,
a] L[] i A il R R S AP B gD . [FIRE, 3 T BB ) Decode X101 £ 5 5h iR BT 47 4
i, Bk Fiddler 2 W% 7 B U R, MR 95 48 13 U 1%

5.13 WEBFORMS

¥R ik
e P

WebForms Request Inspector 2 77 K I 25 ) = #F sh Bk i, & F 255 HTML #
RO HHE A F . W R R HTML f=UM EEE, S0 b iT s, 76 PR LI oh S 2 B/ fEx] .
witn, LLFigK:

POST /sandbox/FileForm.asp?Query=1 HTTP/1.1

Content-Type: application/x-www—form-urlencoded

Host: www.fiddlerZ.com
Content=Length: 54

2=pata%3el23sfileentry2=a%Zetxté_charset =windows-1252
& WasinfE 5-11 s %

Headers | TextView | Syntaxview |[webForms | HexView | Auth |

B s-11

1% Inspector f3 FH A 2 #1910 f¥) Web #% 2057 44 F ] application/x-www-form- urlencoded
e % . 55 multipart/form-data K=, 0 R TI0MF b, 76 Bonshfech el 2
B, Bt B4E, REAE T HexView Inspector.
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5.14 WEBVIEW

5.14 WEBVIEW

Gyl i i
fEFNAR A

WebView Response Inspector 3255 TE 8T Web 0l 55 #5452 0 4% 10 (1w 192, 50T LA e 4 5 5E 4
i L W P 30 BT R R ] SR . Wb 0 T - o % B R A 1 24 o O BEL o b G T A
M G L Web Session VIREBGTE —RE— X EWE KZHWER . ES S A4 80
ENEEP, A, WML WARSAL A HTML SO S R T

& T 4l XHTML 1 HTML, #f | IE8 Sl HiIMA, WebView Inspector ib ] LLiE §4— it
Hfhp AR . T IES, Inspector ] EUEHBEATH /b 1~ 24KB (11 i HIBH (png. jpe.
gif % ). A7 A0 R PR I A2 % Inspector 4§ 1] Data URI J&E 5404 ), if 1ER [ Data URI &
BEBRGE 32KB, #1125 T 24KB () —dEHE .

¥ IE9, 1% Inspector o] BLEL il 1.5GB A/ A . et 2wl BLE R SVG 0,
SHFh WOFF. TTF #l EOT F430fF. MP3 @800, h264 U80S ¢F 4 el s ol i . 454~
@, fr8 WOFF C{Fnt Boctn B 5-12 s & F

[webview = Auth | Caching | Cookes | Raw oL EOM | FareYiew

WOFF Font Praview

i
ARCDEVC HL LN MO POIEST L WY
T e R T I T 4 TR i
The gk briere fin pums, ever ithe lay dud
AR T e P 2 S : .
abecdefghii !;1 |
CITISETEN SRR i), [ [ (= [ i

|

Thee quach brown foo jumps over the by dog

| abcdetghijkimnopgrstunnwingez |
ABCDEFGHUKLAMMOPORSTLVAWKYT |
|| 01234 56789 D# 8% &= (), ./ [Tuee? [ —=_+
| The quick brown fox jumps over the lazy dog
|

abcdefghijklmnopgrstuvwiyz
ABCDEFGHUKLMNOPOQRSTUVWIY L
01234567891 @#S%A&*().. [\ {}-=_+
The quick brown fox jumps over the lazy dog

L e ik el B s b oA S i : |

B 5-12
204 4 35 B PR, FERE R g B A ¢ AutoPlay " HIEHE. ik
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# 5% Inspectors

“AutoPlay” DhRERS, = EATAHENES & Qs GEEE. mREHEP LG, BEHC
HEMBE AL, DA A GEG, A ST nRE.

5.15 XML
®n iR &
SVt &

XML Inspector £ 455% 47 437 SROAIW W AR R FE R XML X708, s XML SOR
SMRERE. R body AR GEM XML B, WEESZSEMN.

B~ XML JCEMIR UM TE P — 9 s, JoEE M e e E 2R E LUT 15 e
AFR.

FAFCAEr) Inspector AN[R], B 4 3 o i mey 1 J2 e 48 BRI H] T HTTP Chunked Encoding.,
XML Inspector {388 AT LAM SLEGR TR Bor, B AEN AT EBIR&E.

WIEANEN L FXREAEMNET: Copy H FiEk iy A 8 62 875t (sl F
CTRL+C i ); Send to TextWizard F T #03% 47 k3 9 9 B 255 B Textwizard B L1317 % b9 al
ARG .

sailif 77 ) Expand All #4410 ] LARE FF88 TE BRI BT A 15 s 1T 407 Collapse 4 01| =] LA
W E BT Y A R XML BRLE A s 8D 1 2000 S AShESF: d1THERREA,
RO, WASEEMRIT, REFsRIT.
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20«
b hé

6.1 HE%E

Fiddler #2{% T F B @04 B, JF% A 53] DU oo 3 25 il 98 45 b 4 3 (0 36 o 349 6t
Fiddler fFIZhHE .

6.1.1 RMITHE=ZF¥E

M FEEMNCSHWETHRE Fiddler ¥ i, FlXAHbEbh ¥ H T8> RE:
http://getfiddler.com/addons. B SA Nk, CE8F T —HERRITHRE =T E, X
¥ REAT U IR 8 T Fiddler 7E4F Web RV FI 4T 1 il 30 R0 22 4 W38 o o Th g .

TEREY FELEH

Fiddler A< 5 D£8R LIR £ M APERE S W AEALIhBE, #R1f0, § FES: Fiddler 42k T Waa
K.

e neXpert YEREHL M A A 38— € M RO ZE 8 AR 5 0B BA O R A — 358 B, neXpent %
FFHEREIL I, ATRART Web 35 i AT VA 4 R 2, S0 tH il 45 U v T
Vral il i,

o StresStimulus—3Z 3% 68 G2 H MIAT RE SR A Web 3 5 &SR B8 L #4000 3
W R Y — e, (X N RE AT LAVEAS — AP 5 ] L B A 3 R
&mmﬁ'ﬁ 'L!Fﬂ.rﬁﬁ- ﬁﬁﬂmu

R REY

Fiddler 7 ¥F{R £ fh Ml PIE8 441 SO R T S k() 24 0 i A e 40 1,

0] LA 3% B 8 F A B0 - P g 4 ] L.
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Fow R

e Watcher— ] Casaba Security B\ 7% . Watcher J&—# “Weah it 27, Ealblli
W ST AR AE B, % T RS R RN, bRid ISR A
%% (security penetration) MRFEA Sl 12 1 H eV EAS b oah . el A2 FRRseE.

® x5s—Casaba Security FBAJF 509 % — 411, xSs o] LLIEAS M b, AT
FFAE ARG 1 ] B S TR B AR . el A R

* intruder2] —— A1 3L 0 Web B0 T BOBI I 2 fuzz-testing ) . 1 5E T Fiddler
B HAnil R G, S RS i gk, Jheh o e ah iz e ik . dFar R
G AE .

o Ammonite— %41 FF BT A WIS ETE, 25 SQLiEAN. BEREHSHEN. B
Wi AIETT. XPEHEAE (Ale inclusion) BABREEMPEHEIH . WA RidH.

6.1.2 WO R

AR E ST HrHEA TR R HO Y R, X R E ) LL e 2R M
http://getfiddler.com/addons % %% F 4.

g Xt X £ 8 Fiddler FI /7 #H 1, 1€ Fiddler ¥ P RHRITEMNEERAT
W RS b . LA R B A B A N W B FE R, Ak P i e R i
e Th T LB G Fiddler L4 0k [ B0 T Fiddler (95§ 2 £ B8 AL 6 05K,
A LR A FE A D oK .

Frd R A ARSI A, A YR Fiddler i 2 A SRR A ROTEIELE A2
EHH.

6.2 JAVASCRIPT FORMATTER

%4 T JavaScript Formatter jo, °] ELA i fEE 4% JavaScript %% ] Session, i Make
JavaScript Pretty. % &£ H kUL JavaScript, MR CH S IL ol i, 45 SRR e i
ff JavaScript B H M. 34017, 1T 6-1 X {T JavaScript {45:

L| #* Copyright {Ci i017 Micrasoft Corporacion =/ (funcciom() {ver b-sdndes. w=
o |h JQumry, Feb Dabiog, geb wlives|Coze (|, Contrsls: ||| a<h iCanfig s
fic) handlsrBaseUrl-s handlerBassUzl! | "";1fin. =d) |var d~document domain, s=d
[ splin [*. ") & sd=g lengehe==17"":"_"+c|c. lesgeh-2 |+~ _com® | & mkt=a sk |~
@ na¥;a prop=s propl | "ETif (eypead window TymlsaliinDpes ' =sTundsfined”
[ wirmdow ooen-window SveleslHieloen i (funorions ) {var a-wvimdow, s~u

¥ 6-1
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6.3 GALLERY

i AL i Tk S B AU B 6-2 BT s

| /% Copyrighe IC) 2012 Microsoft Cozporation */

2| ifunctioni)
3 var b = window, & = b.jQuery, £ = b.Debug, g = b.ulive = |

d Corm: |, Comcrolis i

a = b_%Config:

& handlerBaselUsl = a handlerbaseUzl |
b if (e =d) {

a

3 var d = document domain, o = d aplic|™.").

LG a.sd = c.lengch === 1 7 "% - " " 4 ofc.length - 2} 4 ".com®
13 a.mkt = a.mkt “na”;

13 A pEap = a.pfop || "K";

14 if (cypecf window SymRealWinOpen |=— “undefined™)

15 window open - window SymBealWinOpen

¥ -2

0 A AR A T £ sl Ak, i Fiddler 1) Rules 32 #eb () Make JavaScript Pretty
SR aT, B3 JavaScript RS UILRTE ARG RPIATHY, BrLA%E P i H 2 f B Ak n
ik, SR IEAE A S R AR A A A T R, XA shEsE 1R A

i LLifi it X-Format-JS session #5ick, T-ah$2 6] JavaScript Ry aU AR 02 75 X o B2k 1T 4%
k. MR APCHUE D 0, &4 R4 fF K A 22 0d ool b AR TR 4k, ENETE Rules 3L
% T Make JavaScript Pretty 350, #5i%bsic W R0 AT o] 6 408 2 00w 5 A fllcke U4k, B
{#7E Rules 4P BT ® Make JavaScript Pretty ZE T .

JavaScript Formatter 4" i Fl b /b $m 1A e, nf i sy 1, ik sUIL R PR S0 04T
FEF R ST ol e 2 tH BRI A o] . — 0 7 3o op 75 W] JavaScript MIME 28981, {H4 590
FHARILIEN JavaScript (H1—4% Google @) R UWMBAEH CHERHIRN) JavaScript
HEATThE, ML RS e . ST A AR AT RN Rl R AL A R AT,
JavaScript 51 %4 HahiE# I F —47. JavaScript Formatter #8785 ok il nlizohfe, i
I A XA AT AT A

6.3 GALLERY

Gallery # JB44EH T S nikeh Session T ARTA B . o F 40 85 3RO Y P s B ek
BT 5L T35 7t B F tha ik b B4~ Session, ZThiERLAER A .

EIhAE A LRI, SondakmEid 1y, i e-3 Fras.
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Bek TR
| Bcdey |

[ 150 %* px thumbs for images > (KB):| 18 [ [@ Stretch images in Fullscresn mode Filter sessions Help

B 6-3
PO T, S AR 150150 R E M gaRs B, o BT 10kb BB F a8 Emng . 1
i BEEE Filter sessions, =ik 88 5= 5 1 Session, A EH i B ek E g0
PO R 1 Session. o1 EEEE Help & W 0K, B EMIThEE.

R bR P | 2285 H s 00 Session ID. URL. B R A0Uh LR kel Wik 6-4
B,

Session &5
spaceflight.nasa.gov/gallery/images/shuttle/sts-101 /hires/[sc2000e10522.jpg
301 4x2000px [imagejpeg]

 6-4

ohrg e P 2 M Gallery PLEE RN IER # s B - A s P < M Gallery )4t
Hi 3k, {8 H Inspector £ 45 1% 1 P 1 BT 7E(K) Session . 0 290 A il sE A i i 42 41 Shift §#, Inspectors
STERH S O P IF.

=HFME
Ak B 2t AR, B AR Session 147% Comment, S HF
J7 AbR R 28 B iziFie .
{EA R EEEUE, B LA R B i Bl kb il -
o i el T Escape 8] LUE H BB,
o WAMTF B, Zedk, TN, Bamiik, 264 Page Down . HE[RIHET
sk K, Aidi. ¥ Shifi+Spacebar 8, 4% ) Ao (f1Hi Sk 3l 5 Page Up 8.

o YT Z 8. Enter el FbRES)EE T LIDM AR R (IR RUY b RIS
@RS, R R LUl R b B, i B R OB RST . I RUBRRT LS 8
.

o T 1~9 ZMEERECFE, wLEET Bt A s f . BerRon il
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6.4 CONTENT BLOCKER

dRE ATiE R R . & 0 SR B A a4 i E B R M)
AEgifrie ok, LAY Fiddler £F 0 — LA M s L.

o  Fiddler 35 & FPiE, oI LUK S 9 Ron . 5 H 8ol LKT 8B B s
MPE -, $ v BROTCATR TR M. # R BT LA S B RERE 90° , Hk 1 Al
CLUI B b B . $ S BT DLIEE Rl R, B G BaFE kKA. o
a] LU P H et e i (2 [ D). 5 E ST LR B A 0 JEa R B K (5 i
BetEiRte, T XE AR ERE AN E . U B HGE R E R R RTE Es.

®  {i Delete 2 M Gallery B )y, JF8EE F—9kBE R .

6.4 CONTENT BLOCKER

Content Blocker ( 97240 3%) & i 410FaT LA % 553 [0] HTTP/404 Wa R, A 428 M

FEPIEN M. e UURRBIR R A R e
#2558 TES LA UT 7 A P 3 405 (8 o) R EE (R 4P Th BB L2 AR Web Ij ‘"'“':' =
M RFIAT A . ? ;dwum,

ALY, e Fiddler MG F&T, H4EDLLEN | AwesBlodfsh

¥ Block X-Domain Flash

#| H F\Program Files\Fiddler2\Scripts JUAFJHT. SR | protimio o0 sesons
Ji. TE Fiddler i 3 fiep £ H—4 ContentBlock i/, Eide Blocked Sessions !
I 6-5 Fras. H 6-5

ContentBlock &8I T 42 6-1 Brocity JLA~ i S 1l .

% B-1 ContentBlock L&
Enabled gy, Spstiidk. A, ST T
Block Paths mAtiE G, URI P8 4 -G/ad Ml R a2k

Edit Blocked Hosts

silEIER, SWTF T80, TlESea s, mfixpEst
PLO R M. B SAR eRE R R, ERLZ W R e

Always Block Flash

b, BiA 0 Nash Mo =4k, Ak HWER

Block X-Domain Flash

TR, T BT R O L R RS fash. I GUELYE Referer
bl
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Few K&

ek
HpE, §ESAEIR Web Sessions FIREEATARNT, Pl 1% () session
R A 400. Fiddle T JLE: i) “keeponly”™ T Hr3Ea itz 5k il

AutoTrim to 400 sessions

Hide Blocked Sessions Bebnd, W H0 session S EEEGE, AT Web Sessions ¥l B

417 Web Session #1221 51 Session, #AJ57E I T 3 % h ik Block this Host, n[ LL{
i 43X 4 session [ EHL Chost) dEinEIFE 48 s der .

A sy e AR T S i o] 4 I Fiddler § B (Fiddler Farh e HERM), ik
‘LA T BESE Fiddler SCAh &L (142 4R A oh il b o 28240,

6.5 TRAFFIC DIFFER

Traffic Differ §" REAL| n] AR LE Rl 2R 00 P £ i A 2 b XA Zhignl REMR AT . Ehi
fAE5 PRI SAZ SCHHBE T B, iy FES 4 SAZ XfF R LI R .
a] 2L H Traffic Differ ML I00F, SRG SB35, 504k, fRi ] LA 2T (H Web
Session 1| £ Hu T & Session #| Session ¥4, JFELEIXEE Session.
B JFHERY Session #1| R £ B4 Session APIRAETD. URL. %R K]S 1L e i 1 44 fl
FAH, W 6-6 Fran,
O st [ B rpectors. [ dtchempnes | feamstpaider | ) Golery | 0 | 3] odesawr. |

I____I.Md saZFies.. | ..o Dvag and Drep Sexsions to the bowet bebow...

Request Count: 2 ] ' - - RequestCount 2

Bytes Send: 67 Brytes Seni: ]

Pubes Rarsnd: A 591 T Autes Berwaed: TR14 T
P 6-6

L Al AR 09 A [A] Session, FEREAFIFE P4 WL — 4 Session, G A
Compare Selected Session fHl. thmf<z3ahofFbeE TR, Teaeis R Fomg i 5k LU body
Sl
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6.6 FIDDLERSCRIPT %48 %

6.6 FIDDLERSCRIPT 45573

Syntax Highlighting CiEikmasE) ¥ R4 4245 Fiddler UL i FiddlerScript
I, 4T fiE A0l Bk L (Y 1 FHFE I Fiddler2 ScriptEditor. &ML —4> SyntaxView
Inspectors, L2 il () Inspector — 7t 4 31t .

6.6.1 FiddlerScript &L+

fi¥ith FiddlerSeript BEIF, v LAFL$EAE Fiddler Ul 42 b 1% 5 F1 905 FiddlerSeript AU .
TR ) o0 —5 Ul #h0, 2 W% 6-2.

*6-2 Ul =i
Save Script i8] | €8 RAT FEEA SO

R AP E T FiddlerSeript PR ik, fEFRFldehig 08, SEishi
Golo 1 5E () it

T e EEH “*FiddlerScript Reference™ 510, H§§1FF FiddlerSeript i SRR 7% Bh 001 .

MR ThAE: Wik “Gow” WAREAL, WARKCMST S Lt

Find... fE £ HE {ERIA P ST i A

ClassView Hedll | B al LUIT FF & 5 M) FiddlerSeript B ClassView fif#

IR T A TR R M S A A5, Kb o SRIT TR FiddlerSeript
WA XA T RSOOSR SIS R ThAR,  FESEA RS AT O LR T A
M. ERATTE Wk 67 k.

if [(oSession.

:M‘ [pubbc Hostnamels fs TestHost Stng)  Bociean|
5 67
FEAEME b — B g R, FRiMEdnTme, i 6-8 Fiox.

[-[1mport System;
Timpurt System. windows . Forms;
import Fiddler;

l' I've just tvped t : Ting]
 6-8
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e B
iRz G, FEESRTSE, mE 69 Fra.

[[import System:
| import System.windows.Forms;
| import Fiddler;

£ just Typed ti nel
69

A4 VR B AC I I B B ACHT U8, FiddlerScript X0 £ MU . HERE) BB AL .

6.6.2 ClassView 4=

{E ClassView ML E Pl LIF AN LN & . MERA . HE, ClassView A 5
Frfia] i zhfie, B BasiAdw K.

fEREE B g BT, MR T S 2 o i (5 B fERETI LB CTRL+C
B2 R VLB AT, Mo R A5 b A AR A B A, P 6-10 FoR.

s bem; =1 Flash Fiddier's taskbar ioon i Fiddler is notthe

[ import System. Windows. Forms; * | sctive window,
L import Fiddler; : |
[ 5 FderObject
// GLOBALTZATION MOTE: : " e
Fi Be sure to save this f1le with UTF-3 Encoding 1F wusing. o 5§ " |
ff in strings, stc. StahmText:Svslen. Srmg
Y1 3Seript Ret AN
) Crip et Erence
A Werp: g v, Fidd Y er 2. com/redie 7 id=mednisnet ] Mmm;fmm”
i alert{sMessage
ff Fiddlerseript Reference prompt{sMessage |
W L 3 ded ¥ 73 d=Fi el 1 o |
:: ttp:/ Fwew, F1ddlerZ. com/redir /7id=-Fiddlerscriptoookbook | proptisMessaos sDetaitviakue
ff FiddlerSeript Editor: [ prompt{shessape shefaultiahes s\Windo
£ hvtped faws. Fiddler? . com/redie/ 7 de® dd ] ersoriptadi tor | PaySound(sSourdname |
Eiclass Handlers | i 1o .m
4 6-10

R 04 P S 7 £ o LR 248 RO 8 1

il £, ok
e ik
{4 ) Rt
(s TR
e Hif
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6.6 FIDDLERSCRIPT %% &

6.6.3 Fiddler2 ScriptEditor

1t Fiddler ' fitli Rules > Customize Rules 3% F CTRL+R ##£: 47 H Fiddler2 ScriptEditor
FilF. 4 F Windows+R 0 LLIT Hf Windows /1] Run @ 01, fEH P& A fse2 W LLFT H Fiddler2
ScriptEditor F5.

ScriptEditor EHMALETH, MM HEERN FiddlerSeript I RAHR, Wl LR (i iz
fIEEH G Db, H FiddlerSeript iE 5 F A6 2 &b 7E 1. ScriptEditor &3 3Eiz 17N
BIF, EASHEMARER R, B Fiddler S 3 H 5 BA K B B, B4 R
i .

FIF Go SEmrpdt a4, ol LUyl S B3] FiddlerScript *PE B (¥ ik, HREENBHEEIT.

View F 0 JEEEIAER, o] LU AR Er X, BRREPERA D BaiTE.
JEFF R R k. B FUMRIIAE, LU RsREE M ClassView Explorer i1 .

Insert JE PR TR E BUCRIRLFA B, o LHER Ly B m BB Ach . BER X W
AR B, TLE R R R AR Iy BEAAUER AL, MRS m A SR T

AW, #%ERAE Handlers 25009 7 A 4E 5 B, i 6-11 Fras.
# |5 15 i Insert > Context Menu Item, W 6-12 s,

“‘t_” —
Tools Menu ltem

Rudes Menu Ophon

:{:'Iass Handlers Onflgauest 7
I OnResponge *

B 6-11 B e-12
% 2% <24 A ContextAction H#iiH:, 7F Web Session 9 1 F 323 8 rp s 7 19 38 5000,
e 6-13 Fyas.
n?'l-l:.!. Handlers

Create a mew 1Len on the Jort 14ck men T
bl1ic starfc ConuextACTion " &NTLTLED)
unction DOUNTITLED(DSesS5100s: F'IWT'IT-SE'S"D“I'I_'H
for (var x = 0 X < DSES51005. LengTh: Xr+}i
WO b dit P

b

M 6-13
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6.7 SAZCLIPBOARD

SAZClipboard A~ $L04 RE 414, & 0] LA SAZ TP 4k 20 3 Ay 46 8 10 3857, Session
P erb . fEWYREHL A B 1 R0 Fiddler 1/ 90 & 10 2 () 0T LUK HHEPUAT 35 session. 101 44
Composer 5f, AutoResponder F7#E, #IhAEME 5, Composer Hl AutoResponder # 3 f5414
Session LL{W M, Wi 6-14 Fas.

Method  Protocal Host
PUT http 27-3145/012805
T http 273145012805

| tondsme | [ smeste

F 6-14

LA ] SAZClipboard ", fiili Fiddler Tools 3 /.71 ) New SAZClipboard... .
n] LAHESY Web Session %1 £ %] SAZClipboard, & L F A i0EE ndk SAZ .

6.8 ANYWHERE

R SO A U AR AR S R M e A, (B hIX A ThfiE, JavaScript 0T LU SE IR 3L
R B . K o] WA A e iR A R, BEHUAL T BT WiFi A s e, RN %
PRAE PR Web BB, %R %20 B T 048 A LT I 0 P P A bR, AT GG M P R B
{27 . Web [ % HEAR bR PR [l on B A%, o0l U 2% 3R [nl&Y JavaScript.

Fiddler () AnyWHERE " & 0] L% Web [ %1% (3] 0 s B0 4 B 78, Ain “MR38 " i
8%, (ER UARIE) ) fr AR SR B AT . AnyWHERE § R 7 D SR8 AT &, 85X
M ASER BT 5 R R AR R, W 6-15 PR,
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6.8 ANYWHERE

. !Latitude. Longitude, Precision, Elevation

IE TestDrive

M 6-15

R 24 0 8 i M T 5 0 Weeb AR T2 HTTPS A55A0, B7 LB AE B F 00 1 3
TAE, 41k H HTTPS #E k. 41X F IE9+. FF4, Chrome 1 Opera, {H 2 i 5 il 52
SRR S AT TR AR AT Web MRS W, EHUHLASREIER T, #lm, £4% GPS
(] Windows 8 4% [Jz4T IE10 i, Windows £ {8 ] GPS 1y 4~/ Web 45 e M rg 4 7 .

Fiddler Fatturp824t T 4" B mdites.
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PRAF. SR B i

7.1 Session I} ARCHIVE ZIP (SAZ) XfF

Fiddler %%\ {8 77 k% 202 Session Archive Zip (SAZ) L. SAZ S0 5 4 ZIP R4
frdsisctr, AHlid Fiddler GESERRRRM A AR . HSAZ SO ar k. ZIP, (W] LS
Windows Explorer 5% WinZip #f7 SAZ fF, &£ M.

SAZ #RE Fiddler SCRFEIEIT “ 61" WX IS S F——¢ & Fiddler it 8
B~ Session 1) header fl body, LLEoc#ds (RESER. SitubnilblEatefE ). P SAZ
SO AT RN, RO R TEAE R L, U e A, SR S e
HI5 My, HTML. Script f1 CSS CfF g B EL R LF, FCRRSE#al % & 5. o[ L)L GB 1)
B L E T L) Session {RAF R SAZ S0, (HAEH FiX 4 K CpeE U4 ffl i, [
SEIE s A Fiddler a8 Thie, P LSS 2 SAZ SO Of A7 i 80 il 4T I

] BLE S5 W3 SAZ ST N4 ®) Fiddler, #0405 ) Session; X% Session £:ill
AR AT RESRETH . BEE - , Fiddler fEN4% SAZ L, AL {# ] Session
JRAT () Session ID: &k SAZ SCHFRE, $§-1> Session TRINCE] M 5% 5 M ID. 1E
FdiAt AJE5E SAZ SCPF2 01, (A Comments 4 HI 5 Edit > Mark S48, 0] RABR AT fof 8 2 i
i) Session, WA 7-1 ffas.

b S Fiddler 337 bnd% A0 1) Session, &4 F sl mAd % L Session ID (193¢,
g 7-2 P

7R

AutoResponder it 3 F 2 A SAZ L4, FHE 04690, Sk SAZ LM+ e s
Y o 46 4048 AL,
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7.1 Session #] ARCHIVE ZIP ( SAZ) 3 ff

Comments
[#1]
[=7]
[=3]
[#4]

B 7-2

fRi7 SAZ Xt

SAZ SCEFRLE FTAAHL R Web ¥, W Fiddler SR80, b Al HUEE R
(R 4. %4, cookie LLEWKSEE). Hith, RMECEEARASLLMILE SAZ 1.

IR SAZ I H BB G A A A S R A0 0 W B A0 A A i p R, mT AR
P FERE T I AT, BT LA e A . ECHLIX A, SEZEFR A9 Save Session Archive
AHEHE D 1) Save as type F e 1ikh Password-Protected SAZ ik 5, WP 7-3 Fiok.

@&} G| 5 « Foded » Capurs ]G | [ Sewcn Captam 3
Fibe pamse: | encrypied.sac ""]
Secasipe PuowondProtected SAZ (Fsad e o
&bt | e
i 7-3

el @R RS, T ERAER,. W 74 Frs.

i Enter the password (case-senative] that will be used to encrypt this
I password,

sesson archive fle. Leave blank for no

e |

4 7-4

i R R0 SAZ SCIFRAERT 128 St AES D@ ke T M@ R, AES 2R
e al, HTTPS MM MBUT. FINRAEA T . S, SO RE, W
EAT R BRI AR, AUl R R A VR . AR
M s T, s A T LT SAZ S0fF (AR 3R R .
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Preference fiddler.saz. AES. Use256Bit ] L4 % 1 true, il Fiddler {8 256 {if AES i 42
128 £f AES #t4Tn#. thah, E A CONFIGbUseAESForSAZ itk ol L Bl false, Ml
Fiddler {# i () PKZIP BUMA N o, @hnes fikdi i s, BRN ChWaeT .

7.2 FIDDLERCAP

SAZ O CEEHUE A TR A TR Web FoF ) SR AER A, MBI AEI, WP
Wweb FFR A RiR MR PC Bl SAZ 0. M THMENRTESEH, RElET
FiddlerCap. FiddlerCap ¥ R4 TR, H 73 FFAREAR S #HE SAZ 30, RS04k
A G AT BLil it Fiddler 81828 BEAT 4147 .

FiddlerCap 124 8 i) i S il At 2 1 it e T Web Hdigifi. # Fiddler & & A,
S, T ARSI, L Fiddler, wTLLUEGE FiddlerCap WSl %4
AT R AR B 7 42 () Web 3. FiddlerCap J&3E T FiddlerCore FEGIERNY, EAEH T
FiddlerCore fCEES: (5, 1 8889 Wif 11 FizdT, WILUAHEE Web $dE .

A LAk 7 i) B0 3t http:/fiddlercap.com %%¢ FiddlerCap, %04 sfid Sk (Mt fo] fif Y % 1 FL4l
i Web AR FAI W W HFE. BUARE F, %3 FiddlerCap B £ 7F MLl b AR Rl PR, AT
EEARNE. ARt LA AR, FiddlerCap CE&RIRME T HBESIE,
. EARE. HiE. WSS E AN .

SEREHE S, ST ASEHEHTH. WO SRR =185 fifE (Capture). FHHLEIN
( Capture Options) 1 T (Tools), WP 7-5 firas.

- ' FiddlerCap Web Recorder =<
: - E Wmmu .n.l:. e ..:-
[ 3 Sgwe Caphure | MustomaticaBy drscagd raffc after | Clear Captyre
(Il s b8l sompsnor |14
e
& 7-5



7.2 FIDDLERCAP

FiddlerCap & [147 F 77 sl o 1z 41 G068 i T30 8 0 EATS I8, W) S o 42 B 1 3
2 LMY Session F3. Session PN E LG, (B LIE DA Session, # F Delete S

7.2.1 Capture &

Capture T D SO SRl 42 BT o5 200 de A g BT 4E . BT Start Capture $281, HUGH
1 Web BdE . SERSATH BRSO, EH%0E, B FiddlerCap MM HER
5 AC B A P A R BB i A U MR 8E % . HLF Firefox () FiddlerHook
Xt ¥ FiddlerCap Al Hl. SR Firefox 05 B80T, 4T H31 %241 Tools > Options >
Advanced > Network > Connection Settings #1001, " Use System Proxy Settings i1 .

2 E 5, £idi Stop Capture $4, &5 ¥ iislide . &S5, #idi Save Capture #5H],
HFESAZ LR R . BUEIRT, SAZ -SRI gim. BUlid# it SAZ i
AT, & Save as type T HHES () Password-Protected SAZ i 15, Wik 7-6 s,

()| B[R eicow » Dottop » <[4 | sesch Desion 2]

File name: ~ FiddlerCap_120129-11-37.52 ' v

7.2.2 Capture Options B O

Capture Options T 1458 fil i £ -] {4 FH ity ol

Store binaries S IEHE (BRUA L) FHITEMAN S SRT —dEHw g (i .
T, PLAIFIRY Flfoctet it F#K). BRGIX S R LIRFFmIR 3 ) ] LIGROCREREE% 1Y) SAZ
SN, BRI T BT PR N R, NSRRI .

Decrypt HTTPS traffic SikHE (BRiAALiEd) F26] FiddlerCap 2 & 2231 HTTPS %4 it
. mEEPiEERE, &RR - RMEEE.

HTTPS decryption will enable your debugging buddy to see the raw traffic sent
via the HTTPFS protocol.
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This feature works by decrypting 55L traffic and reencrypting it usinga locally
generated certificate. FiddlerCap will generate this certificate and remove it when
you close this tool.

You may choose to temporarily install this certificate in the Trusted store
to avoid warnings from your browser or client application.

FotiElE S, &8s Windows Security $273HE, SCRHIE FiddlerCap HUET:, I 7-7 Fras.

Security Warming - el

You are about to install a certilicate lrom a cenification autharity (CA)
A claiming to represent:
DO NOT_TRUST Fiddlesftoot
Windows cannot validate that the certificate is actually from
“DO_NOT_TRUST Fiddlesfoat”. You should confirm its engin by

contacting “D0_MNOT_TRUST FiddlerRoot”. The fellowiig rumber wall
assist you in thes process:

Thumbprint (shal): 364FCATE 4B041EE5 26031C98 28052040 FB604642
Warning
If you instad] this root cendicate, Windows will sutomatically trust any

certifscate moued by thas CA. Installing & certificate with an unconfumed
thasmbpeant iz 2 security risk. I you click *Yes" you acknowledge this
sk

Do you want to mstall this certifscate?

& 7-7

KM FiddlerCap B, ‘&£ Fah BB 1C 5l 2 S0 i A ORI AT A AE 45, SRR A LR HE AL P
W 5E NS035 Gl 15 FE v MR AR AE 15

Store cookies and POSTs 3£ 1l (ERA M1 ) 2458 FiddlerCap &5 {817 POST ik ik
LB HTTP i 3K 3k () Cookie. Set-Cookie. Set-Cookie2. Authorization il Proxy-Authorization.
U R T AT LA — SE PR b b i, O Hm e s b R a0 B AL ML, BT
RS, AR A0 EO A AR T AR OB VA B B R RETEAR (R Z ML

Automatically discard traffic after # minutes 1% 51 Fl T35 5175 SAZ SC#F 0847 JL4 b i Bdis
e sl Al PR BPE R AR s e, IR AT . ATLL R S SisTRY FiddlerCap,
FR A RS R B st A, WA O S R LR A A A T SR N A R
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7.3 Fiddler #] Viewer # 3,

fy o) R, W] LR (R A7 S e LA b e iR i

7.2.3 Tools @A

Tools T HIR{EEAETA R T W 8. Clear Cookies ¥l <5 1E LR IL b5+
WinINET )i 41 #F /. Cookie. Clear Cache £ #l 4 M IE/WinINET £ {£5 %5 i M8 15 ik,
fiffi % FiddlerCap ] UL &5 Fr 3 (W, 1 A A M A M 8 47 Fh I .

Clear Capture fi¥ll 11474 FiddlerCap HFAGHITR I A 0. &2 2055 Bk B A7 2 i il 42 1)
It] Session.

Snapshot £ #l 2:% FiddlerCap 1EAEIZT [ #0017 b R il Fedls B HEEL 1Y) TPEG H
A E S, EHN Session P {R{r iR E, L URL W& MurndmE, Rk
http://localhost/Screenshot_h-mm-ss.jpg

e F Flag SR 200 ot 55 HE, AT L0k 42 200 800 iR mak e, tmPe 7-8 A .

P == T

I = e el e i ]
ey %'i:'-li':nj-'::':..'-'-'.:'"-::-":.'-'-'*k'.-r.a. P o A e ":"';-'!;" P -3'-\ .
ﬁ Enter 5 comment 1o add Bo Bhe caphire
[Now when T cick the bkt rashes. |
w | o |

1% 7-8

A TR SO £ (RAT T AY Session (9 HTTP Wifi{k, 3L URL A hitp:/USERCOMMENT/
MARKER.

7.3 Fiddler Iy Viewer B

BHEEOLF, FUWLAERIT A Fiddler SEB1; 5 Fiddler TLEAT I — LN, AL
T B, o Of [ Fiddler 5.

{HAE, F70 T IF 43570 Fiddler SX 853 SAZ JCfFaR A iR 2 2. Eoilix
— 4, Fiddler T B AT B Viewer S0, @GS 1T EH-viewer, BT
Windows Explorer "4 8 i i SAZ 3CfF, M RIS Gk Open in Viewer, W 7-9 fras.
Viewer Mode @70 R b2 0L Viewer BEU P bR EE Viewer Mode Gilors, i HLaf LU T R
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FTE RE. FARFHEER
O SCASR s . IAREAT INGAERT SAZ Soff,  SCAL: BUR FiddlerViewer, 1P 7-10 Fiog.

Open with... FiddlerViewer () 43 Replay

& 7-9 B 7-10
o] LU i s i A, S 4 AR i Viewer £, i 7-11 Bros.
MR SAZ iFmIEBLFID, CERSTH SAZ AR BaiFleRern e
Edtas, e 7-12 k.

file Edit Rules Tools View Ew‘rwwx b Resume | & Sueam §
Your Text Here () %4 Replay

| Jc,\uﬂmmmnucummmmmuaupmmum.m

B 7-11 4 7-12

Fiddler Viewer “C#| EiEHiHe 8t i, o LA 2 8AF Viewer B F A H P ik
(Al BaiE 1 PP ot Web Session #1885 EH ) fECM B &4k E55.

74 AR Session

B T Fiddler [R50 SAZ K53, Fiddler A 3SIARMEE TS A T tHThiE (B “Transcoders™),
M ] LRI LA T RO S Ea e, B T Fiddler S55E M Transcoders, ¥ JEHLHISC R
ke s in oAb g .

Fiddler )30 4 Je 34t 5 A F HIhfiE. Import Sessions... < 32 £ M H Al 4% 38 i 4%
Session. ifi Export Sessions T 3£#. 4§55 i B 47 ) Session 4 FL7E Web Session 5% ke )
Session, 1P 7-13 P,

lrn.pnrtSemm's. 3 _ [
Export Sessions 3 All Seszions...
[} Selected Sessions..

Exit

¥ 7-13
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741 AKX

) Fiddler MEACRLES B Fh 5 AR U HTTPArchive 1 F12 NetXML. HTTPArchive ¥
. (HAR: http://groups.google.com/group/http-archive-specification) JEA74R 193 T JSON f#%
A, RETH LR, B4 Firebug. Chrome 31| W88 1977 A # LILLL A HTTPWatch. % ¥ 1.1
A 1.2 flAs.

F12 NetXML #5801 IE 9 A2 # 1 Network #7955 th f#s a0 A3 2608l Bk
I3 A HTTPArchive 3, IX# L fHliid XML i A2 JSON %ifd. % He A 2 Sois i
MO 1B S A, R R b B AR HTTPArchive My xUJ2 il XML B .
FEGL e b0y, LR R T — FREEAE ] JSON KU, Fiddler A2 ME—82 HiE4T i) ol i3 1R
NetXML # U T H: of LUl Fiddler IN#k NetXML, #4795 WAL (in HAR).
TR, AR R AR AT R S, AT S s Bk R, A SRR it
il P 15

BErp T ES AN, RSB ITEEREEFESAN . Fiddler 2MHTIE
PRISCE, JCEE LSS nE] Web Session #1]3%.

TR G AR T BRI Al 3 A k0. Hir, AT A0 LL T A Wireshark .pcap # A H
NetMon .cap 330 PF 1) 5 AR

742 SHERX

Fiddler #2{1t [ 18 % 5 i Dhiie, =288 S Scdig ey Hofh T Hoalny B . A5 i) 8] 4 5
2z fiik Fiddler A< 5 =2 ¥5 1 5 HH B =

HTMLS5 AppCache 7 B 3044

HTML 4| A T R {T (Application Cache) [JHEE, ‘& 3CFF Web H %A G {E 01 (i 7
W SCPE (manifest), o] AZE 7 so UL 2R A0 T . 75 0 SO i 0 06 28 17 12 44 16 1 8 i
T 8L% AppCache 7, 1t WFL% 5% #5012 — 5 A\ Y 8 2K 1

OISO SURSCA SO, AT B o SO R BRI . R, R AR
Wenl, UE () Eh ki /72 . Fiddler ff) HTMLS AppCache Manifest Exporter {7 4E plé 5 0
1 75 4 1) L

1) 34 i W AR 4R AT .
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FIE R BARFHEER
2) Kiz) Fiddler.
3) {E SR AL web B ri.

4) {F Fiddler ' 1517 File > Export Sessions > All Sessions.....

5) {E Select Format & [15p, i%h HTMLS AppCache Manifest.

6) piili Next. & Adjust AppCache Manifest #f 11, 3% A & 48 75 8] 3L £F ( manifest )
() CACHE {4340 3 (0 985 . 407000 4% % 55 34 75 0 S R (1) NETWORK {04y, i 7-14
o

Adjust AppCache Mandel
Bt Boe Peaoues List below by iraaried endnes . Flace o chechmschk reat o sy deen ihat slundd ahwsys be retneved bom e
metecrk inminad of the AppCache To wae relatve URLS, specify a Base URL in the bax below
et dT s sy i b ST e e ; =iy
URL Ss  Type "E
Markup
[ it s svmecreeset com bastdrren. 8128 et
Imasges
T it gl com bt Viawe Homapage. ADemes pg NET  magepng
[7] bt o macresnolt combastamen. Ve Homapage. ioana. Cookbeak prg BU430  wagepag
[T hitp e mwcrersolt com dastdnveViswa, Homapage loona. HandsOn Winckes prg S5 mageipng
[T ity mcmepiat Aty Vi Hammaspagis. |oong, el eciong png 471 magepng
85
7] htp - ey et com Asstanve fnchudes. Shyies Base Stples oo 545 tedices
fﬂm!hmgummﬂhuﬂmﬁmm 6] fmsdinas
| Sonpt
(I IR D G— Y P WA T8 FUNY | SN U [ L [ S S NEEEN. - p— — T.
Kplional] Specily UAL b5 e 48 5 bose &g hitp ./ fessmpls com
Brl = o

M 7-14

7) aTeAilad i F A SCAKE, R URL BIAE#E, fiE 1 Base URL. filfm,
7C L o, 3RS0 o e H 3 hitps/ie.microsoft.com/testdrive F, Bl &ifle
£ % Base URL.

8) siil Save fefll, ARG MBEP AR, W 715 Fras.

9) AT I A R, MRS R R Web BRS B3RO0 Gl H . B {RH Web IR% 3
AL B 4R [F] 49 % Content-Type: text/cache-manifest 777 0 3L PF2 8,

146
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CACHE MANIFEST
# Generated: 9714,/2001 6:36:33 PM

#® peploy so that s are relative to: hoop://fe.microsoft. com/testdrive
CACHE ©

'l

Jimeludes /L ibraries L 1.6.2, min, 5
,-'Ir-:'lutlu,‘Sac ;| I.,-"h'vm{:‘:rm -is -1
/Ine ludes Scr 1pl‘.-"'rﬂ.r.l:lr1ulf1:—-1 j=
SIngludes  Styles ‘BaseStyles. css

vl ews SHomepage, /Al 1Demos . prig

v}‘m; Y K55

Iiews Hompaqe-fmaqe. 5

iews ; nui}:hwlr

Py
.-‘\Hmfmx'tcw ‘and=0me i ndowsS. png
/i ows fHomepage,/ Tocons /Spel Ichecking. png
Nim-‘nﬂup&-qgh:nm.r‘mhsocku: P
Swiews ‘Homepage, wr apping. prg

NETWORK :
.

B 7-15

100 75 Web i, &% e b bzt Clofd i HTMLS Sofiles), Zedfmp
FH 0% 7 B S04 9 HTML oG 2 7P i In Manifest B, WP 7-16 Ak

e, Mg R AppCached W%, &MEETFPEH i s o R
XAEBEI, A AR CEBIER A R . POAWRRE | he
AR, {E Fiddler b, {R-Aof B EH BN FHH Hl 7-16
Ko WMPHRA LA Fiddler B SGX T AE, T EMTRMEES, Wt REEr -

A T M R Ak .

HTTPArchive v1.1 #1 v1.2

HTTPArchive K5:U—#F JSON L, "Ef4& Web Session 1] header. body FIR [){ii &
11 R 1.2 A 22 () 1) S o S0 A A S A/ i) —2E body .

IO F . Fiddler 2 {71 IMB K/ CAZE T body, 1M —HEHI2E 54 () body
0] LLRAF 32768 F45; o] LA 5 7 A BE Y preference XX SS{HIEIT 450

fiddler.importexport.HTTPArchiveJS0ON.MaxTextBodyLength
fiddler.importexport . HTTPArchiveJSON.MaxBinaryBodyLength

ME body KT, ERSLUICHESERT, MM, 7 Session Pl —&iLH, £
715 208 i body .

MeddlerScript

Meddler (http://webdbg.com/Meddler/)Jit 4~ HTTP ¥k TR, WHARKERMT L
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F1E KA. sARFHBRER

Frala A m . HAEE HTTP $d6ii. Meddler £ A “AK Socket”, EXIFIFEIKE
(9 socket #4E, %IRRT o WS E L Ab % Fom iR A H .

{74 Web Session 5 M F MeddlerScript B, “FRf#I.MS SC#F AT LLINELE) Meddler
Moy T BL “RA" Bl MREE BiF, ZM4ER Fiddler ) AutoResponder %7l 5 i 2 i
M. SAZ Sl 4 0 i B AR 2L, HJE Meddler BJASE (F T8l M ahdk, i B SRR
B — i (o “ %23 header FUA IS body 195 — 5% 2 (A1 %+ 300ms, A5 HER 10s
LLBEAS 514k 2048 F155 body ™), 1 &1 A Fiddler A 5 MR SeBLX — 54,

B AR AL i W S sl A ) HTTP %/ 3. W5 1) MeddlerScript {8 A] gt i {14
Fl4k.

[Rea3r ¥ (Raw Files)

Raw Files Exporter < Ff0 8- W B AR (R A7 BIRESE SCPF. 2R 5 T A BIRERLRT, iZThiE
ERHH. 34017, iR TR PSS, 75 Web Session 52l T — M A . fRaT el
{lH Fiddler (a3 fiLibhfie, RuErhmnmm iy (ol 20k /4 JPG S0fF). #AS, ATEL
%4 File > Export Sessions > Selected Sessions, E Select Export Format i£THEZEF Raw Files.

File Exporter & NS FFACE S L #E, Wl 7-17 Frae.

(o D Foddar whish complete

#7-17

Path EGHE L&D HO RO F XM RMENRBER. BXHRGAHIDEN
\Dump-MonthDay-Hour-Minute-Second\-

Options ¥ Ji#E 5 W54~ S%HE. Recreate Folder Structure 2 &/ B T L4 ML
PR PG T P . 3 DL 7 A M 1S

Open folder when complete #1124 H Windows Explorer, s 5 H ) SCAERTERIIR H 3.

#iidi Export >>f 10T LL i &h T .

B T A SCPE, Raw Files Exporter i o] L7 {8 i 24 i 42 219 Web 3 e 6 2 A< h e £
BRI, SRS, AT LU S e 4 % B AutoResponsder iE11 . Fiddler 258 T B
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TSRO A i N AR % . M RAELA] I0Ah T . (1 Expression Web o, Visual Studio) 7F 4 #h 4 4t
HTML W, AR T 1k Web il AR5 4.,

Visual Studio WebTest

£ 1l Visual Studio .WebTest SCfFfa, (0] LI{EH] Visual Studio Web Test /i $URT 28 2 i

fiEBpa ek, Zzhagel BUH T o ok A . 7F Visual Studio 2008 BAK ¥ A
$L4E T Visual Studio Web Test T H..

WCAT Script
W TR Web 55 5 Br g 1 -

Web Capacity Analysis Tool (WCAT) is a lightweight HTTP load generation
tool designed to measure the performance of a web server within a controlled
environment. WCAT can simulate thousands of concurrent users making requests
to a single web site or multiple web sites. The WCAT engine uses a simple script
toc define the set of HTTP requests to be played back to the web server.

Fiddler {f) WCAT Exporter 0] LL{H 755 5 WCAT “E il I A, 0] LLTE IR 95 4% 5 11X
Segtsk, e b AR R ) .

] BL{E hitp/fiddler2.com/t/?WCAT T #% 32 {i75E 64 {7 [f) WCAR %%z 30t
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FiddlerScript

8.1 {¥}Hl FiddlerScript §"Ji¢ Fiddler

I BLAR A Y Fiddler {8 L4 EThAE, H /M AR SCIR LR SE R ThRE . fRIRTRAR SR
FIH CAE AR L Fiddler F P o the 2 b ol B8 il 4 % T R4 & R R .

Fiddler - MMSAH) Ji B 1 870+ HER{E 7l %8 (Hide Images), il it /& 1 ]
%5 B 8. B RITE Fiddller Sl RO IETh AR R H /- Wi, SR E FHvlE
HERSCARE, B RET PRI R R R . RO A B Rk,
ERERMAEEHAR UL A o, BMHEREHEESAME. mEH 8
Ul Ml A0 Ay IR B, B AP fe 2 00 e S HkEE AND. OR #I NOT #4EFFM
5t 1 5 B R .

FIEME, ‘M s HEEFN TREM. BN T M. “7F Fiddler {{i
ek S Ayt g ek R F ok R Mg B 26 . AN ISR AT LIAER] P B SR Bl " X
AR EHE, R A—— AR B2 FLNET HESELEREH o f it B A 8¢, i B
A0 P on) % B TF O B AT | SRt IR A2 B . 7 2003 SEAERSES Fiddler ¥ T JLATANIS/S,
B EMmAET.

B Fiddler el & 9 P SIANT A Fohilk, {045 Fiddler - EAR £ N B XL IEThRE,
{H FiddlerScript 5| %6 2 Fiddler f9—/~A 0] sl G h itk . 7622 3] FiddlerScript f9ilf
th, HEHRSEMRE, X Fiddler i) TR S8 |- — 2,

8.1.1 37T FiddlerScript
Fiddler E 4k B 51~ Session i, WA L CustomRules.js P TR &I, ZWANH
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